Table of Contents

INSTALLING ROLL CALL
- Install for use on a Single Computer ............................................................. 7
- Install for use on a Local Area Network .......................................................... 9
- Install for use at Other Locations .................................................................. 13

GETTING STARTED
- Enter License ..................................................................................................... 15
- Enter Organization Information ........................................................................ 15
- Set up Trial for Mobile or Connect ................................................................... 16
- Getting Around Roll Call .................................................................................. 17
- Set Color Schemes ............................................................................................ 18
- Activate User Security ....................................................................................... 19
- Preferences ......................................................................................................... 20
- Email ................................................................................................................... 25
- Grid Columns ...................................................................................................... 26
- Lock Columns ..................................................................................................... 26

CUSTOMIZING THE DASHBOARD
- Widgets Customization ..................................................................................... 27
- Adding Widgets to your Dashboard .................................................................... 28
- Printing your charts, to do list, and birthday list ................................................ 30
- Types of charts: Pie, Bar, Bar stacked, Column, Column stacked, Area, Line ....... 31

ADDING FAMILIES IN ROLL CALL
- Import contact information ................................................................................ 33
- Use Add a Family (Basic) .................................................................................. 36
- Use Add a Family (Detail) .................................................................................. 38

MANAGING BACKGROUND CHECKS
- Enter Background Check Request ................................................................... 47
- Enter Background Check Results ...................................................................... 49
- Research Background Checks .......................................................................... 52

RECORDING VISITATIONS
- Print Visitation Log ........................................................................................... 57
- Enter Visitation Notes ....................................................................................... 58
- Print Visitation History ...................................................................................... 61

LOOKING UP PEOPLE INFORMATION
- Search Profiles .................................................................................................. 62
- View Details ........................................................................................................ 66

UPDATING FAMILY RELATIONSHIPS
- For Marriage ...................................................................................................... 77
- For an Addition to the Family ............................................................................ 80
- For Divorce .......................................................................................................... 80
- For a Death in the Family ................................................................................... 81
- Change the HOF (head of family) Designation ................................................... 81

DELETING PEOPLE FROM THE DATABASE
- Transfer Contributions ...................................................................................... 82
- Delete an Individual Record .............................................................................. 83
- Delete Multiple People ..................................................................................... 84

COMMUNICATING WITH YOUR CONGREGATION
- Who Do you Wish to Contact ......................................................................... 86
- Email ................................................................................................................... 89
Match On .................................................................................................................................173
Running the Import ..................................................................................................................173
Successful Run ...........................................................................................................................173
Processing Rules ......................................................................................................................173
An existing profile is matched ....................................................................................................173
Adding a new Profile ................................................................................................................173
Manually Finding a Match to Imported Contribution ...............................................................174
Post a Batch ...........................................................................................................................175
Import deposit to QB or MYOB .................................................................................................175
Delete a Template ..................................................................................................................175
Batch Reports ..........................................................................................................................176
CORRECTING CONTRIBUTIONS
Open Batches .............................................................................................................................177
Posted Batches ........................................................................................................................178
Transfer Contributions .............................................................................................................180
RECURRING CONTRIBUTIONS
Recurring Contribution Process .................................................................................................183
Recurring Contribution Preferences ........................................................................................183
Find Recurring Contribution Profiles ......................................................................................184
Create Recurring Contribution Profile ......................................................................................184
Posting the Recurring Contributions .........................................................................................185
Post the Batch ........................................................................................................................185
CREATING CONTRIBUTION RECEIPTS (STATEMENTS)
Contribution Receipt Process ..................................................................................................187
Contribution Statement Formats ...............................................................................................187
Quarterly Statements ................................................................................................................192
Quarterly Tabular Statements ...................................................................................................196
Annual Statements ...................................................................................................................197
Canadian Receipts ..................................................................................................................201
Individual Gifts .......................................................................................................................203
Statement for a Specific Person .................................................................................................207
CREATING CONTRIBUTION REPORTS
Donor Detail Report ...................................................................................................................212
Donor Summary Report ...........................................................................................................215
Donor Summary by Fund ...........................................................................................................217
Donor Giving by Week, Month or Year ..................................................................................219
Top Donors .............................................................................................................................222
Donors over X Amount .............................................................................................................224
Given X Times ........................................................................................................................226
Given 0 Times ..........................................................................................................................229
First Time Givers ....................................................................................................................231
Fund Summary .........................................................................................................................234
Giving by Fund by Week, Month or Year ................................................................................236
Contribution Detail ...................................................................................................................238
Contribution Statistics .............................................................................................................240
MAINTAIN PLEDGES
Pledge Fund .............................................................................................................................242
Individual Pledges ..................................................................................................................242
Finding Pledges .......................................................................................................................243
CREATING CUSTOM REPORTS

Pledge Progress Letter ......................................................................................................................... 246

Pledge Reports ...................................................................................................................................... 250

MANAGING GROUPS

Group Hierarchy ................................................................................................................................. 255
Group Custom Fields ............................................................................................................................ 255
Add a Group ......................................................................................................................................... 257
Copy a Group ......................................................................................................................................... 261
Mass Enrollment ................................................................................................................................. 263
Transfer members to a new group ......................................................................................................... 265
Graduation ........................................................................................................................................... 266
Modify Group Information .................................................................................................................... 268
Delete Groups ..................................................................................................................................... 268

REPORTING ON GROUPS

Attendance Summary ............................................................................................................................. 269
Absent Present Report ........................................................................................................................... 271
Attendance by Group ............................................................................................................................ 273
Attendance by Session .......................................................................................................................... 275
Check in Roster .................................................................................................................................... 277
Attendance Roster ............................................................................................................................... 278
Sign-In Roster ....................................................................................................................................... 279
Check In Log ......................................................................................................................................... 281
Group Members .................................................................................................................................... 283
Background Checks ............................................................................................................................. 285
Duplicate Class Enrollment .................................................................................................................. 288
Group Involvement ............................................................................................................................... 289

USING THE QUERY EDITOR

Query Editor uses ................................................................................................................................. 292
Table Layouts ......................................................................................................................................... 292
Current selection ................................................................................................................................... 294
Basic Query ........................................................................................................................................... 294
Complex Queries ................................................................................................................................... 299
AND, OR and EXCEPT .......................................................................................................................... 304
Save a Query .......................................................................................................................................... 304
Special Query ......................................................................................................................................... 304

CREATING CUSTOM REPORTS

Create a custom report ............................................................................................................................ 307
Base Table .............................................................................................................................................. 308
Data for the Report ................................................................................................................................. 308
Select columns for the report ............................................................................................................... 308
Calculated columns ............................................................................................................................... 309
Summary Information ............................................................................................................................ 311
Sort the Report ....................................................................................................................................... 312
Print the Report ....................................................................................................................................... 314
Re-use the Report ..................................................................................................................................... 315
Edit a Saved Template .......................................................................................................................... 315
CLEANING UP THE DATA – DATA ADMINISTRATION

List of Valid Values ..................................................................................................................316
Duplicate Check .....................................................................................................................316
Bulk Changes ..........................................................................................................................317

MAINTAINING THE DATABASE

Data File Location ..................................................................................................................319
User Security ..........................................................................................................................319
Backup on single user system ...............................................................................................323
Recover the database .............................................................................................................323
Backup a networked system .................................................................................................324
Recover database from a backup on a network system .......................................................326
Open a Different Datafile ......................................................................................................
Repair my data file ..................................................................................................................328
INSTALLING ROLL CALL

Install for use on a Single Computer

If you will be accessing Roll Call from only ONE computer, you will want to download and install the Standalone version of the software from http://www.bythebook.com/support/downloads/

Windows

To install Roll Call on a Windows computer, you must first download the Windows installer file.

1. To download the Windows installer, click on the Standalone link.

   - **Click on Standalone link under Windows.**

2. Once the file (ROLLCALL.exe) is downloaded, double click on the file and choose the run or open option.

3. The installation wizard will be presented. Click NEXT through all the steps.

4. Once the installation is complete, there will be a Roll Call icon on your desktop. Double click on the icon to start the program.

   - **Click NEXT through the installer set up wizard.**

   

<table>
<thead>
<tr>
<th>Windows</th>
<th>Mac OS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standalone</td>
<td>Standalone</td>
</tr>
<tr>
<td>Client</td>
<td>Client</td>
</tr>
<tr>
<td>Server</td>
<td>Server</td>
</tr>
</tbody>
</table>

   

   - Version Info: Requirements | Change Log
Mac

To install Roll Call on a Mac, you must first download the Mac installer file.

1. To download the Mac installer, click on the Standalone link under the Mac section.

2. Once the file (ROLLCALL.dmg) is downloaded, double click on it in your downloads list to mount the dmg.

3. Double click on the RollCall Installer icon from the window that comes up and choose OPEN.

4. Click Continue, then INSTALL to complete the installer process.

5. To start the program go to the Applications:Roll Call folder and double click on the Roll Call application. You may also wish to drag the application to your doc.
Install for use on a Local Area Network

If you wish to have multiple computers in your office access Roll Call, you will want to install the network version of the software. There are two components to the network version. First is the Roll Call Server software. This can be run from a Windows or Mac machine. It does not need to have a “Server OS”. The second component is the Roll Call Client software. The Client software must be installed on each computer that needs to access Roll Call.

Roll Call Server Software
Install Roll Call Server software on the machine that will house the database. This machine should be:

1. A robust computer with at least 4Gb of memory
2. Left on at all times with Roll Call Server running
3. Set to NOT go to sleep

To install Roll Call Server on a Windows machine:
2. Run the file ROLLCALL_Server.exe by double clicking on the file in your downloads list and choose the RUN or OPEN option.
3. The installer wizard will be presented. Click NEXT through each section.
4. When the installation is finished, there will be a black Roll Call icon on your desktop.
5. Double click on the icon to start Roll Call Server

To install Roll Call Server on a Mac machine:
1. To download the Mac installer, click on the Server link under the Mac section.

   Click on the Server link under the Mac section.

2. Once the file (ROLLCALL_Server.dmg) is downloaded, double click on it in your downloads list to mount the dmg.
3. Double click on the Roll Call Installer icon from the window that comes up.

Double click to begin the installation process.
4. Click CONTINUE then INSTALL to complete the installation.
5. To start the program go to the Applications: Roll Call Server folder and double click on the Roll Call Server application. You may also wish to drag the application to your doc.

6. Make sure to turn off App Nap if you are using Mac OSX 10.9 (Mavericks). See https://bythebook.freshdesk.com/support/solutions/articles/1000017537-roll-call-is-running-slow-on-osx

Roll Call Client Software

Each machine on your network that requires access to Roll Call will need to have Roll Call Client software installed on their computer.

To install Roll Call Client on a Windows machine:

1. Download the software from http://www.bythebook.com/support/downloads/ by clicking on the Client link under the Windows section.
2. Run the file ROLLCALL_Client.exe by double clicking on the file in your downloads list.
3. The installer wizard will be presented. Click NEXT through each section.
4. When the installation is finished, there will be a blue Roll Call icon on your desktop.
5. Double click on the icon to start Roll Call Client.
To install Roll Call Client on a Mac machine:
1. To download the Mac installer, click on the Client link under the Mac section.
2. Once the file (ROLLCALL_Client.dmg) is downloaded, double click on it in your downloads list to mount the dmg.
3. Double click on the Roll Call Installer icon from the window that comes up.
4. Click CONTINUE then INSTALL to complete the installer process.
5. To start the program go to the Applications: Roll Call Client folder and double click on the Roll Call Client application. You may also wish to drag the application to your doc.

6. Make sure to turn off App Nap if you are using Mac OSX 10.9 (Mavericks). See https://bythebook.freshdesk.com/support/solutions/articles/1000017537-roll-call-is-running-slow-on-osx

Install for use at Other Locations
If your church does not have a central church office or has staff that work from home, you will want to check out these different ways that Roll Call can be configured.

Remote Desktop Software
Remote desktop software allows you to take over control of a remote machine as if you were sitting in front of it. Since you are controlling the machine remotely it is important to remember that only one person can use the machine at a time and anything on that machine can be accessed. Examples of remote desktop software would be logmein.com or GoToMyPC.com.

You can use remote desktop software with a standalone or network installation of Roll Call. Install the remote desktop software on a machine that has Roll Call or Roll Call Client installed.
Internet Port Forwarding

Internet port forwarding allows you to access Roll Call via Roll Call Client from any machine over the internet. To implement this option you will need to install Roll Call Server software on a machine that is accessible from the internet, and that has fixed or dynamic IP address. For more information on setting up this option see http://www.bythebook.com/PortForwarding.pdf

VPN

VPN or Virtual Private Networks create a network connection between your church LAN (local area network) and a remote computer using the internet. This can be accomplished with software or hardware. A popular option is Logmein’s Hamachi. For more information see http://www.bythebook.com/VPN.pdf

Cloud Hosting

Another option is to have By the Book host your Roll Call Server software. We install Roll Call Server on our servers in the cloud. Then you install Roll Call Client on your computers that need access. For more information on this option see http://www.bythebook.com/church-software/roll-call-on-the-cloud/
GETTING STARTED

Enter License

When you purchase Roll Call you will receive a license number. This license number must be entered into the system. To do this:
1. Go to the File menu on the top menu.
2. Select Enter License.
3. Enter the number you received.

You will not need to enter a license number if you are using a trial.

Enter Organization Information

You will want to enter basic information about your organization. This information is used as a return address on contribution statements. Only users with Expert level permissions will be able to view and edit this information.

To enter this information, click on Organization from the left side menu. Enter the following information:
1. Organization – The name of your church or ministry.
2. Address – Your organization’s mailing address.
3. More Address – The second line of your organization’s mailing address.
4. City/State/Postal Code – The city, state and zip code portion of your mailing address.
5. Country – If your organization is not based in the US, enter the country here. If you enter Canada, the contribution receipts will default to the Canadian format.
6. Phone 1 – Enter the phone number of your organization.
7. Phone 2 – Enter a secondary phone number for your organization.
8. Tax Number – This information is required if your organization is in Canada. This number will be printed on the Canadian contribution receipts.
10. Weekly Budget – This weekly budget amount will be used in budget vs actual reports.
11. Fiscal Year – Enter the month that your fiscal year begins.
12. Church Email – Enter an email address for your organization.
13. Church Website – Enter the URL for your organization’s website.
14. Click SAVE to save this information.

**Set up Trial for Mobile or Connect**

Mobile CheckIn is an add-on product to Roll Call. It allows you to perform church check in via a browser on your mobile device such as an iPad, Galaxy tablet or Smart phone. Roll Call Connect is a membership portal into Roll Call. Using Roll Call Connect your staff can access some Roll Call information through their smart phone, tablet or computer at home through a browser. Your congregation can log in and update their profile information, give online and view their contributions.

If you would like to trial either of these products, you’ll need to activate the trial. To do that:
1. Select File>Enter License from the top menu.
2. Click on the Mobile tab.
3. Click TRY IT.
4. Click on the Connect tab.
5. Click TRY IT.

For more detailed information on the set up of Mobile CheckIn and Roll Call Connect, check out our Child Check In user manual or Roll Call Connect user manual. Video instructions are available as well at http://www.bythebook.com/church-software/tutorials/

**Getting Around Roll Call**

To navigate Roll Call, there are really three main things to understand. The menus allow you to get to certain areas of the program. For example, people, contributions or groups. The icons allow you to perform certain functions against the data. For example, send emails, search the database or save a set. The plus and minuses at the bottom of windows allow you to add or delete from the list.

**Menus**

There are 2 main menus in Roll Call. The left sidebar contains the navigator menu. This allows you to access different areas of the program. To expand or open up a menu on the left, click the plus sign (on Windows) or the arrow (on Mac). The menu items will be displayed below. Click on the function you would like to perform.

The top menu in Roll Call allows you to perform more administrative type functions. For example, you can change your password, run utilities or set preferences from these menus. To open up or expand top menu items, click on the menu name, and select the item you would like to perform.

**Icons**

The following are the icons that will be on the top on most search screens in Roll Call. Click on the icon to perform that action. The action will be performed against all records in the list. If you only want to perform the action for certain records, highlight those records in the list then click on the icon.
PRINT – Prints the list that is displayed on your search screen.
EMAIL – Sends an email to everyone in the list or everyone highlighted in the list.
TEXT – Sends a text to everyone in the list.
LETTERS – Creates a mail merge letter to the people in the list.
LABELS – Creates mailing labels for the people in the list.
SPREADSHEET – Displays the search list in a spreadsheet format.
ALL – Displays all records in the database.
SORT – Allows you to sort the records in a different order.
SEARCH – Allows the user to query the database and look for common characteristics.
SPECIAL – Will perform some common queries.
SETS – Will allow you to perform union and intersect comparisons of two different sets.
SAVE SET – Will allow you save a listing of records.
GET SET – Will allows you to retrieve a saved set or records.
SUBSET – Allows you to reduce a list to only the highlighted records.

Icon bar to print, email, write letter, etc.

Use plus (+) and minus (-) signs to add and delete people records.

PREFS – Allows you to change which fields are displayed on the search screen.

Plus and Minus Signs
You will notice a (Add+) and (Delete-) sign below most “list” areas in the program. When you click the Add+ sign, it allows you to add a record. When you click the Delete- sign, you will be deleting a record. For example, let’s say you were in the Groups Search screen. When you click the plus sign, it brings up the window to add a group. If you hit the minus will delete the group or groups that are highlighted.

Set Color Schemes
You can customize the appearance of the Roll Call screens. To modify the appearance, go to the Edit menu at the top and select Preferences. There are five different areas on the window that can be customized.
Icon Bar Color - The icon bar is that top bar that contains the different icons or actions that can be performed. Click on the … button to get a color palette to choose your color.

Menu Icon Color – This is the actual color of the icon pictures. You may choose Black or White.

Menu Icon Text Color – This is the text beneath the icon picture. Click the … button to choose your color from the color palette.

Background Color – This is the background color of the various screens. Click the … button to choose your color. Click on the reverse arrow to return to the default.

Activate User Security
If you would like to turn on the security system in Roll Call so that all users will need to log in, you will need to give Administrator and Director a password. To do this:
1. Expand the Admin menu on the left sidebar menu.
2. Click on User Security.
3. Highlight Director.
4. Click the CHANGE PASSWORD button. Assign a password.
5. Click on Administrator.
6. Click the CHANGE PASSWORD button and assign a password.

After you click the plus sign, you’ll get this window to add your user.

Choose the areas that you want to allow this user to access. Click SAVE & CLOSE.

To add additional usernames, click on the plus sign in the lower left of the window. A window will pop up to enter the username and default password. To create a regular user, mark the option for Standard. To create a user that will man a check in station, choose the option for Check In (Client). Click OK to save this user. Next mark all the areas that they will be allowed to access.

Preferences

There are various preferences for Roll Call that will affect how the program operates. To change the preferences, do the following:
1. If you are using a Windows machine, choose the Edit menu from the Top menu.
2. If you are using Mac machine, choose the Roll Call menu from the Top menu section.
3. Click on Preferences.
4. Click on the section you’d like to update from the left sidebar list.
5. Make your change and click OK to save those settings.

People

To set the preferences for people type information, click on People on the left sidebar of the Preferences screen. Make sure you are anchored on the General tab at the top to set the following preferences:
1. **Optional Mailing Name Autofill** – The optional mailing name is an area where you can enter a salutation for addressing purposes. Only use this area if you need to address correspondence in a non-standard way. Our standard options are to use the Titles or First Names. So a standard format would be Mr. & Mrs. David Conley OR David & Kim Conley. If you would like the system to automatically fill in this optional mailing name, mark YES.

2. **Use Last Comm date** – In the Dates section of the People screen, there is a custom date that can be used to record the Last Communion Date or Other Date. Choose which you would like to use.

3. **Assign Family Numbers** – Indicate if you’d like the system to automatically assign family number or if you’d like to enter them manually. If you choose to assign automatically, the system will ask what number you’d like to start with.

4. **Make Family Position changes** – If you would like to automatically change a CHILD to YOUTH and a YOUTH to ADULT at a certain age, mark YES. Enter the ages you’d like to make the change.

5. **Turn off Security Clearance Level** – if you do not wish to have the Clearance Level displayed, mark this box.

6. **Use Multiple Campuses** – if your church is a multi-campus organization, mark YES. Indicate if the campus field should be mandatory. Indicate what value should be used as a default.

On the custom tab, you can define the custom fields you’d like to use in Roll Call. Custom fields are any pieces of information you’d like to track about a person, but that we don’t have as
a standard field. There are three types of fields you can define: text, checkbox or dates. To set up these custom fields, do the following:
1. From the Preferences window, click on People on the left side list.
2. Click on the Custom tab.
3. Use the drop down box to choose the type of field you are defining. If the field requires a text response (for example an occupation) then choose field. If the field requires a yes/no answer (for example can you send email) choose checkbox. If the field is a date (for example baptism date) then select dates.
4. Enter the label that you want displayed for that field.

**Addresses**

For the preferences that affect address options, choose Address on the left side list.

Set the following preferences:
1. *Default Address fields* – If you would like the city, state or postal code to always default to the same value as the organization address fields, mark those boxes.
2. *Use Postal Preferred* – If this box is checked then the mailing labels will be printed in all CAPS in a specific font.
3. *Increase the size of the state field* – if your organization is not in the US, you can increase the size of the state field to accommodate providences.
4. *Display Country* – if the people in your congregation are from different countries, mark the box to display the country field. This will allow you to enter a country as part of their address.
5. *Web Mapping URL* - to view an address in a web map such as google maps or mapquest, enter the URL of the program you’d like to use. We default to google maps. You will also need to indicate the address format required by your preferred program.
6. *Address Validation* – if you will be implementing address validation through smarty streets, check this box.
7. *Smarty Streets Auth ID* – enter the authorization ID for your account through Smarty Streets.
8. *Smarty Streets Key* – enter the key provided by Smarty Streets.

**Contributions**

For the preferences that affect contribution data entry, click on Contributions from the left side list.

1. *Enter key as tab* – If you use the enter key on your numeric keypad and you’d like it to act as if you are using the tab key, mark this box.
2. *Default Designation* – To set a system wide default designation, enter it here.
3. *Auto Connect to Pledge* – Tell us how you’d like to connect giving to pledges. To you want a...
contribution to connect to the current pledge or to any outstanding pledges.

4. **Automatically Print Receipt** – If your organization provides a receipt for each individual gift, you may mark the box to print a receipt immediately after the contribution is entered. If you choose this option, indicate if you’d like to Include Pledge information and if you want to Print with out Header (on stationary).

5. **Print Name on Deposit** – If you want the donors name listed on the deposit slip for their check, mark this box.

6. **Sort Order** – Indicate how you’d like the Batch Detail report to be sorted… By Name or Entry Order.

7. **Denote check** – tell us how you want check to be spelled. For example, check vs cheque.

---

**Attendance**

One of the ways that you can automatically record attendance is through the church check in system. If you will be printing bar code badges for use with check in, use these preferences to indicate what should be included on the badge.

**Group Custom**

Just like with people information, there may be custom information that you wish to capture about groups. Maybe you need to know what small groups are studying or the emergency contact...
Choose the group type, then enter the labels for the custom fields.

for a certain group. You can create group custom fields to capture this information.

1. Select the group type for which these custom fields should be used.
2. Enter the label that you’d like to use for the custom field.

Choose the group type, then enter the field names for your group member custom fields.

**Member Custom**

You may also have custom information about group members that you’d like to track. For example, maybe for the choir you need to know their voice type and what instrument they play. This can be recorded as a group custom field. To set those up go to Preferences and click on Member Custom from the left sidebar list. Enter the labels for the group member custom fields you’d like to use.

**SMS Text**

You may use Roll Call to send texts to individuals, a group of people or your entire congregation. There are two methods that can be used to text. To set your preference for texting go to the Preferences window, then click on SMS Text on the left side. Your options are:
Choose the type of texts you'd like to use. If using NexMo, enter the API key information.

1. Send via email. You will need to have your outgoing email information set up properly and you will also need to know the cell phone carrier for the person you are sending the text to. This option is free.

2. Send via NexMo. NexMo is an SMS texting service. You will need to create an account with NexMo. When you do, you’ll get API Keys that you’ll need to enter in Roll Call. There is a very small charge for each text sent through this service.

Email

To send emails from Roll Call, each user will need to set up their outgoing email host information. Roll Call works with most email providers. However there are some providers that require a double handshake and those providers do not work with Roll Call. Gmail works great but depending on the type of account, you may be limited as to the number of emails you can send in one day.

To configure the email settings, do the following:
1. Go to the top menu where it says File, under File select:
2. Select My Email Settings.
3. Choose your preference for Plain Text or HTML emails.

Go to File>My Email settings.
Enter your outgoing email host information. Click SAVE.
4. Enter the Return Address. This is the “from” email address. If a recipient replies to the email this is the email address it will go to.

5. Enter the Mail Host Name. This is the Outgoing SMTP mail address required by your email provider.

6. Enter the Username and Password for this email account if your provider requires authentication.

7. Mark the box for the SSL if your provider requires SSL encryption.

8. Enter the Port Number, if your provider requires a specific port number.

9. Enter the No Emails/Minute. Your provider may throttle the number of emails that you can send per minute. If so, enter that number here.

10. Click SAVE to save these settings.

**Grid Columns**

When a user resizes a grid’s columns width, the system will remember it for that user. To resize a column width:

1. Position the mouse on the line between the end of the column you want to resize and the next column. The mouse pointer will change.
2. Click and hold and drag to resize.

**Lock Columns**

Users now have the ability on a grid to lock the left most # of columns. This means that when you scroll to the right to view other columns, those columns locked will remain visible. This is handy when you have a bunch of columns and want to see who the data is for as you scroll. To set this:

1. Click on the on PREFS icon when the grid is displayed.
2. Set the number of locked columns. For example, if this is set to 2, then the 2 left most columns will not move when horizontally scrolling.

When this is set, the locked columns in the grid don’t have the scroll bar beneath them.
CUSTOMIZING THE DASHBOARD

Roll Call allows each user to set its own dashboard, each according to the security levels allowed per user. For instance, only people with access to contributions will be allowed to set up widgets that have contribution info in them.

Widgets Customization

Each user has the ability to choose what widgets they want to have displayed. The defaults will be in affect until they choose to change them. The user can choose from the following widgets. Each widget has multiple choices for graph types (pie, bar, column, etc.)

- Giving by Fund – Shows a break down of top 6 funds given to as well as an Other category for all remaining funds. Pie Chart displays percentages of giving for each category for the current year. Other graph types show counts.
- Giving by Week 0 Shows a break down of top 6 funds given to as well as an Other category for all remaining funds. This displays amounts of giving for each category for the past 8 weeks.
- Giving by Month – Shows a break down of top 6 funds given as well as an Other category for all remaining funds. This displays amounts of giving for each category for the past 6 months.
- Giving by Year – Shows a break down of top 6 funds given to as well as an Other category for all remaining funds. This displays amounts of giving for each category for the past 4 years.
- Attendance by Week – Shows a break down of attendance by type (group/service/event) for the last 8 weeks.
- Attendance by Month – Shows a break down of attendance by type (group/service/event) for the last 6 months.
- Attendance by Year – Shows a break down of attendance by type (group/service/event) for the last 4 years.
- Visitors by Week – Shows visitor counts for the last 8 weeks.
- Giving vs. Attendance – Shows total giving vs Service Head Count for the last 6 weeks.
- People by Association – Shows a break down of top 6 associations based on counts as well as an Other category for all remaining associations. Pie Chart displays percentages for each category. Other graph shows counts.
- Families by City – Shows a break down of top 6 cities based on counts as well as an Other category for all remaining Cities. Pie Chart displays percentages for each category. Other graph types show counts.
- Families by Postal Code – Shows a break down of top 6 Postal Codes based on counts as well as an Other category for all remaining Postal Codes. Pie Chart displays percentages for each category. Other graph types show counts.
- Families by Shepherd Area – Shows a break down of top 6 Shepherd Areas based on counts as well as an Other category for all remaining Shepherd Areas. Pie Chart displays percentages for each category. Other graph types show counts.

When the screen is presented, it will display the current selections for each widget. The user can select the widgets that they want and the type of graph and that will remain in affect from that point on.

Defaults in Widgets

Each user can select the Widgets they want to display. There are a set of default widgets that will be assigned to all users based on their permissions.
If the user has Contributions permissions then:
• Widget 1 – Giving Fund – Pie Chart
• Widget 2 – Giving by Week – Column Chart – Stacked
• Widget 3 – If Attendance permissions – Attendance by week – Column Chart – Stacked; If no attendance permissions – Pie Chart

If the user doesn’t have Contributions permissions but has Attendance then:
• Widget 1 – Attendance by Week – Column Chart -Stacked
• Widget 2 – Visitors by Week – Column Chart
• Widget 3 – People by Association – Pie Chart

If the user doesn’t have either of these permissions then:
• Widget 1 – People by Association – Pie Chart
• Widget 2 – Families by City – Column Chart
• Widget 3 – Families by Postal Code – Pie Chart

**Birthday preference tab**
You can choose to show birthdays for everyone, by Association, Groups, Shepherd Area, Keyword, Tagged People, or Tagged Groups.

**Visitor Preferences tab**
To purpose of this tab is to see your recent visitors, how many times they’ve visited according to your ‘since’ date, and if you wish, to see if they have given. If you don’t have access to Contributions, the Include Contributions is disabled. If you don’t have Include Selected Groups checked, you cannot select groups below. Also, if you change from Include Selected Groups to Include All Groups, any selected groups will be removed.

**Permission Changes**
If the permission for a user is changed in User Security either adding or removing Contributions or Attendance, the widget settings are cleared from the user and the defaults will be used (see above).

**Adding Widgets to your Dashboard**
Once logged in as the user you wish to set widgets up for:

1. Go to the PREFS at the top of your screen. It looks like a gearbox.
2. You can select up to 3 widgets, not including birthday and visitor widgets.
3. Select for widget one, two and three and decide which type of chart you wish to see in each. You will have the option of Pie, Column, or Bar charts, Area or Line, depending on each widget.
4. Next, click on the Birthday widget. Decide who you wish to view birthdays for… just members? If so, select Associations and choose members.
5. Next, select the Visitors widget. This will show you attendance information of anyone with an association of visitors Decide if you want to show just services, or certain groups, etc...
Choose PREFS here to get to your widget customization page.

Select DASHBOARD here to view your dashboard.

Notice here are your optional widgets displayed on your dashboard.

This is the widgets tab. This will allow you to customize up to 3 widgets in Roll Call.

Select the type of widget.
Select how you want to see it displayed (such as pie chart).

Select the birthday tab and choose which people you wish to see. In this instance, we choose As-sociations, then choose certain associations.

For the Visitor widget, select if you want groups, services, or just certain ones.

Also decide if you want contribution info displayed. You can only see this if you have access to contributions as part of your user under user security.

**Printing your charts, to do list, and birthday list**

1. Go to the print icon in the upper left.
2. Select which widget, to do list, or birthday list you wish to print.
3. Select PRINT to send it to your printer.
Types of charts: Pie, Bar, Bar stacked, Column, Column stacked, Area, Line

You have several different charts to choose from, according to the type of widget you choose. The following screen shots show you what each of these look like:
Bar Chart

Column Chart

Stacked Chart

Area Graph

Line Graph
ADDING FAMILIES IN ROLL CALL

Import contact information
You can import contact information into Roll Call from a tab delimited text file. If you are converting to Roll Call from a different program you will need to export the data into a format that can be opened in a spreadsheet, like Excel. Open the spreadsheet, and save it in the file format “tab delimited text” file (*.txt).

There are four different formats accepted for import. Each are described in more detail below.

One Row Per Person Standard
The one row per person means that there will be one row in the spreadsheet for each person in the family. If you have a family of four, there would be one row with the dad’s information including address. The second row would be the mom’s information including the address. The third row would be child1’s information. And the fourth row would be child2’s information. We pull the family together based on a match of the address information.

The standard format means that a very specific order to the columns is required. The order is outlined on the screen below. If you do not have a piece of information, you still need to leave a column for that field.

To import this type of file, do the following:
1. Expand the People menu on the left sidebar
2. Click on Import
3. Choose the One Row Per Person Standard Format
4. Click NEXT
5. Choose a Default Association. This is used if the record doesn’t have an association value. Association is the membership category (how are they involved in your church)
6. Choose a Default Family Position. This is used if the record doesn’t have this value. We allow Husband, Wife, Adult, Youth, Child and Other.
7. Enter the line number where the data begins in your file. For example, if you had headers in your file, the data probably starts on line 2. If you don’t have any headers, the data probably starts on line 1.
8. Click LOAD FILE and navigate to the file you want to import. Highlight it, then click OPEN.
9. Click FINISH in the lower right to process the import.
One Row Per Person Custom

The one row per person means that there will be one row in the spreadsheet for each person in the family. If you have a family of four, there would be one row with the dad’s information including address. The second row would be the mom’s information including the address. The third row would be child1’s information. And the fourth row would be child2’s information. We pull the family together based on a match of the address information.

The custom format means that you can have the columns in any order you wish. The import wizard will allow you to map the columns in your file to the fields in Roll Call. This format also allows you to pull in custom fields.

To import this type of file, do the following:

1. Expand the People menu on the left sidebar
2. Click on Import
3. Choose the One Row Per Person Custom Format
4. Click NEXT
5. Choose a Default Association. This is used if the record doesn’t have an association value. Association is the membership category (how are they involved in your church)
6. Choose a Default Family Position. This is used if the record doesn’t have this value. We allow Husband, Wife, Adult, Youth, Child and Other.

7. Enter the line number where the data begins in your file. For example, if you had headers in your file, the data probably starts on line 2. If you don’t have any headers, the data probably starts on line 1.
8. Click LOAD FILE and navigate to the file you want to import. Highlight it, then click OPEN.
9. In the lower section you will need to map the columns from your file to the fields in Roll Call. Click on the header [Skip] and choose from the list of available fields.
10. Once you’ve mapped all the fields, click FINISH in the lower right to process the import.
One Row Per Family Standard

The one row per family means that there will be one row in the spreadsheet for each family unit. There will be a column for family name, husband’s name, wife’s name, child1 name, child2 name, etc.

The standard format means that a very specific order to the columns is required. The order is outlined on the screen below. If you do not have a piece of information, you still need to leave a blank column for that field.

![Image of the import wizard with a list of fields]

To import this type of file, do the following:
1. Expand the People menu on the left sidebar
2. Click on Import
3. Choose the One Row Per Family Standard Format
4. Click NEXT
5. Choose a Default Association. This is used if the record doesn’t have an association value. Association is the membership category (how are they involved in your church)
6. Choose a Default Family Position. This is used if the record doesn’t have this value. We allow Husband, Wife, Adult, Youth, Child and Other.
7. Enter the line number where the data begins in your file. For example, if you had headers in your file, the data probably starts on line 2. If you don’t have any headers, the data probably starts on line 1.
8. Click LOAD FILE and navigate to the file you want to import. Highlight it, and click OPEN.
9. Click FINISH in the lower right to process the import.

One Row Per Family Custom

In this file format, there will only be one row in the spreadsheet for each family unit. There will be a column for family name, husband’s name, wife’s name, child1 name, child2 name, etc.

The custom format means that you can have the columns in any order you wish. The import wizard will allow you to map the columns in your file to the fields in Roll Call. This format also allows you to pull in custom fields.

To import this type of file, do the following:
1. Expand the People menu on the left sidebar
2. Click on Import
3. Choose the One Row Per Person Custom Format
4. Click NEXT
5. Choose a Default Association. This is used if the record doesn’t have an association value. Association is the membership category (how are they involved in your church)
6. Choose a Default Family Position. This is used if the record doesn’t have this value. We allow Husband, Wife, Adult, Youth, Child and Other.
7. Enter the line number where the data begins in your file. For example, if you had headers in your file, the data probably starts on line 2. If you don’t have any headers, the data probably starts on line 1.
8. Click LOAD FILE and navigate to the file you want to import. Highlight it, then click OPEN.
9. In the lower section you will need to map the columns from your file to the fields in Roll Call. Click on the header [Skip] and choose from the list of available fields.
10. Once you’ve mapped all the fields, click FINISH in the lower right to process the import.

Use Add a Family (Basic)

The Add a Family screen is a great way to get the basic information about a family entered into Roll Call quickly. To use the this screen:
   1. Expand the People menu.
   2. Click on Add a Family

Enter Family Information

The top section of this screen is where you enter the common family information. Enter the following pieces of information
   1. Type - Choose either Family or Organization.
   2. Last Name – Enter the last name for the family, or organization name if you are entering a business.
   3. Primary Phone – Enter the home phone number for the family.
   4. Unlisted – Mark this checkbox if the family wants the home phones unlisted.
   5. Alt Phone – Enter a second home phone number if applicable for the family.
   6. Street – Enter address line 1 of the families address.
   7. More Address – Enter address line 2 if applicable. Typically an apartment or suite number.
   8. City – Enter the city portion of the families address.
   9. State – Enter the state portion of the families address.
   10. Postal Code – The zip code or postal code portion of the families address.
   11. Do Not Send Mail – Mark this box if the family does not want to receive mail from your organization.
   12. Unlisted Address – Mark this box if the family wants their address unlisted.
   13. Family Email – Enter the email address that should be used when sending “family” emails.
   14. Shepherd Area – Indicate the person, deacon or zone that is responsible for this family.
Enter the family information.

Enter Family Members Information

Use the lower section to enter the information for each family member. Use the plus sign in the lower left corner to open up a row to add another family member.

1. **Family Position** - Choose Husband, Wife, Adult, Youth or Child to indicate their family position.
2. **First Name** – Enter the first name of the family member.
3. **Last Name** – If the family member has a different last name, enter it here.
4. **Date of Birth** – Enter the family member’s birthday. Make sure to enter a 4 digit year.
5. **Gender** – Select the appropriate gender for the family member.
6. **Association** – Select the appropriate association or membership status for this family member.
7. **Cell Phone** – Enter the cell phone number for this family member if they have one. Enter the last name for the family, or organization name if you are entering a business.
8. **Marital Status** – Indicate the marital status for this family member.
9. **Grade** – If the family member is in elementary, middle or high school, enter their grade. Values accepted are K – 12.
Once you’ve completed entering the information for a family, click:
1. SAVE & CLOSE to save the information and close the window.
2. SAVE & VIEW to save the information and go to the Family Details screen.
3. SAVE & NEW to save the information and clear the window.
4. CANCEL to close the window without saving the information.

Use Add a Family (Detail)

The Family Detail screen can be used to add much more detail for each family member. Use this screen if you need to pull in pictures, enter custom fields or other detailed information not available in the Add a Family screen.

To add a family using this window:
1. Expand the People menu and click Search Profiles
2. Click the plus sign in the lower left corner.

General Information

The main portion of this screen allows you to pull in pictures for family members, enter general information about the family member and the family’s address and home phone number. Enter the following information that applies:
1. **Title** – Select the formal title for this family member.
2. **First Name** – Enter the first name for the family member.
3. **Nickname** – If different than the first name, enter the “goes by” name.
4. **Middle** – Enter the middle name or initial for the family member.
5. **Suffix** – Enter the suffix, for example Jr., Sr., III etc.
6. **Maiden Name** – Enter the maiden name for this family member.
7. **Family Position** – Select Husband, Wife, Adult, Youth or Child.
8. **Gender** – Select the gender for this family member.
9. **Marital Status** – Select the marital status of this family member.
10. **Spouse** – If this family member is married, enter their spouse name.
11. **Association** – Enter the membership status of this family member.
12. **Birthdate** – Enter the birthday for this family member. Year is not required when inputted from here.

Enter the general information for the first person in the family.
13. Personal email – Enter the email address for this individual.
14. Unlisted – Mark if the email address should be unlisted (not in directories).
15. Staff – Mark if this individual is on staff at your organization.
16. Cell Phone – Enter the cell phone number for the family member.
17. Unlisted – Mark if the cell phone should be unlisted.
18. Carrier – Select the cell phone carrier used by this family member. This is required to send texts if you will not be using the NexMo SMS service.
19. Work Phone – Enter the business phone number for this individual.
20. Ext. – Enter the extension for the work phone number.
21. Unlisted – Mark this box if the work phone number should be unlisted.
22. Exclude from Directories – Mark if this person does not wish to be included in any directories.

To pull in a profile picture, click on the plus sign to navigate to your operating system. Highlight the file name of your photo, then click OPEN. Or you may simply drag and drop the picture into the box for the profile picture.

Once you entered this information you may:
1. Move to the lower section to enter the family address and phones.
2. Click SAVE & CLOSE to save the information and close the window.
3. Click SAVE & NEW to enter a new family member or an entirely new family.
4. Click CANCEL to close the window without saving any of the information.

Family Info
The family info section includes a family photo, home phones and address information. Enter the following information:
1. Primary Phone – Enter the home phone number for the family.
2. Unlisted – Mark if the home phone should be unlisted.
3. Alt Phone – Enter an alternate home phone number if applicable.
4. Family No – If you are manually assigning family numbers, enter it here. A family number is the unique identifier for the family. It can be used with the check in system.
5. Wedding Date – Enter the anniversary date for the husband and wife in this family.
6. Street – Enter street address where this family lives or receives mail.
7. **More Add** – Enter the PO Box or apartment portion of the address.
8. **City/St/Postal** – Enter the city, state or providence abbreviation and zip code or postal code portion of the address.
9. **Bad Address** – Mark this box if you know this address is not valid.
10. **Do not Send** – Mark this box if the family does not wish to receive mail from your organization.
11. **Unlisted** – Mark this box if the family wishes the address to be unlisted.
12. **Family Email** – Enter the email address that should be used to receive “family” emails.
13. **Shepherd Area** – Enter the person, deacon or zone that is responsible for watching over this family.

To pull in a family picture, click on the plus sign to navigate to your operating system. Highlight the file name of your photo, then click OPEN. Or you may simply drag and drop the picture into the box for the profile picture.

Once you entered this information you may:
1. Enter data in another section such as salutations or additional phones.
2. Click SAVE & CLOSE to save the information and close the window.
3. Click SAVE & NEW to enter a new family member or an entirely new family.
4. Click CANCEL to close the window without saving any of the information.

### Salutations

The salutation section is used to enter an optional mailing name and directory listing information. To enter this information:

1. Click on Salutations on the left sidebar section.
2. **Optional Mailing Name** – Enter the mailing name to be used for this family. This will override our standard addressing options. By default we use John & Sue Baker or Mr. & Mrs. John Baker. If there is an optional mailing name all correspondence will use that name.
3. **Family Picture Label** – This is the label that will be used in the family picture directory.

Once you entered this information you may:
1. Enter data in another section.
2. Click SAVE & CLOSE to save the information and close the window.
3. Click SAVE & NEW to enter a new family member or an entirely new family.
4. Click CANCEL to close the window without saving any of the information.
Additional Phones
The additional phones section can be used to enter pager, fax or other phone numbers for a family member. To enter this information:

1. Click on Additional Phones on the left sidebar section.
2. **Pager** – Enter the pager number for this family member.
3. **Fax** – Enter the fax number for this family member.

The additional phone section on the right can be used to enter an unlimited number of phone numbers. Click on the plus sign in the lower right to open up a row for data entry. Enter the following:

1. **Phone** – Enter the phone number.
2. **Ext** – Enter any extension associated with this phone number.
3. **Description** – Enter the type of phone number. For example, second cell, grandmas, babysitters etc.)

Once you entered this information you may:

1. Enter data in another section.
2. Click SAVE & CLOSE to save the information and close the window.
3. Click SAVE & NEW to enter a new family member or an entirely new family.
4. Click CANCEL to close the window without saving any of the information.

Custom Fields
There are three types of custom fields available in Roll Call. There are “fields” which are text type fields. There are “checkboxes” which are yes/no or true/false type fields. And there are date fields. These fields can be used to track pieces of information your organization needs, but that are not included in the standard Roll Call fields.

If your organization has defined custom fields, enter that information:

1. Click on Custom Fields on the left sidebar section.
2. Click on the tab for Fields, Check Boxes or Dates.
3. Enter the value associated with the family member.
Enter custom date values here.

Use the CHANGE TITLES button to define the labels you wish to use for the custom fields. These labels will be consistent across all records in your database.

Once you entered this information you may:
1. Enter data in another section such as salutations or additional phones.
2. Click SAVE & CLOSE to save the information and close the window.
3. Click SAVE & NEW to enter a new family member or an entirely new family.
4. Click CANCEL to close the window without saving any of the information.

**Significant Dates**

Significant dates are “life event” type dates that your organization may want to track. Examples of a significant date might be the death in a family, diagnosis of an illness or a divorce.

To enter a significant date for a family member:
1. Click on Significant Dates on the left sidebar.
2. Click the plus sign underneath the dates section to open up a row for data entry.
3. Date – Enter the date of the significant event.
4. Type - Enter the type of significant event.

Once you entered this information you may:
1. Enter data in another section.
2. Click SAVE & CLOSE to save the information and close the window.
3. Click SAVE & NEW to enter a new family member or an entirely new family.
4. Click CANCEL to close the window without saving any of the information.
Click the + sign to open up a row to enter the significant date and event type.

Keywords
Keywords are a great way to categorize folks in your database. They can be used to track spiritual gifts, talents or volunteer interests. To enter this information for the family member:

1. Click on Keywords on the left sidebar.
2. Click on the plus sign underneath the keywords section. This opens up a row for data entry.
3. Date - Enter the date if applicable. We’ve had several churches use this to track responses from a questionnaire. This date was the date of the survey.
4. Keyword – Select the keyword you’d like to assign to this person
5. Ranking – Entering the ranking if applicable. This could represent a level of interest.
Once you entered this information you may:
1. Enter data in another section.
2. Click SAVE & CLOSE to save the information and close the window.
3. Click SAVE & NEW to enter a new family member or an entirely new family.
4. Click CANCEL to close the window without saving any of the information.

**Check In Settings**

The check in settings are pieces of information used by the check in/out system in Roll Call. You can enter allergy information, check in alerts that pop up when a child checks in as well as custody comments that are displayed when a child is checked out. To enter this information for the child:

1. Click on Check In Settings on the left sidebar.
2. Click on the General tab.
3. **Allergies** - Enter any allergies that this child has. This information can be printed on the name tag and check in roster, when a child is checked into a class.
4. **Check In Alert** – Enter the alert that should be displayed when this child checks into a class.
5. **Custody Comments** – Enter any pertinent custody information.

If you will be using the system to record check out’s, you can set up who is allowed to check this child out. To enter this information:

1. Click on Check In Settings on the left sidebar.
2. Click on the Authorized CheckOut tab.
3. Click on the plus sign in the lower left of the section to add a person to the list.
4. Enter the Last Name of the authorized person. Choose the appropriate person from the list that is returned.
5. Enter the relationship between the child and the authorized person.
Click the + sign to add an authorized pickup person.

Once you entered this information you may:
1. Enter data in another section.
2. Click SAVE & CLOSE to save the information and close the window.
3. Click SAVE & NEW to enter a new family member or an entirely new family.
4. Click CANCEL to close the window without saving any of the information.

Comments
The comments section includes an area for general free form comments, allergy information and confidential comments. To enter these:

1. Click on Comments on the left sidebar.
2. Click on the General tab.
3. Enter any comments or allergy information for this family member.
4. Click on the Confidential Comments tab.
5. Click on the plus sign in the lower left to open the window to enter confidential comments. A user must have specific security privileges to enter and view this information.
Click on the + sign on the confidential comments tab to enter those comments.

Once you entered this information you may:
1. Enter data in another section.
2. Click SAVE & CLOSE to save the information and close the window.
3. Click SAVE & NEW to enter a new family member or an entirely new family.
4. Click CANCEL to close the window without saving any of the information.

Add a New Family Member

When you have entered all the information for this specific individual, you can begin entering the details for another family member. To do this, click on the SAVE & NEW button. You will be given a choice to add a new family member or a completely new family. Choose the option to “add a new family member”.
MANAGING BACKGROUND CHECKS

To ensure the safety of the children in your care, your ministry should run periodic background checks on the volunteers and staff. You can track those background check requests and the results using the Roll Call database. This will allow you to easily determine who has a current check, obsolete or even a missing background check.

Enter Background Check Request

Once you have requested a background check, you can enter that information into Roll Call. It can be entered through the Background Check menu, or it can be entered from the volunteer’s profile.

From Menu

To enter the fact that a background check has been requested, do the following:
1. Expand the People menu.
2. Click on Background Checks.
3. Click on the plus (+Add) sign in the lower right. The Background Check window will be displayed.

4. Enter the Last Name of the volunteer who the check is for. Press the tab key. A list of people with that last name will be displayed. Choose the specific volunteer.
5. Enter the Request Date. This is the date that the background check was submitted to your background check provider.
6. Enter department or ministry area that Requested the check.
7. Mark the box to indicate whether this check is for an Employee or Volunteer.
8. Choose the Type of Check. The standard options are Fingerprint, Background, Reference or Interview.
9. Indicate the Agency or Reference that will be performing the background check.
Enter the data pertaining to the background check request.

Once you’ve completed entering the information, click:
1. SAVE & CLOSE to save the information and close the window.
2. SAVE & NEW to save the information and clear the window to begin entering a new background check.
3. CANCEL to close the window without saving the information.

**From within Person’s Profile**
The background check request can also be entered through a person’s profile record. The first step to entering the background check information from a person’s record is to retrieve that record.

1. Expand the People menu.
2. Enter the Last Name of the volunteer to the right of the FIND BY drop down.
3. Double click on the appropriate person’s record.
4. Click on the Background Check link on the left sidebar.
To begin entering the background check request information, do the following:

1. Click on the plus (+) sign in the lower left corner of the section.
2. Enter the *Request Date*. This is the date that the background check was submitted to your background check provider.
3. Enter department or ministry area that *Requested* the check.
4. Mark the box to indicate whether this check is for an *Employee* or *Volunteer*.
5. Choose the *Type of Check*. The standard options are Fingerprint, Background, Reference or Interview.
6. Indicate the *Agency* or *Reference* you will be using to perform the check.

![Enter the data pertaining to the background check request.](image)

Once you’ve completed entering the information, click:

1. SAVE & CLOSE to save the information and close the window.
2. SAVE & NEW to save the information and clear the window to begin entering a new background check.
3. CANCEL to close the window without saving the information.

**Enter Background Check Results**

Once your ministry receives the results from the background check, you can enter those into Roll Call as well. They can be entered through the Background Check menu, or it can be entered from the volunteer’s profile.

**From Menu**

To enter the result, do the following:

1. Expand the People menu.
2. Click on Background Checks.
3. Enter the volunteer’s last name to the right of the find by drop down.
4. A list of all the background checks for people with that last name will be displayed.
5. Double click on the specific background check that needs to be updated with the results.
Choose Background Check from the menu, then double click on specific background check.

Enter the following result information:

1. Enter the Report Date provided by the background check agency.
2. Select the Report Result that is applicable based on the report.
3. Indicate the Clearance Level, or what age ranges this volunteer can work with based on the specific results of this background check.
4. Choose the Overall Clearance Level for this volunteer. This level for the individual may be different based on multiple background checks.
5. Enter the Report Text from the report provided by the agency. This is a free format text area.
Once you’ve completed entering the information, click:
1. SAVE & CLOSE to save the information and close the window.
2. SAVE & NEW to save the information and clear the window to begin entering a new background check.
3. CANCEL to close the window without saving the information.

**From within Person’s Profile**

The background check request can also be entered through a person’s profile record. The first step to entering the background check information from a person’s record is to retrieve that record.

1. Expand the People menu
2. Enter the Last Name of the volunteer to the right of the FIND BY drop down.
3. Double click on the appropriate person’s record.
4. Click on the Background Check link on the left sidebar.
5. Double click on the specific background check that needs to be updated with the results.

Enter the following result information:

1. Enter the *Report Date* provided by the background check agency.
2. Select the *Report Result* that is applicable based on the report.
3. Indicate the *Clearance Level*, or what age ranges this volunteer can work with based on the specific results of this background check.
4. Choose the *Overall Clearance Level* for this volunteer. This level for the individual may be different based on multiple background checks.
5. Enter the *Report Text* from the report provided by the agency. This is a free format text area.

Once you’ve completed entering the information, click:
1. SAVE & CLOSE to save the information and close the window.
2. SAVE & NEW to save the information and clear the window to begin entering a new background check.
3. CANCEL to close the window without saving the information.
Double click on the Background Check record, then enter the results here.

Research Background Checks

You may be wondering if it’s worth the time to enter your background check reports into Roll Call. It is if you’d like to quickly determine who has a current check, who is missing a check or who has an outdated or obsolete background check. These questions are easily answered with some of the queries or standard reports available in Roll Call.

Find Current

To get a listing of current background checks, you’ll first need to determine what “current” is. Does your ministry consider in the last year, two years or three years to be current. There are two ways to get a listing of current background checks. You can perform a query from the background check screen or you can run a background check report.

Let’s assume for this example that you consider any background checks in the last year to be current. To perform the query, do the following:

1. Expand the People menu.
2. Click on Background Checks
3. Click on the SEARCH icon.
4. From the Query Editor, choose Report Date in the Field drop down box.
5. In the Comparison box, highlight “is greater than or equal to”.
6. In the Value box, enter the date that is one year earlier. This example shows the REPORT Date is greater than or equal to 01/01/2016.
7. Click QUERY.
8. The resulting list contains your current background checks.
To create a background check report, do the following:

1. Expand the People menu.
2. Click on Reports.
3. Click on Backgrounds Checks.
4. On the Criteria tab choose Run For “search the database”.
   a. From the Query Editor, choose Report Date in the Field drop down box.
   b. In the Comparison box, highlight “is greater than or equal to”.
   c. In the Value box, enter the date that is one year earlier than today. For example, if today is 8/28/14, you would enter 8/28/13.
   d. Click QUERY.
5. On the Columns tab, you can pick which pieces of information you’d like included in the report. Double click on the field name to move it to the Selected Column. You can choose fields from the People, Addresses, Background Checks or Special Columns area.
6. Click GENERATE to run the report.

Find Missing
To find those volunteers who are missing a background check, you will need to have those
volunteers in one or more groups. To find the “missing” checks, do the following:

1. Expand the Groups menu.
2. Click on Reports.
3. Click on Background Checks for Groups.
4. On the Groups tab, click on each group that represents your volunteers that should have a background check.
5. On the Criteria tab, in the missing section, click on the types of reports you are interested in.
6. Click GENERATE to run the report.
7. The report will list all the volunteers in those groups and indicate if the report is missing.
Find Obsolete
To find those volunteers that have an obsolete background check, you will need to have those
volunteers in one or more groups. To find the “obsolete” checks, do the following:

1. Expand the Groups menu.
2. Click on Reports.
3. Click on Background Checks for Groups.
4. On the Groups tab, click on each group that represents your volunteers that should have a
background check.
5. On the Criteria tab, in the obsolete section, click on the types of reports you are interested
in.
6. Enter the “older than” date. This will tell the system what is considered obsolete.
7. Click GENERATE to run the report.
8. The report will list all the volunteers in those groups and indicate if the report is obsolete.
Choose the type of background checks you’d like to consider for this report.

Lists the volunteers with obsolete checks.
RECORDING VISITATIONS

In Roll Call, visitations are considered those times that someone from your ministry (pastor, staff member, deacon, elder) goes out and visits someone from the congregation.

Print Visitation Log

The visitation log is a three part report. The first section outlines the basic information for a family. The second part contains the details of the last visit with this family. The third part is a section for the caller to write notes.

To print the visitation log, you’ll need to decide which families need to be visited. Do you need a log for families of a certain associations or a specific family? To create the visitation logs, do the following:

1. Expand the People menu.
2. Click on Reports
3. Click on Visitation Log
4. If you’d like a log report for every family of a certain association, click over the specific associations.
5. If you’d like the log report for a specific family, click the box for individual. A pop up window will be presented for you to enter the last name, then pick from a list of folks with that last name.

6. If you’d like a log report for folks missing since a certain time, enter the date, then check the box for missing.

7. Click GENERATE to send the report to the printer.

**Enter Visitation Notes**

There are several ways that you can record the fact that a visitation occurred, who conducted the visit and any remarks or notes. These can be entered from the visitation section, from the person’s profile or through Roll Call Connect (if you have this module).

**From Menu**

To enter a visitation, do the following:

1. Expand the People menu.
2. Click on Visitation.
3. Click the plus (+) sign in the lower left of the screen. The visitation window will pop up.
4. Enter the last name of the family that was visited then press the TAB key.
5. A list of people with that last name will be presented. Choose the appropriate person.
6. Enter the last name of the person who is conducting the visit then press the TAB key.
7. A list of people with that last name will be presented. Choose the appropriate person.
8. Select the type of visit (Phone or In Person).
9. Enter the duration of the visit.
10. The date will default to today. You may change that to reflect the exact date of the visit.
11. Enter any notes or remarks about the visit.

Once you’ve completed entering the information, click:

1. SAVE & CLOSE to save the information and close the window.
2. SAVE & NEW to save the information and clear the window to begin entering a new visitation notes.
3. CANCEL to close the window without saving the information.
From within Person’s Profile

The visitation information can also be entered directly into the profile record of the person who was visited.

1. Expand the People menu
2. Enter the Last Name of the person who was visited to the right of the FIND BY drop down.
3. Double click on the appropriate person’s record.
4. Click on the Visit link on the left sidebar.
5. Click on the plus (+) sign in the lower left.
6. The visitation window will pop up.
7. Enter the last name of the person who conducted the visit. Press the TAB key.
8. A list of people with that last name will be returned. Choose the appropriate person.
9. Select the type of visit (phone or in person)
10. Enter the length or duration of the visit.
11. Enter any notes or remarks.

Once you’ve completed entering the information, click:

1. SAVE & CLOSE to save the information and close the window.
2. SAVE & NEW to save the information and clear the window to begin entering a new visit.
3. CANCEL to close the window without saving the information.

From Roll Call Connect

If your ministry uses Roll Call Connect, staff members can enter visitation notes from their mobile devices or through a browser at home.

To enter visitation notes through Connect, log into Roll Call Connect and do the following:

1. Click on the Find Family.
2. Enter the Last Name of the person who was visited and tap the SEARCH button.
3. Click on the appropriate family.
4. Click the link for Household Visits.
5. Click the link for Add Visit.
6. Choose which person in the family was visited.
7. Select the type of visit (phone or in person).
8. Enter the length or duration of the visit.
9. Enter any notes or remarks.
Enter the last name, then click SEARCH. Click on the appropriate family.

Tap on Household Visits.

Enter visitation information.

Click on Add Visit.
Once you’ve completed entering the information, tap or click:
1. SUBMIT to save the information and close the window.
2. CANCEL to close the window without saving the information.

Print Visitation History
The visitation history report lists all visitations that have occurred since a given date. To create this report:
1. Expand the People menu.
2. Click on Reports.
3. Click on Visitation History.
4. Enter the date of the oldest visitation you’d like to include.
5. Click GENERATE. The report will be sent to your printer.
LOOKING UP PEOPLE INFORMATION

Search Profiles
Finding people in your database can be accomplished in a variety of ways.
1. Use the Find By area to search by common fields.
2. Use the Search box to find folks by Last Name or Keyword.
3. Use the Query Editor to find folks by other fields

Find By
The most common characteristics that people would want to search on can be found in the Find By drop down box. These fields are Last Name, First Name, Association, Family Position, Email, Street, City, Postal Code, Family Number, Badge No, Envelope Number and Keyword. To find a person or listing of people using this method, do the following:
1. Expand the People menu.
2. Click on Search Profiles.
3. Select field you’ll be using as the find by criteria.
4. Enter the Value in the field to the right of the drop down box.
5. As you enter the field, the results will be displayed below in the people list.

Let’s take a look at an example where you are looking for a specific individual. You would probably find them by their last name. From the Search Profiles window:
1. Leave Last Name selected in the Find by drop down.
2. Enter the last name to the right in the blank field.
3. The results show everyone with that last name.
4. Double click on the specific individual you are looking for.

In our next example, let’s say you are looking for a list of all your members. From the Search Profiles window:
1. Change the Find By drop down to Association.
2. Select Member from the field to the right.
3. The results will show a list of all your members.
To find all your members, choose Association, then select Member.

Search Field

The Search Field in the upper right corner can be used to find people based on their last name or keywords. To find people using this method, do the following:

1. Expand the People menu.
2. Click on Search Profiles.
3. Enter the Name or Keyword in the search box.
4. Press the ENTER key on your keyboard to get your results.

Let’s look at an example where we’d like to get a list of all the people in our database that have the keyword “Mechanic”. To accomplish this:

1. Expand the People menu.
2. Click on Search Profiles.
3. Enter Mechanic in Search Box.
4. Press ENTER key on keyboard.

Enter the keyword you are looking for.
Query Editor

The Query Editor can be a bit intimidating, but it is a very powerful tool. The query editor allows you to find folks based on almost any field in the database or combination of fields. In this section, we’ll look at a simple query. For more complex queries, please see the chapter “Using the Query Editor”. To perform a query:

1. Expand the People menu on the left sidebar.
2. Click on Search Profiles.
3. Click on the SEARCH icon at the top.
4. The Query Editor is returned.
5. Use the Field drop down box to choose the field that you’ll use as your criteria.
6. Highlight the Comparison operator that is applicable.
7. Enter the Value of the field you are looking for.
8. Press the QUERY button.

Let’s take a look at a simple example. Let’s say you need a list of all the women in the congregation. To get this list, do the following:

1. Expand the People menu on the left sidebar.
2. Click on Search Profiles.
3. Click on the SEARCH icon at the top.
4. The Query Editor is returned.
5. Use the Field drop down box and select Gender.
6. Highlight the Comparison operator “is equal to”.
7. Enter the Value “Female”.
8. Press the QUERY button.
9. You now have a list of all the females.

Customize Profile Window

Each Roll Call user can customize which fields are displayed in the Search Profiles window. To select or de-select fields for display, do the following:

1. Expand the People menu on the left sidebar.
2. Click on Search Profiles.
3. Click on the PREFS icon on the top.
4. Double click on any of the fields on the left to move them to the selected column.
5. To remove a field from the window, double click on it from the selected column to remove it.
6. Click SAVE & CLOSE button to save your preferences.

Tagged People/Tagged Groups

Each Roll Call user can create a set of tagged people and/or groups. You may want to do this if you want to work with or contact a certain group of people. For example, if you are the Pastor and you want to quickly send two of your elders a quick email, you can tag those two elders. Then you can do all your work under the Quick Search>Tagged people.

Let’s take a look at our example of the Pastor looking to email two or three of his elders. To tag the elders look under search profiles to find them, then do the following:

1. Expand the People menu on the left sidebar.
2. Click on Search Profiles.
3. Right click on the people to tag.
4. Select TAG on each person to tag. You can now email, text, or write a letter to more than one person at a time, as long as each person you wish to tag is highlighted. To select more than one person to highlight at a time, hold down the windo/CMD key in windows, Apple key on a mac.
5. When you are ready to unTAG someone, simply right click again while their name is highlighted and select UNTAG.

Now, go to the Search Profiles and Quick Search menu and choose Tagged People. You’ll see the list of elders. Proceed with your email, text, mail merge, etc...

To instead tag a group, say a group of elders or maybe you’d like to email two of your groups of Sunday School classes...
1. Go to Groups>Search
2. Highlight the groups you wish to tag.
3. Right click on the group to tag.
4. Go to the Quick Search Menu under Groups and select TAGGED GROUPS.
5. Continue with your email, text, mail merge, etc..
6. Right click on the group again and select UNTAG to untag your group.
To look up a specific person and view their details, do the following:

1. Expand the People menu.
2. Click Search Profiles.
3. Enter the Last Name of the person you wish to look up.
4. From the results list, double click on the specific person.
5. From within that person’s record, click on the items on the left pane to view those details.

**General Information**

The main portion of this screen will display the name, birthdate, association and other general contact information for this person. Notice all the family members are also listed in the upper left. Each of the fields displayed on the portion of this screen are described below.

1. **Title** – The formal title for this family member.
2. **First Name** – The first name for the family member.
3. **Nickname** – The “goes by” name.
4. **Middle** – The middle name or initial for the family member.
5. **Suf** – The suffix, for example Jr., Sr., III etc.
6. *Maiden Name* – The maiden name for this family member.
8. *Gender* – The gender for this family member.
9. *Marital Status* – The marital status of this family member.
10. *Spouse* – The spouse name if this person is married.
11. *Association* – The membership status of this family member.
12. *Birthdate* – The birthday for this family member. Year is not required.
13. *Grade* - The grade in school (K-12) if the individual is a child or youth.
14. *Personal email* – The email address for this individual.
15. *Unlisted* – Marked if the email address should be unlisted (not in directories).
16. *Staff* – Marked if this individual is on staff at your organization.
17. *Campus* – Indicates which campus this person regularly attends. This field is only available if the multi-campus preference is set.
18. *Cell Phone* – The mobile phone number for the family member.
19. *Unlisted* – Marked if the cell phone should be unlisted.
20. *Carrier* – The cell phone carrier used by this family member. This is required to send texts if you will not be using the NexMo SMS service.
21. *Work Phone* – The business phone number for this individual.
22. *Ext.* – Enter the extension for the work phone number.
23. *Unlisted* – Marked if the work phone number should be unlisted.
24. *Exclude from Directories* – Marked if this person does not wish to be included in any directories.

Family Info

The family info section includes a family photo, home phones and address information. If this information is not shown on the screen, click on Family Info from the list on the left sidebar. Each piece of information in this section is described below.

1. *Primary Phone* – The home phone number for the family.
2. *Unlisted* – Marked if the home phone should be unlisted.
3. *Alt Phone* – An alternate home phone number if applicable.
4. *Family No* – The unique identifier for the family. It can be used with the check in system.
5. *Wedding Date* – The anniversary date for the husband and wife in this family.
6. *Street* – The street address where this family lives or receives mail.
7. *More Add* – The PO Box or apartment portion of the address.
8. **City/St/Postal** – The city, state or providence abbreviation and zip code or postal code portion of the address.
9. **Bad Address** – Marked if this address is not valid.
10. **Do not Send** – Marked if the family does not wish to receive mail from your organization.
11. **Unlisted** – Marked if the family wishes the address to be unlisted.
12. **Family Email** – The email address that should be used to receive “family” emails.
13. **Shepherd Area** – The person, deacon or zone that is responsible for watching over this family.

The alternate address tab contains information for those families who live in a different part of the country for part of the year. The Alternate Address tab contains the following information:

1. **Street** – The street address where this family lives or receives mail.
2. **More Add** – The PO Box or apartment portion of the address.
3. **City/St/Postal** – The city, state or providence abbreviation and zip code or postal code portion of the address.
4. **Phone** – The home phone and alternate phone where they can be reached while at this “alternate address”.
5. **Effective Month Number** – The month and day that this address and phone become effective.
6. **End Month Number** – The month and day that this address will no longer be used.

---

**Salutations**

The salutation section contains optional mailing name and directory listing information. To view this information, click on Salutations from the list on the left sidebar. A description of the fields is listed below:

1. **Optional Mailing Name** – If the optional mailing name is used, it will override our standard addressing options. Our standard options include using the title, for example, Mr. & Mrs. Joe Smith or using the first names such as Joe & Sue Smith. If you wanted everything addressed to “The Smith Family”, you would enter that as the optional mailing name.
2. **Family Picture Label** – The family name as it will appear in the family picture directory.
Additional Phones

The additional phone section contains other phone numbers for this individual such as fax or pager. To view this information, click on Additional Phones from the list on the left sidebar. A description of the fields is listed below:

1. **Pager** – Enter the pager number for this family member.
2. **Fax** – Enter the fax number for this family member.

The additional phone section on the right can be used to enter an unlimited number of phone numbers.

1. **Phone** – The phone number.
2. **Ext** – Any extension associated with this phone number.
3. **Description** – The type of phone number. For example, second cell, grandmas, babysitters etc.)
Giving

The giving section displays summary and detail contribution information for this person as well as the First Donation Date and Last Donation Date. This area can only be accessed by Roll Call users who have privileges to do so. To access this information, click on Giving in the list on the left sidebar. The different areas and options are described below.

The Giving tab contains a drop down with the options for Summary by Year, Summary Overall and Details. Choose the information you’d like to view.

1. Summary by Year – A tabular report of giving for the last five years.
2. Summary Overall – A summary report of how much was given to each fund.
3. Details – A listing of every gift given by this person.

The Graph tab contains a drop down with the graphing options for Summary by Year, Summary Overall and Details by Month and Details by Week. Choose the information you’d like to view.

1. Summary by Year – A bar chart that displays the giving information for the last five years.
2. Summary Overall – A pie chart that shows the giving by fund for this person.
3. Details by Month – A line graph that shows giving information by month.
4. Details by Week – A line graph that shows giving by week for this individual.

The Accounts tab contains the checking account numbers for this donor if you are using a check reader to input your contributions.

The Settings tab contains those contributions specific settings for an individual. They are as follows:

1. File Individually – This box is marked if the husband and wife in this family wish to have separate contribution statements for tax purposes.
2. Email Receipt - This box is marked if this donor wishes to receive their quarterly and annual contribution statements via email.
Pledges

The pledge section contains a listing of any pledges that this person has made to your organization. Only Roll Call users who have privileges to view this information will be allowed in this section. The following pieces of information are included in the list.

1. **Fund** – The fund or campaign that was pledged to.
2. **Start Date** – The beginning date of their pledge.
3. **End Date** – The ending date of their pledge.
4. **Pledged** – The total amount of their pledge.
5. **Received** – The amount that has been received to date towards this pledge.
6. **Difference** – The difference between the amount promised and the amount paid to date.

The graph tab displays a bar chart comparing the pledges and amounts received.
**Custom Fields**

There are three types of custom fields available in Roll Call. There are “fields” which are text type fields. There are “checkboxes” which are yes/no or true/false type fields. And there are date fields. These fields can be used to track pieces of information your organization needs, but that are not included in the standard Roll Call fields.

To view the custom information, click on Custom from the list on the left sidebar. The Custom Fields tab contains any information for custom text fields. The Custom Checkboxes tab contains any information for custom checkboxes. The Custom Dates tab contains any date information for custom dates that were defined by your organization.

**Significant Dates**

Significant dates are “life event” type dates that your organization may track. Examples of a significant date might be the death in a family, diagnosis of an illness or a divorce.

To view significant date information, click on Significant Dates from the list on the left sidebar. The fields in the list include:

1. *Date* – The date the event occurred.
2. *Event* – The significant event that happened on that date.

**Groups**

Groups in Roll Call are any grouping of people within your ministry. They could be Bible Studies, Volunteers, Small Groups, or Sunday school classes. To view the groups this person is involved in, click on Groups from the list on the left sidebar.

The fields in the groups list are outlined below:

1. *Group Name* – The specific group that the individual is a member of.
2. *Group Status* – Indicates whether or not the group is active or not.
3. *Leader* – Marked if this person is the leader of the group.
4. *Involvement* – Indicates how this person is involved in the group.
5. *Member Status* – Indicates if this person is active within the group.
6. *Comments* – Any comments associated with this group member.
Events
Event registration is a separate subscription service. To add or view events on a person, you must be logged in as a user with EVENTS enabled under the user security as well as a Count Me In subscription. Count Me in is the Event Registration system from By The Book. Call 800-554-9116 to subscribe.

Keywords
Keywords are a great way to categorize folks in your database. They can be used to track spiritual gifts, talents or volunteer interests. To view the keywords for this person, click on Keywords from the list on the left sidebar.

1. Date – The date if applicable. We’ve had several churches use this to track responses from a questionnaire. This date was the date of the survey.
1. **Keyword** – The keyword or category assigned to this individual.
2. **Ranking** – The ranking if applicable. This could represent a level of interest.

**Visits**
In Roll Call, visitations are considered those times that someone from your ministry (pastor, staff member, deacon, elder) goes out and visits someone from the congregation. The fields displayed in the visit list include:

1. **Date** – The date the visit occurred.
2. **Type Visit** – Indicates the type of visit … phone or in person.
3. **Caller** – The person who conducted the visit.
4. **Length** – The duration of the visit.
5. **Comments** – The comments or remarks about the visit.

**Background Checks**
The background check section contains the requests and results of background checks performed on this individual. Only Roll Call users who have access to background check information will be allowed to view this information. To view this section, click on Background Check from the list in the left sidebar. The information displayed in this section includes:

1. **Request Date** – The date the background check was requested.
2. **Type** – The type of check that was requested.
3. **Result** – The result text of the background check.
4. **Clearance Level** – The person’s clearance level based on this specific check.

**Correspondence**
The correspondence section will list any letters that have been sent to this individual. To view, simply click on Correspondence in the list on the left sidebar. The information listed includes:

1. **Letter Date** – The date the letter was printed.
2. **Subject** – The subject of the letter. If the letter was saved in the record, double click to view the body of the letter.
Attendance

The attendance section will give you a graphical representation of this person’s attendance for the last year. The details tab will outline what they have attended on a specific date. To view this information, click on Attendance in the list on the left sidebar.

The Summary tab shows a graph of the last 52 weeks ending on Sunday. It will show how many “things” this individual attended that week. The Details tab will outline the specific date and what this person attended.

Check In Settings

The check-in settings are pieces of information used by the check in/out system in Roll Call. To view this information, click on Checkin Settings from the list on the left sidebar. From the General tab you’ll be able to access the following information:
1. **Allergies** – Any allergies or special needs that this child has. This information can be printed on the name tag and check in roster, when the child is checked into a class.

2. **Check In Alert** – The alert that should be displayed when this child checks into a class.

3. **Custody Comments** – Any pertinent custody information. This information is displayed on check out.

The Authorized Checkout tab lists all the adults that are allowed to check this child out of his/her class. The information included:

1. **Name** – The person who is allowed to check the student out.

2. **Relationship** – The relationship between this person and the child.

**Comments**

The comments section includes an area for general free form comments, allergy information and confidential comments. To view this information, click on Comments from the list on the left sidebar.

On the General tab, you’ll be able to view general comments and special needs or allergy information.
UPDATING FAMILY RELATIONSHIPS

For Marriage

When folks in your congregation get married, this needs to be reflected in Roll Call. From a database standpoint there are several scenarios:

1. The husband or wife is already part of your congregation and has a record in Roll Call, but the other does not.
2. Both the individuals are part of your church and have records in Roll Call.
3. The husband or wife have children as part of their family

Add to Existing Family

To handle the situation where one person is already in the database, but the other is not, do the following:

1. Expand the People menu.
2. Click on Search Profiles.
3. Find the record of the person who is in your database and double click on their record.
4. Change the Family Position to Husband or Wife from Adult.
5. Change the Marital Status to Married.
6. Next, click on the SAVE & NEW button at the bottom of the screen.
7. Choose the option for ADD NEW FAMILY MEMBER.
8. Now you can enter the information for the husband or wife that was not already in your database.
9. Click SAVE & CLOSE when you’ve completed your data entry.

Both are in the Database

To handle the situation where both the husband and wife attend your church and have individual records in the database, do the following:

1. Expand the People menu.
2. Click on Search Profiles.
3. Find the record of the wife in your database and double click on her record.
4. Click on the Head of Family checkbox.
Click on Head of Family check box.

Mark this option, then enter last name of husband. Click OK.

Choose the husband from the list of folks with that last name.
5. Choose the option for “Make this person a member of another family”.
6. Enter the Last Name of the husband.
7. Click OK in the lower right.
8. A list of people with that last name will be displayed. Click to highlight the husband’s name, and click OK.
9. The wife is now part of the husband’s family.
10. Change the Family Position to Husband or Wife from Adult.
11. Click SAVE & CLOSE when you’ve completed your changes.

Now they are in the same family.

Make changes to Family Position, Marital Status and Spouse Name in each record.

Children are Involved
To handle the situation where both the husband and wife attend your church and have individual records in the database and the wife has children, do the following:
1. Expand the People menu.
2. Click on Search Profiles.
3. Find the record of the wife in your database and double click on her record.
4. Click on the Head of Family checkbox.
5. Choose the option for “Make this person a member of another family”.

Children are Involved
To handle the situation where both the husband and wife attend your church and have individual records in the database and the wife has children, do the following:
1. Expand the People menu.
2. Click on Search Profiles.
3. Find the record of the wife in your database and double click on her record.
4. Click on the Head of Family checkbox.
5. Choose the option for “Make this person a member of another family”.

Enter Last Name, highlight children that are moving to new family. Click OK.
6. Enter the Last Name of the husband.
7. Highlight the children’s names on the right that should be moved into the new family.
8. Click OK in the lower right.
9. A list of people with that last name will be displayed. Click to highlight the husband’s name, and click OK.
10. The wife and children are now part of the husband’s family.
11. Change the Family Position for both the husband and wife.
12. Change the Marital Status to Married for the husband and wife.
13. Click SAVE & CLOSE when you’ve completed your changes.

For an Addition to the Family
If a family in your congregation has a baby or adopts a child, you’ll want to add that child to the family. To do this:
1. Expand the People menu.
2. Click on Search Profiles.
3. Find the record of the mom or dad in this family.
4. Next, click on the SAVE & NEW button at the bottom of the screen.
5. Choose the option for ADD NEW FAMILY MEMBER.
6. Now you can enter the specific information for this child.
7. Click SAVE & CLOSE when you’ve completed your data entry.

For Divorce
In the case of divorce, you’ll want to separate the husband and wife’s records into two separate families. To do this:
1. Expand the People menu.
2. Pull up the wife’s record.
3. Click on the Head of Family checkbox.
4. Select the option for “make this person head of a new family”.
5. On the right side of the screen, highlight any children who will be staying with the mom.
6. Mark the Retain Address box, if the wife is staying at the current address.
7. Click OK.
8. The wife and children are now moved into a new family. Make sure to enter any new address information if applicable.
9. Change the Marital Status and Family Position for both the husband and wife.
10. Click SAVE & CLOSE to save your changes and close the people screen.

For a Death in the Family
When a death in the family occurs, you’ll want to properly reflect this in the database. To do this:
1. Expand the People menu.
2. Pull up the record for the deceased.
3. Change their Association to Deceased.
4. If they were married, make sure to change the Marital Status on the surviving spouse to “Widow(er)”.
5. Remove their name from the spouse name field on the surviving spouses record.
6. Make sure they are not marked as the “head of family”.

Change the HOF (head of family) Designation
The head of family check box is a way for us to pull together families properly. Typically the husband is marked as the head of family so that correspondence is addressed properly. If you would like to change who is marked as the head of the family, do the following:
1. Expand the People menu.
2. Pull up the record of the person you’d like to be marked as head.
3. Click on the HOF checkbox.
4. Choose the option for “make this person the head of their current family”.
5. Click OK in the lower right.
6. Click SAVE & CLOSE to save your changes and close the people screen.
DELETING PEOPLE FROM THE DATABASE

If you have people in your database that you would like to delete, this can be done. If they contributed, you’ll first need to transfer their contributions to a “dummy” record for audit trail purposes. Once the contributions are transferred, you can delete their record from within the People Screen or the Search Profiles window.

Transfer Contributions

To transfer contributions for the purposes of deleting a person’s record, you’ll want to make sure you have a “dummy” record in your database. This will become a placeholder for all contributions of deleted people. By doing this, your financial reporting will remain accurate. We recommend that you create a person with a Family Position of “Other” and the Last Name of “_Dummy”.

To transfer contributions, do the following:
1. Expand the People menu.
2. Pull up the record of the person who is to be deleted.
3. Click on Giving on the left sidebar.
4. Use the drop down in this section and select “Details”.
5. Right mouse click on the grid and choose “Select All”.
6. Right mouse click again and choose “Transfer”.
7. Enter “_Dummy” as the last name of the person that you are transferring the contributions to.
8. Double click on _Dummy to select this record from the list.
9. A confirmation message will ask if you are sure you wish to transfer these contributions.
10. Click OK to complete the transfer.
11. A log will be displayed showing the success or failure of the transfer. Click CLOSE to close the log file.
Enter name of new owner of contribution, then select from list.

Log file which displays success or failure of transfers.

**Delete an Individual Record**

If a person in your database does not have any giving records tied to them, they can be deleted. To delete this person using the People screen, do the following:

1. Expand the People menu.
2. Pull up the record of the person you’d like to delete.
3. Click on the DELETE PERSON button in the lower right of the screen.

Click DELETE PERSON from within their record.
4. A window that shows the people that will be deleted is presented. If the person’s name is in red it means they have contributions attached and cannot be deleted.
5. To complete the deletion process, click the DELETE button.
6. A log file showing the success or failure of the deletion process will be displayed. Click CLOSE to close this window.

Delete Multiple People

If there are multiple people in your database that you would like to delete, this can be done all at once through the Search Profiles window. To perform this type of delete, do the following:

1. Expand the People menu.
2. Highlight the people that you would like to delete. If you are using a Windows machine, hold down the CTRL key to highlight multiple people that are not right next to each other in the list. If you are on a Mac, hold down the CMD key to highlight multiple people in the list that are not next to each other.
3. Press the minus (- Delete) sign.
4. A window that shows the people that will be deleted is presented. Anyone who has contributions will be listed in red, and they will not be deleted.
5. Press DELETE to complete the deletion process.
6. A log file showing the success or failure of the deletion process will be displayed. Click CLOSE to close this window.
COMMUNICATING WITH YOUR CONGREGATION

Who Do you Wish to Contact
Before you can send a text, email or create a letter, you’ll need to decide who should receive this communication. You’ll need to get those people queried up in the Search Profiles window or listed on a report. Let’s take a look at several common examples:

1. All your members and regular attenders.
2. Everyone who donated to a specific fund.
3. All folks that are in a small group.

Certain Associations
To get a listing in the Search Profiles window of everyone in a certain association, do the following:

1. Expand the People menu.
2. Click on Search Profiles.
3. Click on the SEARCH icon.
4. Click on the Associations tab.

5. Click over to the selected box all the associations you’d like included in the list.
6. Click the QUERY button in lower right.
7. A list of all the individuals with those associations is displayed.

Once you have your list of people, click on the appropriate communication method.
Now that you have the list, you can click on the applicable icon for Email, Text, Letters or Labels depending on how you’d like to contact these folks.

**Donors to a Fund**

To get a report of all the donors who have given to a certain fund, do the following:

1. Expand the Contributions menu.
2. Click on Reports.
3. Highlight Donor Summary.
4. On the Criteria tab, choose the date range.

5. On the Who tab, select to run for Everyone.
6. On the What tab, select the fund you are interested in.
7. Click GENERATE.

Now that you have the list of people who donated to that fund, you can click on the button for Email, Labels, or Letters depending on how you’d like to contact these folks.
Small Group Members

To get a listing in the Search Profiles window of everyone who is in a small group, do the following:

1. Expand the People menu.
2. Click on Search Profiles.
3. Click on the SEARCH icon.
4. Click on the Groups tab.

5. Click over to the selected box all the small groups you’d like included in the list.
6. Click the QUERY button in lower right.
7. A list of all the individuals in those groups is displayed.

Now that you have the list, you can click on the applicable icon for Email, Text, Letters or Labels depending on how you’d like to contact these folks.
Email

To send emails from Roll Call, each user will need to set up their outgoing email host information. Roll Call works with most email providers. However, there are some providers that require a double handshake and those providers do not work with Roll Call. Yahoo and Hotmail are two examples of outgoing email providers that do not work with Roll Call. Gmail works great but depending on the type of account, you may be limited as to the number of emails you can send in one day.

My Email Settings

To configure the email settings, do the following:
1. Go to the File menu on the top.
2. Select My Email Settings.
3. Choose your preference for Plain Text or HTML emails.
4. Enter the Return Address. This is the “from” email address. If a recipient replies to the email this is the email address it will go to.
5. Enter the Mail Host Name. This is the Outgoing SMTP mail address required by your email provider.
6. Enter the Username and Password for this email account if your provider requires authentication.
7. Mark the box for the SSL if your provider requires SSL encryption.
8. Enter the Port Number, if your provider requires a specific port number.
9. Enter the No Emails/Minute. Your provider may throttle the number of emails that you can send per minute. If so, enter that number here.
10. Click SAVE to save these settings.

Compose Email

When you click on the EMAIL icon the email editor will be presented. There are two types of editors, the plain text or TinyMCE editor for HTML emails. The editor displayed is dependent on the settings under My Email.

Each Roll Call user must set their own outgoing email host settings.
The plain text editor allows you to type in the *Subject* and *Body*. No graphics or linking capabilities are available. You may include one attachment by clicking on the ATTACHMENT button and navigating to the file you’d like to attach. Click the SEND button to send one email to each person in your list.

If you will be using the HTML email editor, you can copy HTML or build your own. To pull in graphics, drag and drop your image file into the editor and place it where you’d like it displayed. Begin typing the content of your email. Notice the font and size options. To create a link within your email, highlight the words you’d like linked, then click the link icon. Enter the URL that you’d like the link to go to.

You also have the ability to send a single email to multiple recipients. To do that, select SINGLE located in the upper right of the email. You may also CC recipients by adding their email addresses in the CC space provided.
If you would like to store the email template for later use, select SAVE TEMPLATE in the bottom right next to the SEND button. When you are ready to open a saved email template, simply find the people you need to email. Press the EMAIL icon. Once in the email editor, use the template drop down to find your saved template. At this point you can make any changes necessary.

**Log**

Once you click SEND, and email will be sent to each person in your list. Once the send is complete a log file will be displayed indicating which email was sent to and if there were any send errors. You may SAVE, PRINT or CLOSE to leave the log and return to Roll Call.

**SMS Text**

There are two methods of sending texts from Roll Call. The first method is free and uses email to send the text. To use this method you will need to know the cell phone number plus the cell phone carrier. You will also need your Email Settings configured properly. The second method is to use the SMS Service from NexMo. Your church will need to set up an account with NexMo.

**My Email Settings**

If your organization will be using the Email method of sending Texts, make sure to configure the following settings:

1. Expand the Home menu on the left sidebar.
2. Select My Email Settings.
3. Choose your preference for *Plain Text* or *HTML* emails.
4. Enter the *Return Address*. This is the “from” email address. If a recipient replies to the email this is the email address it will go to.
5. Enter the *Mail Host Name*. This is the Outgoing SMTP mail address required by your email provider.
6. Enter the *Username* and *Password* for this email account if your provider requires authentication.
7. Mark the box for the *SSL* if your provider requires SSL encryption.
8. Enter the *Port Number*, if your provider requires a specific port number.
9. Enter the *No Emails/Minute*. Your provider may throttle the number of emails that you can send per minute. If so, enter that number here.
10. Click SAVE to save these settings.
Once your email settings are configured, go to the Preference (under the Edit menu on Windows or the Roll Call menu on a Mac). Click on SMS Texting on the left sidebar. Choose the option to use Email.

From the SMS Texting preference choose your method of sending texts.

NexMo Settings

If your organization will be using the SMS service from NexMo, make sure to configure the following settings:

1. Select Preferences from the Edit menu at the top (Windows machines) or the Roll Call menu (Mac machines).
2. Highlight SMS Texting from the left sidebar.
3. Select the option to use NexMo.
4. Enter the API Key provided to your organization by NexMo.
5. Enter the Secret Key provided to your organization by NexMo.
6. Enter the NexMo number that was provided to your organization.
7. Enter any Msg Prefix. This will be in front of every text that is sent.
8. Click OK to save this information.

Find your Numbers and API key from the NexMo dashboard.
Sending the Text
Once you have your preferences and settings configured, you are ready to send a text. To send, do the following:
1. Expand the People menu.
2. Click on Search Profiles.
3. Pull up your list of people that should receive the text.
4. Click the TEXT icon.
5. Type in your text message.
6. Click OK to send the texts.

A log showing the success or failure of each text will be displayed. You can SAVE, PRINT or CLOSE this log file window.

Mail Merge Letters
Once you have determined who you’ll be writing a letter to, click the LETTERS icon from the Search screen or WRITE LETTER button from a report. The Letters window will be displayed for you to compose and print your letter.

The window is made up of three different areas.
1. Template area - lists all saved templates.
2. Addressing options – allows you to select how the letters should be addressed. Should the letter be addressed to each individual in the list or to each family in the list.
3. The word processor is the main part of the window and is used to compose your letter.

Template
The upper left corner of the Letters window is the template area. This area contains all the letters that have been saved as templates. To use a template, highlight the name from this list. The letter will be displayed in the word processing area. You may make any changes necessary, and click PRINT MERGE to print the letters.

Address Options
Before you begin composing your letter, you’ll want to decide who the letter should be addressed to. Will it be addressed to each individual in the list? Or, will it be addressed to the family? Next, choose if you’d like to use formal titles or the first names. Mark your selection. Notice the address block and salutation change based on what you’ve chose here.
Word Processor

The word processor in Roll Call is very similar to other word processors such as Microsoft Word or Word Perfect.

Note the menu bar items: File, Edit, View, Insert, Style, etc. Underneath the menu items are icons for the commonly used features such as New, Open, Save, Print Preview, Print, etc. If you place your cursor over the icon, a text description is displayed for the icon’s function.

To compose your letter, begin typing underneath the salutation. If you would like to pull in data from Roll Call you can use the Insert function. When your cursor is at the point in the letter that you would like to insert some data, select Insert>4D Expression from the word processing menu. Double click on the field you’d like inserted.

To pull data into the body of your letter, use the Insert menu and 4D Expression option.
If you compose your letter in a different word processor and want to copy and paste into Roll Call, make sure to save the original document in a rich text format before doing the copy. If you do not save as a text document first, the formatting characters from the word processor will interfere with the proper formatting in Roll Call.

When you are ready to print your letters, click PRINT MERGE. A letter will be generated for each person or family in your list. Once you send the letters to the printer, you’ll be prompted to save a record of this correspondence in the person’s record. If you’d like to record this, answer yes. The correspondence will be noted in the Letters section of the People screen.

If you’d like to save this letter for use in the future, select File>Save as Template from the word processing menu. You’ll be prompted to name the template.

**Mailing Labels**

Once you have determined who needs a mailing label, click the LABEL icon from the Search screen or CREATE LABELS button from a report. The Label wizard will be presented.

1. From the Options tab, choose how you’d like the labels address. Should they be addressed to the individual or the family? Do you wish to use Titles or First Names? Do you want envelope numbers on the label?
2. From the Customize tab, choose the font and size font that should be used for the label. You can also adjust margins on this page.

3. The View Records tab will list everyone that will have a label printed for them.
4. Click PRINT to send the labels to the printer. Use the Avery 5160/8160 Avery stock. They are the 10 across 3 down labels.

**Envelopes**

Creating and printing envelopes is very similar to creating a mail merge document. The difference is the paper size and formatting options. Let’s say we want to print envelopes for the letters we just wrote to the members of our church. Here’s how you’d do that:

1. Expand the People menu on the left sidebar.
2. Click on Search Profiles.
3. Find by Association and select Member.
4. Click on the LETTERS icon.
5. Choose to address to each individual or to the family.
6. Select File>Page Set up from the word processing window.

In the word processor, change page size and orientation. Move address to middle of page.
7. Change the paper size to your envelope size.
8. Change the orientation to landscape.
9. In the word processing section, delete today’s date.
10. Delete the salutation.
11. Enter the address on the envelope.
12. Type your organization name and address in the return address section.
13. Click PRINT MERGE to print the envelopes.
RUNNING PEOPLE/FAMILY REPORTS

There are quite a few standard reports that can be run to outline people type information. To run a report that has to do with contact information, envelope numbers, birthdays, visitations or background checks, do the following:

1. Expand the People Menu.
2. Click on Reports.
3. Highlight the report you’d like to run.

Directions for each specific report are outlined below.

My Reports

My reports is a great way to build custom reports. You select who you’d like included in the report and what information should be listed in the report. These reports can be saved. To create one, do the following:

1. From the Reports window, select My Reports.
2. On the Criteria tab, select who to include on the report. The Run For drop down allows you to select Everyone, Associations, Groups, Keywords etc.
3. Once you’ve chosen your Run For category, choose the specific values. For example, if you want a list of all your Members and Regular Attenders, you would choose to Run For Associations. Then you would click over Members and Regular Attenders to the Selected column.

4. From the Columns tab, select the information or data you’d like included on the report. Double click on a field name to move it to the Selected column.
5. To sort on a certain value, double click on the field from the Selected column to move it to the Sort column.
6. In the lower right section, choose to list individuals or families. If you choose families only one line per family will be listed.
7. Choose your output format. Do you want to create a csv or text file or would you like to view the report to print it.
8. Click GENERATE to run the report.
From the columns tab, select the fields you'd like displayed in the report.

Report results. Notice the buttons on the right.

If you chose to print/spreadsheet the report, the results are displayed in the main section of the Report Output Window. Use the scroll bars on the bottom and to the right of the report to scroll up and down; left and right.

On the right side of the Report Output Window are actions that can be performed for the report.
1. Click on PAGE SETUP to set your printer and paper size and orientation.
2. Click on PREVIEW to preview the output. Do not send the report to the printer from this preview window; it will only send the first page to the printer.
3. To change fonts, column sizes etc., click CUSTOMIZE. The report will be displayed in 4D View, Roll Call’s spreadsheet program. Make your modifications here.
4. Click on PRINT to send the report to the printer.
5. Click ZOOM IN to make the font in the report larger on your screen.

99
6. Click ZOOM OUT to make the report font smaller on your screen.
7. To save the report as a tab delimited file or html document, click SAVE. Enter the location and name of the file to be saved.
8. Click SAVE SET to save the list of people for use later within Roll Call.
9. Click CREATE LABELS to create address labels (3 across 10 down size) for this list of people.
10. Click WRITE LETTER, to compose a mail merge letter to this list of people.
11. Click EMAIL to send an email to this list people or to email the report to another individual. If you choose Email people, it will send the email to everyone listed in the report.

**Envelope Number Report**

The envelope number report can be used to get a listing of people with their current or next assigned envelope number. To run an envelope number report, do the following:

1. Expand the People menu. Click Reports.
2. From the Reports window, select Envelope Number.
3. On the Criteria tab, select who to include on the report. For this report, you’ll probably want to select Current Env Assigned or Next Env Assigned. This will get you a list of all the people that have an envelope number assigned.

4. From the Columns tab, select the information or data you’d like included on the report. Double click on a field name to move it to the Selected column.
5. To sort on a certain value, double click on the field from the Selected column to move it to the Sort column.
6. In the lower right section, choose to list individuals or families. If you choose families only one line per family will be listed.
7. Choose your output format. Do you want to create a csv or text file or would you like to view the report to print it?
8. Click GENERATE to run the report.

If you chose to print/spreadsheet the report, the results are displayed in the main section of the Report Output Window. Use the scroll bars on the bottom and to the right of the report to scroll up and down; left and right.

On the right side of the Report Output Window are actions that can be performed for the report.
1. Click on PAGE SETUP to set your printer and paper size and orientation.
2. Click on PREVIEW to preview the output. Do not send the report to the printer from this preview window, it will only send the first page to the printer.
3. To change fonts, column sizes etc., click CUSTOMIZE. The report will be displayed in 4D View, Roll Call’s spreadsheet program. Make your modifications here.
4. Click on PRINT to send the report to the printer.
5. Click ZOOM IN to make the font in the report larger on your screen.
6. Click ZOOM OUT to make the report font smaller on your screen.
7. To save the report as a tab delimited file or html document, click SAVE. Enter the location and name of the file to be saved.
8. Click SAVE SET to save the list of people for use later within Roll Call.
9. Click CREATE LABELS to create address labels (3 across 10 down size) for this list of people.
10. Click WRITE LETTER, to compose a mail merge letter to this list of people.
11. Click EMAIL to send an email to this list of people or to email the report to another individual. If you choose Email people, it will send the email to everyone listed in the report.

**Family Report**

The Family Report is a one page summary for each family. It contains multiple sections. The first section contains a list of all the family members, their association and birthdate. The next section contains the individual email addresses and phone numbers. Then the addresses are listed. The final section contains the group involvements for each person in the family.

To run the family report:
1. Expand the People menu.
2. Click on Reports.
4. On the Criteria tab, choose the Run For category.
5. Choose the applicable values for the category you selected.
6. Click GENERATE to print the report for each family that met that criteria. A preview window will be displayed. You will be asked if you’d like to continue with the printing.
Birthday Report
The birthday report will outline people who have a birthday in a certain month. The default birthday report includes the name, address and birthday. To run this report:

1. Expand the People menu.
2. Click on Reports.
3. Highlight Birthday report.
4. On the criteria tab, select the timeframe for birthdays that you’d like to include in the report. Do you want to see all folks that have a birthday next week, this week, a specific month or this year?
5. Select who you’d like to consider for the report. Do you only want to list people who are of a certain association, in a certain group or everyone in your database?
6. On the columns tab, select the fields you’d like displayed on the report. Double click on a field name to move it to the selected column.
7. In the lower right section of the columns tab, choose your output format.
8. Click GENERATE to run the report.

If you chose to print/spreadsheet the report, the results are displayed in the main section of the Report Output Window. Use the scroll bars on the bottom and to the right of the report to scroll up and down; left and right.

On the right side of the Report Output Window are actions that can be performed for the report.
1. Click on PAGE SETUP to set your printer and paper size and orientation.
2. Click on PREVIEW to preview the output. Do not send the report to the printer from this preview window, it will only send the first page to the printer.
3. To change fonts, column sizes etc., click CUSTOMIZE. The report will be displayed in 4D View, Roll Call’s spreadsheet program. Make your modifications here.
4. Click on PRINT to send the report to the printer.
5. Click ZOOM IN to make the font in the report larger on your screen.
6. Click ZOOM OUT to make the report font smaller on your screen.
7. To save the report as a tab delimited file or html document, click SAVE. Enter the location and name of the file to be saved.
8. Click SAVE SET to save the list of people for use later within Roll Call.
9. Click CREATE LABELS to create address labels (3 across 10 down size) for this list of people.
10. Click WRITE LETTER, to compose a mail merge letter to this list of people.
11. Click EMAIL to send an email to this list of people or to email the report to another individual. If you choose Email people, it will send the email to everyone listed in the report.

Anniversary Report
The anniversary report will outline people who have an anniversary in a certain timeframe. The default report includes the name, address, and anniversary. To run this report:

1. Expand the People menu.
2. Click on Reports.
3. Highlight Anniversary report.
4. On the criteria tab, select the timeframe for anniversaries that you’d like to include in the report. Do you want to see all folks that have a anniversary next week, this week, a specific month or this year?
5. Select who you’d like to consider for the report. Do you only want to list people who are of a certain association, in a certain group or everyone in your database?

6. On the columns tab, select the fields you’d like displayed on the report. Double click on a field name to move it to the selected column.

7. In the lower right section of the columns tab, choose your output format.

8. Click GENERATE to run the report.

If you chose to print/spreadsheet the report, the results are displayed in the main section of the Report Output Window. Use the scroll bars on the bottom and to the right of the report to scroll up and down; left and right.

On the right side of the Report Output Window are actions that can be performed for the report:

1. Click on PAGE SETUP to set your printer and paper size and orientation.

2. Click on PREVIEW to preview the output. Do not send the report to the printer from this preview window, it will only send the first page to the printer.
3. To change fonts, column sizes etc., click CUSTOMIZE. The report will be displayed in 4D View, Roll Call’s spreadsheet program. Make your modifications here.
4. Click on PRINT to send the report to the printer.
5. Click ZOOM IN to make the font in the report larger on your screen.
6. Click ZOOM OUT to make the report font smaller on your screen.
7. To save the report as a tab delimited file or html document, click SAVE. Enter the location and name of the file to be saved.
8. Click SAVE SET to save the list of people for use later within Roll Call.
9. Click CREATE LABELS to create address labels (3 across 10 down size) for this list of people.
10. Click WRITE LETTER, to compose a mail merge letter to this list of people.
11. Click EMAIL to send an email to this list of people or to email the report to another individual. If you choose Email people, it will send the email to everyone listed in the report.

**Significant Dates Report**

The significant dates report will outline people who have an anniversary of a significant event during the selected timeframe. The default report includes the name, address, and event type and date. To run this report:

1. Expand the People menu.
2. Click on Reports.
3. Highlight Significant Dates report.
4. On the criteria tab, select the timeframe for the significant date that you’d like to include in the report. Do you want to see all folks that have had a significant event anniversary next week, this week, a specific month or this year?
5. Select who you’d like to consider for the report. Do you only want to list people who are of a certain association, in a certain group or everyone in your database?
6. On the columns tab, select the fields you’d like displayed on the report. Double click on a field name to move it to the selected column.
7. In the lower right section of the columns tab, choose your output format.
8. Click GENERATE to run the report.
On the criteria tab, choose the timeframe for the event.

Choose the type of people to consider when looking for significant events.

Choose the information you'd like included in the report.

If you chose to print/spreadsheet the report, the results are displayed in the main section of the Report Output Window. Use the scroll bars on the bottom and to the right of the report to scroll up and down; left and right.

On the right side of the Report Output Window are actions that can be performed for the report.

1. Click on PAGE SETUP to set your printer and paper size and orientation.
2. Click on PREVIEW to preview the output. Do not send the report to the printer from this preview window, it will only send the first page to the printer.
3. To change fonts, column sizes etc., click CUSTOMIZE. The report will be displayed in 4D View, Roll Call’s spreadsheet program. Make your modifications here.
4. Click on PRINT to send the report to the printer.
5. Click ZOOM IN to make the font in the report larger on your screen.
6. Click ZOOM OUT to make the report font smaller on your screen.
7. To save the report as a tab delimited file or html document, click SAVE. Enter the location...
From the report output you can print, customize, email etc.

and name of the file to be saved.

8. Click SAVE SET to save the list of people for use later within Roll Call.
9. Click CREATE LABELS to create address labels (3 across 10 down size) for this list of people.
10. Click WRITE LETTER, to compose a mail merge letter to this list of people.
11. Click EMAIL to send an email to this list of people or to email the report to another individual. If you choose Email people, it will send the email to everyone listed in the report.

Confirm Data Report

The Confirm Data report summarizes the family’s contact information. This report is set up as a letter to the family so that they can confirm their contact information. To run the report, do the following:

1. Expand the People menu.
2. Click on Reports.
3. Highlight Confirm Data.
4. Select your Run For criteria.
5. Choose the appropriate associations, keywords, or groups based on the category you chose.
6. Click GENERATE.
7. A window will be displayed for you to enter instructions for updating the contact information.
8. Click CONTINUE to begin printing the letters.
Uninvolved Families

The uninvolved families report can look at attendance data, contribution data and group membership data to determine who is “uninvolved”. To run this report:

1. Expand the People menu.
2. Click on Reports.
3. Highlight Uninvolved Families.
4. Click on the Criteria tab.
5. Mark the box for Hasn’t Given if you’d like to use contributions as your “uninvolved” criteria. Enter the date that they haven’t given since.
6. Mark the box for Hasn’t Attended if you’d like to use attendance as your “uninvolved” criteria. Enter the date that they haven’t attended since.
7. Mark the box for Not Active Member of a Group if you’d like to consider group membership as your “uninvolved” criteria.

Set the criteria for “uninvolved”.

From the columns tab, choose the fields you’d like in the report.
8. Choose your Run For criteria. Do you want to evaluate everyone in the database or just look at certain associations, groups or keywords?
9. On the Columns tab, choose the fields you’d like on the report. Double click on the field name to move it to the selected column.
10. In the lower right of the Columns tab, you can choose your output format.
11. Click GENERATE to run the report.

If you chose to print/spreadsheet the report, the results are displayed in the main section of the Report Output Window. Use the scroll bars on the bottom and to the right of the report to scroll up and down; left and right.

On the right side of the Report Output Window are actions that can be performed for the report.
1. Click on PAGE SETUP to set your printer and paper size and orientation.
2. Click on PREVIEW to preview the output. Do not send the report to the printer from this preview window, it will only send the first page to the printer.
3. To change fonts, column sizes etc., click CUSTOMIZE. The report will be displayed in 4D View, Roll Call’s spreadsheet program. Make your modifications here.
4. Click on PRINT to send the report to the printer.
5. Click ZOOM IN to make the font in the report larger on your screen.
6. Click ZOOM OUT to make the report font smaller on your screen.
7. To save the report as a tab delimited file or html document, click SAVE. Enter the location and name of the file to be saved.
8. Click SAVE SET to save the list of people for use later within Roll Call.
9. Click CREATE LABELS to create address labels (3 across 10 down size) for this list of people.
10. Click WRITE LETTER, to compose a mail merge letter to this list of people.
11. Click EMAIL to send an email to this list of people or to email the report to another individual. If you choose Email people, it will send the email to everyone listed in the report.
Background Checks

The Background Check Report will list all checks on file for the people in the Run For selection. The default report lists the name, request date, type result and clearance level. To run the report:

1. Expand the People menu.
2. Click on Reports.
3. Highlight Background Checks.
4. From the criteria tab, select your Run For criteria. Do you want to see background checks for everyone, certain associations, certain groups, etc.

5. On the columns tab, double click on a field name to move it to the selected column to include it in the report.
6. In the lower right of the columns tab, you can choose your output format.
7. Click GENERATE to run the report.
If you chose to print/spreadsheet the report, the results are displayed in the main section of the Report Output Window. Use the scroll bars on the bottom and to the right of the report to scroll up and down; left and right.

On the right side of the Report Output Window are actions that can be performed for the report:

1. Click on PAGE SETUP to set your printer and paper size and orientation.
2. Click on PREVIEW to preview the output. Do not send the report to the printer from this preview window; it will only send the first page to the printer.
3. To change fonts, column sizes etc., click CUSTOMIZE. The report will be displayed in 4D View, Roll Call’s spreadsheet program. Make your modifications here.
4. Click on PRINT to send the report to the printer.
5. Click ZOOM IN to make the font in the report larger on your screen.
6. Click ZOOM OUT to make the report font smaller on your screen.
7. To save the report as a tab delimited file or html document, click SAVE. Enter the location and name of the file to be saved.
8. Click SAVE SET to save the list of people for use later within Roll Call.
9. Click CREATE LABELS to create address labels (3 across 10 down size) for this list of people.
10. Click WRITE LETTER, to compose a mail merge letter to this list of people.
11. Click EMAIL to send an email to this list of people or to email the report to another individual. If you choose Email people, it will send the email to everyone listed in the report.

**Visitation Log**

The visitation log is a three part report. The first section outlines the basic information for a family. The second part contains the details of the last visit with this family. The third part is a section for the caller to write notes.

To print the visitation log, you’ll need to decide which families need to be visited. Do you need a log for families of a certain association, or a specific family or enter the fact that a background check has been requested, do the following:
1. Expand the People menu.
2. Click on Reports
3. Click on Visitation Log
4. If you’d like a log report for every family of a certain association, click over the specific associations.

On criteria tab, choose who you’d like to print a log for.

5. If you’d like the log report for a specific family, click the box for individual. A pop up window will be presented for you to enter the last name, then pick from a list of folks with that last name.
6. If you’d like a log report for folks missing since a certain time, enter the date, then check the box for missing.
7. Click GENERATE to send the report to the printer.
Visitation History

The visitation history report lists all visitations that have occurred since a given date. To create this report:

1. Expand the People menu.
2. Click on Reports.
3. Click on Visitation History
4. Enter the date of the oldest visitation you’d like to include.
5. Click GENERATE. The report will be sent to your printer.

---

My Church
Visitation History since 9/3/2013

<table>
<thead>
<tr>
<th>Caller</th>
<th>Comment</th>
<th>Visited</th>
<th>Length</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Walt Adams</td>
<td></td>
<td>9/2/2014</td>
</tr>
<tr>
<td>Conley, Dave</td>
<td></td>
<td>Jacob Smith</td>
<td></td>
<td>9/2/2014</td>
</tr>
</tbody>
</table>

blah blah
EXPORTING PEOPLE INFO

There are several exports available in Roll Call.
1. The Custom Export allows you to define which fields should be included in the export file. You can choose between a tab delimited text file or csv file.
2. The Lifetouch Export is a pre-defined export file that you can provide Lifetouch if you will be using them to create a picture directory for your church.
3. The Family Export is a pre-defined export. It creates a tab delimited text file that contains some basic information about each family member. If you were to open this file up in Excel, there would be one row for each family in your selection.
4. The Picture Export allows you to export each of the pictures in Roll Call to a jpg file on your hard drive.

Custom Export

The custom export allows you to create a file with Roll Call data in it. The export file can be used to pull contact information into your email program or to pull information into Excel. You will be able to define who should be included in the export. You will also define which pieces of information should be included in the file. Finally you’ll need to choose the type of file (*.txt or *.csv).

To create the file:
1. Expand the People menu.
2. Click on Export.
3. On the criteria tab, make sure the Export Type is set to Custom.
4. On the criteria tab, select the Run For category. This allows you to choose who you want included in the export. Is it everyone? Only people of certain associations? Only people in certain groups? Etc.
5. Once you’ve selected your Run For category, click on the values that represent the people you would like included in the export file. Those values should now be listed in the Selected column.

On the criteria tab, choose your Run For category and values.
6. On the columns tab, choose the fields you’d like included in the file. Double click on a field name to move it to the Selected column. There are 3 sections of fields: People, Addresses, and Special. Click on the plus sign or arrow in front of the section name to view all the fields in that section.

7. In the lower right of the columns tab, choose to create 1 row in the file for each individual or each family from your selection list.

8. In the lower right of the columns tab, choose the file format you’d like.

9. Click GENERATE to create your export file.

10. A window will be displayed for you to select the location of the file and the name of the file. Enter this information, then click SAVE.

**Lifetouch Export**

If you will be working with Lifetouch to create your church picture directory, you will need to export your congregation’s contact information into a format required by Lifetouch. You will also need to produce the Sit Reports required by Lifetouch. To produce the contact information file and the Sit report, do the following:

1. Expand the People menu.
2. Click on Export.
3. On the criteria tab, make sure the Export Type is set to Lifetouch.
4. On the criteria tab, select the Run For category. This allows you to choose who you want included in the export. Is it everyone? Only people of certain associations? Only people in certain groups? Etc.
5. Once you’ve selected your Run For category, click on the values that represent the people you would like included in the export file. Those values should now be listed in the Selected column.
6. Click on the SETTINGS button to pick which fields should be included in the file.
7. Also from the Settings window, mark the box for Lifetouch LCD file. Enter the location you’d like this file saved.
8. Mark the box for the Sit reports.
9. Close the Settings window.
10. Click GENERATE to create the file and send the Sit reports to the printer.
On the criteria tab, choose your Run For category and values.

From the settings window choose the fields to include and the output format.

Family Export

The family export will create a standard text file that contains 1 line per family. It contains the following information:

1. Date head of family was entered into Roll Call.
2. Head of family last name.
3. Head of family first name.
4. Head of family birth date.
5. Head of family individual phone numbers.
6. Head of family association.
7. Head of family’s last communion/other custom date.
8. Head of family gender.
9. Head of family custom field 1 & 2.
10. Spouse’s first name.
11. Spouse’s last name.
12. Spouse’s birthday.
13. Spouse’s individual phone numbers.
14. Spouse’s association.
15. Spouse’s last communion/other custom date.
16. Spouse’s gender.
17. Spouse’s custom field 1 & 2.
18. Children’s names.
19. Children’s names and ages.
20. Children’s names and birthdates.
21. Parents wedding date.
22. Current address.
24. Shepherd area.
25. Alternate primary phone.
26. Alternate address.

To produce the family export file, do the following:

1. Expand the People menu.
2. Click on Reports.
3. Highlight Family Export.
4. On the criteria tab, select the Run For category. This allows you to choose who you want included in the export. Is it everyone? Only people of certain associations? Only people in certain groups? Etc.

5. Click GENERATE.
6. A window will pop up allowing you to choose which individual phone numbers to include in the file.
7. Click OK.
8. Indicate the name and location for the export file.
9. Click SAVE to save this file.

Picture Export

The picture export will take the images stored in your database and create .jpg files in a folder of your choice. To export all your pictures from Roll Call, do the following:

1. Expand the People menu.
2. Expand the Bulk Changes menu.
3. Click on Pictures.
4. Click on the IMPORT/EXPORT button.
5. Click on the EXPORT button.
6. Navigate to the folder where you’d like the image files stored.
7. Click OK to perform the export.
PRINTING DIRECTORIES

There are six types of directories available in Roll Call.

1. **Custom** – This directory allows you to pick which pieces of contact information and which custom fields to include in the directory. You can choose to include pictures or not. You can choose a one, two or three column format directory.

2. **Standard** – This directory allows you to choose which pieces of contact information should be included in the directory. You can choose a one or two column format.

3. **Classic** – The classic directory is a two column directory which contains the family names, address and home phone number.

4. **Group** – This directory contains the contact information for members of a specific group or class.

5. **Family Picture** – This directory includes 12 pictures per page. Below each picture are the family member names, address and phone numbers.

6. **Group Picture** – The group picture directory includes individual pictures for members of a specific group or class.

**Custom Directory**

The custom directory can include basic contact information, custom fields and pictures. To configure the custom directory, do the following:

1. Expand the Directory menu on the left sidebar.
2. Highlight Custom.
3. You’ll be presented with a list of all the families in your database. To reduce this list to only certain families, use the SEARCH icon at the top. For example if you only want members and regular attenders in the list, click on the Associations tab from the Search Database window. Then click on Member and Regular attender to move them to the selected column. Click QUERY in lower right. Now you have only members and regular attenders in the list for your directory.

Click SEARCH to change list of families displayed.

Your list of directories.
4. Click GENERATE to begin configuring your directory.
5. Navigate through the options, general, custom, cover, fonts and output tabs to make your selections.
6. Click GENERATE to build the directory.

Options tab
The options tab allows you to pick the format for your directory. Choose a 1, 2, or 3 column directory; with or without pictures. Once you make your selection, click NEXT to go to the General Tab.

General Tab
The general tab allows you to select which pieces of contact information should be included in the directory. Make your selection then click NEXT to go to the Custom tab.
1. List children – mark if you’d like to include children’s names.
2. Show family email – mark to include the family email address.
3. Show personal email – mark to include each family member’s personal email address.
4. Show cell phone – mark to include each family member’s cell phone number.
5. Show work phone – mark to include each family member’s work phone number.
From the General tab, mark the items you’d like included in the directory.

Click on each custom field you’d like to include in the directory.

Custom Tab
The custom tab allows you to choose which custom fields will be included in your directory. Any custom fields that your organization has defined will be listed in the Available Custom Fields column on the left. Click on a field name to move it to the Selected column on the right. All fields in the selected column will be included in the directory. Click NEXT to move to the cover tab.

Cover Tab
The cover tab allows you to create a cover page for your directory. A word processor is presented. Enter any text you’d like on the cover page. To insert an image, you’ll need to open the image in your graphics program. Within the graphics program choose Select All, then Copy. Back in the word processor on the cover tab, place your cursor where you would like the image and Paste it. Click NEXT to move to the font tab.
On the cover tab, build the cover page you'd like on your directory.

Font Tab
The font tab allows you to set the font type and size for each section of the directory: the header, footer, family names and body of the directory. Make your selections then press NEXT to move to the output tab.

Set the fonts and sizes you'd like for each of the directory sections.

Output Tab
In the setting section of the output tab, you can adjust the margins for your directory. Mark the box Column Separator to place a line between columns. Mark the box for Cover to include a cover on the directory.

In the Output section, you can choose your output format.
1. Print – sends the directory to your printer. You may also choose to print in a booklet format.
2. Save to Disk – allows you to save the directory as a file. You may choose to save in a 4D Write, Word or HTML format.
3. Open in Word Processor – this will open up the directory in Roll Call’s word processor. This is a great way to preview the directory.

Click GENERATE to create the directory in the format you’ve chosen.

Sample Custom Directory

<table>
<thead>
<tr>
<th>My Church</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Abbott, Aaron, George (George) Baker, Joanna</strong></td>
</tr>
<tr>
<td>2342 Kingman Ct</td>
</tr>
<tr>
<td>Byron, IL 60102</td>
</tr>
<tr>
<td><a href="mailto:2342@skil.com">2342@skil.com</a> (Aaron - personal)</td>
</tr>
<tr>
<td><strong>Barker, Tom</strong></td>
</tr>
<tr>
<td>1001 Main St</td>
</tr>
<tr>
<td>Evangeline, CO 80439</td>
</tr>
<tr>
<td>(303) 234-8888</td>
</tr>
<tr>
<td>826-3911 (Tom - Membership)</td>
</tr>
<tr>
<td>fdds (Tom - How Referred)</td>
</tr>
<tr>
<td><strong>Adams, Walter (Walt), Sue</strong></td>
</tr>
<tr>
<td>55567 Walnut Ave</td>
</tr>
<tr>
<td>Byron, IL 60102</td>
</tr>
<tr>
<td>(303) 555-1212</td>
</tr>
<tr>
<td>(322) 555-6767 (Walter - cell)</td>
</tr>
<tr>
<td><a href="mailto:info@bjthebook.com">info@bjthebook.com</a> (Walter - personal)</td>
</tr>
<tr>
<td><strong>Baker, Josh, Kim, Jacob, Taylor</strong></td>
</tr>
<tr>
<td>100 Main</td>
</tr>
<tr>
<td>Byron, IL 60101</td>
</tr>
<tr>
<td><strong>Baker, Salley, Tommy</strong></td>
</tr>
<tr>
<td>100 Main</td>
</tr>
<tr>
<td>Byron, TH</td>
</tr>
<tr>
<td>(815) 234-7899</td>
</tr>
<tr>
<td><a href="mailto:baker@bjthebook.com">baker@bjthebook.com</a> (Salley - personal)</td>
</tr>
<tr>
<td><a href="mailto:tommy@ed.com">tommy@ed.com</a> (Tommy - personal)</td>
</tr>
<tr>
<td><strong>Baker, Sue</strong></td>
</tr>
<tr>
<td>52 Weyra St</td>
</tr>
<tr>
<td>(303) 555-1212</td>
</tr>
<tr>
<td><strong>Baker, Tom, Char</strong></td>
</tr>
<tr>
<td>151 E Copper Dr</td>
</tr>
<tr>
<td>Plainfield, IL 60102</td>
</tr>
<tr>
<td><strong>Barker, Kimberly (Kimmy)</strong></td>
</tr>
<tr>
<td>45 Apple Way</td>
</tr>
<tr>
<td>Batik, IL 60102</td>
</tr>
</tbody>
</table>
Standard Directory

The standard directory can include basic family contact information as well as family members' individual phones and email addresses. The directory can be a 2 or 3 column format. To configure the standard directory, do the following:

1. Expand the Directory menu on the left sidebar.
3. You’ll be presented with a list of all the families in your database. To reduce this list to only certain families, use the SEARCH icon at the top. For example if you only want members and regular attenders in the list, click on the Associations tab from the Search Database window. Then click on Member and Regular attender to move them to the selected column. Click QUERY in lower right. Now you have only members and regular attenders in the list for your directory.
4. Click GENERATE to begin configuring your directory.
5. Navigate through the options, general, custom, cover, fonts and output tabs to make your selections.
6. Click GENERATE to build the directory.

Options tab
The options tab allows you to pick the format for your directory. Choose a 2, or 3 column directory. Once you make your selection, click NEXT to go to the General Tab.

General Tab
The general tab allows you to select which pieces of contact information should be included in the directory. Make your selection then click NEXT to go to the Custom tab.
1. Mark Certain Association with asterisk – if you’d like members (or a certain association) to have an asterisk by their name, mark this box and choose the appropriate association.
2. Address – mark to include the current, primary or both addresses.
3. Show Birth Dates – mark to include birthdates. Also mark the date format you’d like to use for the children.
4. Show children’s age – mark to include each child’s age.
5. Show Wedding Date – mark to include the Anniversary Date for married couples.
6. Show Associations – mark to include the association for the husband, wife or single adult.
7. Show Shepherd area – mark to include the shepherd area for each family in the directory.
8. Show Family Email – mark to include the family email address.

Custom Tab
The custom tab allows you to choose individual email and phone numbers to include in the directory. Click on each value you’d like to include to move it to the selected column. All phones and email addresses included in the selected column will be included in the directory.

Cover Tab
The cover tab allows you to create a cover page for your directory. A word processor is presented. Enter any text you’d like on the cover page. To insert an image, you’ll need to open the image in your graphics program. Within the graphics program choose Select All, then Copy. Back in the word processor on the cover tab, place your cursor where you would like the image and Paste it. Click NEXT to move to the font tab.
Font Tab
The font tab allows you to set the font type and size for each section of the directory: the header, footer, family names and body of the directory. Make your selections then press NEXT to move to the output tab.

Output Tab
In the setting section of the output tab, you can adjust the margins for your directory. Mark the box Column Separator to place a line between columns. Mark the box for Cover to include a cover on the directory.

In the Output section, you can choose your output format.
1. Print – sends the directory to your printer. You may also choose to print in a booklet format.
2. Save to Disk – allows you to save the directory as a file. You may choose to save in a 4D Write, Word or HTML format.
3. Open in Word Processor – this will open up the directory in Roll Call’s word processor. This is a great way to preview the directory.

Click GENERATE to create the directory in the format you’ve chosen.

Sample Standard Directory

<table>
<thead>
<tr>
<th>My Church</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

Classic Directory

The classic directory includes basic family contact information. The directory is a 2 column format. To configure the classic directory, do the following:

1. Expand the Directory menu on the left sidebar.
2. Highlight Classic.
3. You’ll be presented with a list of all the families in your database. To reduce this list to only certain families, use the SEARCH icon at the top. For example if you only want members and regular attenders in the list, click on the Associations tab from the Search Database window. Then click on Member and Regular attender to move them to the selected column. Click QUERY in lower right. Now you have only members and regular attenders in your list for your directory.
4. Click GENERATE to choose your address options.
5. Click GENERATE to send the directory to your printer.

General Tab

The general tab allows you to select which pieces of contact information should be included in the directory. Make your selection then click GENERATE to send your directory to the printer.

1. **Mark Certain Association with asterisk** – if you’d like members (or a certain association) to have an asterisk by their name, mark this box and choose the appropriate association.
2. **Address** – mark to include the current or primary addresses.
There are two formats available for the group directory:

1. **Simple List** - This is a listing of the group members, their address, phone, birthday and email.
2. **Detail** - The detail format is more typical directory listing for each group member. It includes their address, phone and other custom fields that are defined at the group level.
To create the group directories, do the following: Expand the Directory menu on the left sidebar.

1. Expand the Directories menu.
2. Highlight Group.
3. Select a specific group from the drop down list.

4. From the next window that is displayed, choose the type of directory (Simple or Detail)
5. Based on the type of directory you choose, you will be able to mark which fields should be included in the directory.

6. Click PRINT to send the directory to your printer.
Sample Group Directory - Simple

1st Grade

Leader:          
Phone:          

Total Members: 9

<table>
<thead>
<tr>
<th>Name</th>
<th>Phone</th>
<th>Birthday</th>
<th>Email</th>
<th>Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>Baker, Jacob</td>
<td>(815) 234-7890</td>
<td>9/15</td>
<td><a href="mailto:baker@bythebook.com">baker@bythebook.com</a></td>
<td>100 Main</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Byrom, IL 61010</td>
</tr>
<tr>
<td>Baker, Sally</td>
<td>(815) 234-7890</td>
<td>4/15</td>
<td><a href="mailto:sally@yahoo.com">sally@yahoo.com</a></td>
<td>200 Main St</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Byrom, IL 60102</td>
</tr>
<tr>
<td>Conlin, Jacob</td>
<td></td>
<td></td>
<td></td>
<td>New Address</td>
</tr>
<tr>
<td>Conlin, Taylor</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Sample Group Directory - Detail

1st Grade

Jacob Baker
100 Main
Byrom, IL 61010

Sally Baker
180 Main
Byrom, TH
Phone:(815) 234-7890
Email: sally@bythebook.com

Tommy Baker
180 Main
Byrom, TH
Phone:(815) 234-7890
Email: tommy@aol.com

Sally Barker
200 Main St
Byrom, IL 60102
Phone:(815) 234-7330
Email: sally@yahoo.com

Jacob Conlin
New Address

Taylor Conlin

Billy Hart

Jacob Weaver

Johnny Weaver
Family Picture Directory

The family picture directory includes 12 family pictures per page plus name and contact information below the picture. To create the directory, do the following:

1. Expand the Directory menu on the left sidebar.
2. Highlight Family Picture.
3. The window that is displayed allows you to determine which families to include in the directory. Click on an association name on the left side to move it to the selected column on the right side to include those folks.

4. Click USE ASSOCIATIONS.
5. If you’d like to select your families on something other than association, click USE QUERY EDITOR to call up that list of people. For more information on using the query editor see the Chapter on “Using the Query Editor”.
6. Then next window will allow you to choose only those families that have pictures or all families. Make your selection.

7. Mark address, phone, and family email to have that information printed below the name under the picture.
8. Press CONTINUE to send the report to the printer.
Group Picture Directory

The group picture directory includes 12 individual pictures per page plus name and contact information below the picture for the selected group. To create the directory, do the following:

1. Expand the Directory menu on the left sidebar.
2. Highlight Group Picture.
3. From the window that is displayed, choose the specific group you’d like to create a directory for.

Select specific group from the drop down list.
4. The next window allows you to choose which contact information that should be included in the directory. You may also set the font and size of font for this directory.

5. Press CONTINUE to send the directory to the printer.

Choose the fields you’d like included in the directory.

Sample Group Directory - Picture
RECORDING ATTENDANCE

You may record attendance for services or groups in Roll Call. A service is typically a worship service. It is something that anyone can attend. Groups are typically Sunday school classes, bible studies, volunteer boards or small groups. There are specific people that are members of a group. To record attendance you must first define the services and groups you’ll be recording attendance for.

Worship Attendance

Create Service

Before you can begin entering recording attendance for worship services you must first create the service record in Roll Call. The service record contains the name of the service, what day and time it meets, and which associations you’d like to record attendance for. You may also indicate if you’ll be recording attendance for only adults.

If you’d like to use the check in system for services, indicate if you’d like a name tag printed upon check in.

To create the service:
1. Expand the Services menu on the left side bar.
2. Click on Search menu item.
3. Click on the plus sign in the lower left of the Search window.
4. Enter the Name and Description of the service. The name will be used in the drop down box for you to select which service you’ll be recording attendance for.
5. Enter the Day, Start Time and End Time that this service meets.
6. If you will have the congregation checking into the service and would like to print name tags, indicate the Number of Labels to print upon check in.
7. Mark Inactive if this service is not used any more.
8. Click the associations you’d like to record attendance for this service. Roll Call will use these associations to build the list of people to mark as present when recording attendance.
9. Enter any Comments about this service.
10. Click SAVE & NEW to save this service information and create another service record. Click SAVE & CLOSE to save this service record and return to the search window.

Name the service and select the associations that should be included in the attendance list.
Record Attendance

To record attendance:
1. Expand the Attendance menu.
2. Click on Search, then click on the plus sign in the lower left OR
3. Click on the Record Attendance menu item.

To record attendance for a specific service and date, enter the following information:
1. Select the Type of attendance you’ll be recording. Choose Service.
2. Select the specific Service you are recording for.
3. Enter the Meeting Date that you are recording for.
4. To record attendance for a specific person, find their name and click on the Present box to the left of their name. You may also place your cursor in the last name field, and begin entering the last name. If the correct row is highlighted, you can press the return key to mark them as present.
5. To indicate that a person received communion, find their name and click on the Communion box to the left of their name. This will also mark them present.

6. Note as you mark folks present the Head Count field in the upper right is incremented by 1. If you have a head count, you may over-ride this number by entering it in the Head Count field. Only do this after you have marked the specific people present.
7. Note as you mark folks as having taken Communion the Communion Count field in the upper right is incremented by 1. If you would like to enter the specific number that received communion, you may over-ride this number by entering it in the Communion field. Only do this after you have marked the specific people for communion.
8. When you are done marking the people that attended, click SAVE & NEW to save this attendance and record for another service or group. Click SAVE & CLOSE to save the attendance and return to the search screen.

If a person attended the service and they are not in the list (based on associations) you can click the plus sign in the lower left to find this person in the database and they will be marked present and added to the list.
To add someone to the list, press plus (+) sign then pick from list.

If a person attended who is not in the database, you will need to add them first. Once they are added into Roll Call, you can add them to the list and mark them present.

To record attendance using a bar code roster, click on the bar code symbol on the right side of the screen. Begin scanning the bar code of the people who are present. Their names will be marked present in the list.

**Find/Modify Attendance**

If you need to modify or continue recording attendance for a specific service and date, do the following:

1. Expand the Attendance menu.
2. Click Search.
3. Find the attendance record for the specific service and date you are interested in.

Double click on attendance that needs to be updated.
4. Double click on that attendance record.
5. Note the people you have already marked present should still be marked present. Make the necessary changes.

**Group Attendance**

**Create Group**

Before you can begin recording attendance for a group/class, you must first create that group or class in Roll Call. To create a group/class, do the following:

1. Enter the values for Campus, Group Type, Department and Status.
2. Enter the name of the specific group under Group Section.
3. If the group has a leader, enter the last name in the Leader field. Press tab to view a list of the folks with that last name. Select from the list.
4. If the group has a co-leader, enter the last name in the Co-Leader field. Press tab to view a list of the folks with that last name. Select from the list.
5. Enter the Location of the group if applicable.
6. Indicate if the group meets weekly or randomly.
7. You may enter any comments or notes in the Notes field.
8. The Start Date will default to today’s date. You may change it if you’d like.

To enroll people into the group, press the Members tab. From within the members tab:

1. Click the plus sign in the lower left of the window. A new window will be displayed for you to enter the Last Name and First Name (or portion of the last name) of the person you want to enroll.
2. Select the appropriate person to enroll in the group.
3. Tab across to enter any of the custom field data for this person. If you need to define the membership custom field names, click CHANGE TITLES and enter the name of the data you’d like to capture.

Next, you’ll want to indicate which days and at what times the group meets. The meeting days and times are called sessions in Roll Call. A group that meets weekly can have an unlimited number of sessions. A group that meets randomly does not have any sessions defined.
To create a session:
1. Click on the session tab, if sessions are not currently displayed.
2. Click on the plus sign in the lower left. A row will be displayed, with a default of Sunday and time of 12 a.m.
3. Use the Day of Week drop down box to select the appropriate day.
4. Enter the Start Time.
5. Enter the End Time.
6. Place your cursor under Room and double click to enter the room number of this group meeting.

Click SAVE & CLOSE to save the information and return to the Search screen. Click SAVE & NEW to save the information and enter a new group.

Record Attendance
To record attendance:
1. Expand the Attendance menu.
2. Click on Search, then click on the plus sign in the lower left OR
3. Click on the Record Attendance menu item.

To record attendance for a specific group and date, enter the following information:
1. Select the Type of attendance you’ll be recording. Choose Group.
2. Select the specific Group you are recording for.
3. Enter the Meeting Date that you are recording for.
4. If you know the Head Count, you may enter it manually, or if you will be marking people present, Roll Call will fill this in for you.
5. To record attendance for a specific person, find their name and click on the box to the left of their name. You may also place your cursor in the last name field, and begin entering the last name. Once the correct row is highlighted, you can press the return key to mark them as present.

Click on the box in front of each person who was present to record their attendance.
6. When you are done marking the people that attended, click SAVE & NEW to save this attendance and record for another service or group. Click SAVE & CLOSE to save the attendance and return to the search screen.

If a person attended the group and they are not in the list you can click the plus sign in the lower left to find this person in the database and they will be marked present and added to the group.

If a person attended who is not in the database, you will need to add them first. Once they are added into Roll Call, you can add them to the list and mark them present.

To record attendance using a bar code roster, click on the bar code symbol on the right side of the screen. Begin scanning the bar code of the people who are present. Their names will be marked present in the list.

**Find/Modify Attendance**

If you need to modify or continue recording attendance for a specific group and date, do the following:
1. Expand the Attendance menu.
2. Click Search.
3. Find the attendance record for the specific service and date you are interested in.
4. Double click on that attendance record.
5. Note the people you have already marked present should still be marked present. Make the necessary changes.

![Find/Modify Attendance](image)
REPORTING ON ATTENDANCE

Attendance Summary

The attendance summary report gives head count information for service and group attendance information. This report can be run by day and it will list each service and or group, the day they met, how many attended and how many visitors attended. The Attendance Summary can also be run by week, month or year. When running for this time frame, it will display the appropriate headcount.

To run the attendance summary report by day:
1. Expand the Attendance menu.
2. Click on Reports.
3. Highlight Attendance Summary.
4. Enter the date range for the attendance data you are interested in.
5. Select “By Day” as the report type.
6. Choose which attendance you want to run this for. You may select All and it will list all worship service attendance as well as all group attendance for the date range you entered. You may select Service, and then choose which services you’d like to see or you may choose groups, then pick the specific groups you’d like included in the report.
7. Click GENERATE to run the report.

On the right side of the Report Output Window are actions that can be performed for the report.
1. Click on PAGE SETUP to set your printer and paper size and orientation.
2. Click on PREVIEW to preview the output. Do not send the report to the printer from this preview window, it will only send the first page to the printer.
3. To change fonts, column sizes etc., click CUSTOMIZE. The report will be displayed in 4D View, Roll Call’s spreadsheet program. Make your modifications here.
4. Click on PRINT to send the report to the printer.
5. Click ZOOM IN to make the font in the report larger on your screen.
6. Click ZOOM OUT to make the report font smaller on your screen.
7. To save the report as a tab delimited file or html document, click SAVE. Enter the location and name of the file to be saved.
To run the attendance summary report by week, month or year:
1. Expand the Attendance menu.
2. Click on Reports.
3. Highlight Attendance Summary.
4. Enter the date range for the attendance data you are interested in.
5. Select by week, by month or by year as the report type.
6. Choose which attendance you want to run this for. You may select All and it will list all worship service attendance as well as all group attendance for the date range you entered. You may select Service, and then choose which services you’d like to see or you may choose groups, then pick the specific groups you’d like included in the report.
7. Click GENERATE to run the report.
Weekly head-counts for the selected groups.

Note actions that can be performed.

Attendance by Person

The attendance by Person report outlines the different services or groups a person came to if you run this report “by day”. If you run this report by week, month or year it will show you in a spreadsheet format how many times they attended each week, month or year.

To run the attendance by person report by day:
1. Expand the Attendance menu.
2. Click on Reports.
3. Highlight Attendance by Person.
4. Enter the date range for the attendance data you are interested in.
5. Select “By Day” as the report type.

Enter date range and report type.

On Who tab, select which folks to include in report.
6. On the “Who” tab, select which people you want to run this for. You can choose by association, groups, keywords, shepherd areas or search the database. Once you choose your type, you can pick the specific values. For example, if you wanted to see all your Members and Regular Attenders, choose Associations, then click on Member and Regular Attender to select those values.

7. Next click on the “What” tab to choose which attendance you want to run this for. You may select All and it will list all worship service attendance as well as all group attendance for the date range you entered. You may select Service, and then choose which services you’d like to see or you may choose groups, then pick the specific groups you’d like included in the report.

8. Next click on the Columns tab to choose the information you wish to include on the report. Click on a column name from the left column and move it to the middle column.

9. Click on the View Records tab, to review the people that will be included in the report.

10. Click GENERATE to run the report.

On the right side of the Report Output Window are actions that can be performed for the report.
1. Click on PAGE SETUP to set your printer and paper size and orientation.
2. Click on PREVIEW to preview the output. Do not send the report to the printer from this preview window, it will only send the first page to the printer.
3. To change fonts, column sizes etc., click CUSTOMIZE. The report will be displayed in 4D View, Roll Call’s spreadsheet program. Make your modifications here.
4. Click on PRINT to send the report to the printer.
5. Click ZOOM IN to make the font in the report larger on your screen.
6. Click ZOOM OUT to make the report font smaller on your screen.
7. To save the report as a tab delimited file or html document, click SAVE. Enter the location and name of the file to be saved.

To run the by person report by week, month or year:
1. Expand the Attendance menu.
2. Click on Reports.
3. Highlight Attendance by Person.
4. Enter the date range for the attendance data you are interested in.
5. Select by week, by month or by year as the report type.
6. On the “Who” tab, select which people you want to run this for. You can choose by association, groups, keywords, shepherd areas or search the database. Once you choose your type, you can pick the specific values. For example, if you wanted to see all your Members
On the criteria tab, choose date range and report type.

On who tab, indicate the criteria to include people in the report.

and Regular Attenders, choose Associations, then click on Member and Regular Attender to select those values.

7. Next click on the “What” tab to choose which attendance you want to run this for. You may select All and it will list all worship service attendance as well as all group attendance for the date range you entered. You may select Service, and then choose which services you’d like to see or you may choose groups, then pick the specific groups you’d like included in the report.

8. Next click on the Columns tab to choose the information you wish to include on the report. Click on a column name from the left column and move it to the middle column.

9. Click on the View Records tab, to review the people that will be included in the report.

10. Click GENERATE to run the report.
**Attendance by Type**

The Attendance by Type report will list all the people who came to a group or service on a specific day. This is a great report to run if you want to see who came to your Sunday School classes last weekend and who was absent. Or you can see who attended last Saturday nights service.

To create the Attendance by Type report, do the following:
1. Expand the Attendance menu.
2. Click on Reports.
3. Highlight Attendance Summary.
4. Enter the date range for the attendance data you are interested in.
5. Choose which attendance you want to run this for. You may select All and it will list all worship service attendance as well as all group attendance for the date range you entered. You may select Service, and then choose which services you’d like to see or you may choose groups, then pick the specific groups you’d like included in the report.
6. On the columns tab, choose the fields you’d like displayed for each person in the report.
7. Click GENERATE to run the report.

On the right side of the Report Output Window are actions that can be performed for the report.
1. Click on PAGE SETUP to set your printer and paper size and orientation.
2. Click on PREVIEW to preview the output. Do not send the report to the printer from this preview window, it will only send the first page to the printer.
3. To change fonts, column sizes etc., click CUSTOMIZE. The report will be displayed in 4D View, Roll Call’s spreadsheet program. Make your modifications here.
4. Click on PRINT to send the report to the printer.
5. Click ZOOM IN to make the font in the report larger on your screen.
6. Click ZOOM OUT to make the report font smaller on your screen.
7. To save the report as a tab delimited file or html document, click SAVE. Enter the location and name of the file to be saved.

This report lists everyone who attended the service, or group, then lists who was absent.

Note actions that can be performed.

Attendance by Session

The Attendance by Session report will list all the people who came to a specific group session or a specific service time on a specific day.

To create the Attendance by Session report, do the following:
1. Expand the Attendance menu.
2. Click on Reports.
3. Highlight Attendance by Person.
4. Enter the date range for the attendance data you are interested in.
5. Choose which attendance you want to run this for. You may select All and it will list all worship service attendance as well as all group attendance for the date range you entered. You may select Service, and then choose which services you’d like to see or you may choose groups, then pick the specific groups you’d like included in the report.
6. Click GENERATE to run the report.
On the criteria tab, choose the date range, and attendance type.

On the columns tab, double click on a field to move it to selected column.

For each service, group or meeting, the people who attended are listed below.
On the right side of the Report Output Window are actions that can be performed for the report.

1. Click on PAGE SETUP to set your printer and paper size and orientation.
2. Click on PREVIEW to preview the output. Do not send the report to the printer from this preview window, it will only send the first page to the printer.
3. To change fonts, column sizes etc., click CUSTOMIZE. The report will be displayed in 4D View, Roll Call’s spreadsheet program. Make your modifications here.
4. Click on PRINT to send the report to the printer.
5. Click ZOOM IN to make the font in the report larger on your screen.
6. Click ZOOM OUT to make the report font smaller on your screen.
7. To save the report as a tab delimited file or html document, click SAVE. Enter the location and name of the file to be saved.

**Absent Present Report**

The absent/present report allows you to find folks who have been absent so many weeks or who have attended so many times in a certain time frame.

To run the Absent/Present report:
1. Expand the Attendance menu.
2. Click on Reports.
3. Highlight Absent Present.
4. Enter the date range for the attendance data wish to view.
5. On the “Who” tab, select which people you want to evaluate their attendance. You can choose by association, groups, keywords, shepherd areas or search the database. Once you choose your type, you can pick the specific values. For example, if you wanted to evaluate attendance for all your Members and Regular Attenders, choose Associations, then click on Member and Regular.

6. Next click on the “What” tab to choose which attendance you want to use in determining who was present or absent. You may select All and it will evaluate attendance for all services and groups. Select Services and choose the specific services to only look at attendance for those services. Select Groups to choose specific groups.

![Select date range for display of attendance date.](image)

![Choose the people that should be considered for the report.](image)
7. Click on the “When” tab to enter your absent present criteria. Enter how many weeks you wish to look back. Choose to find people who were absent or find people who were present. Enter how many times.

8. Next click on the Columns tab to choose the information you wish to include on the report. Double click on a column name from the left column and move it to the middle column.

9. Click on the View Records tab, to review the people that will be included in the report.

10. Click GENERATE to run the report.

On the right side of the Report Output Window are actions that can be performed for the report.

1. Click on PAGE SETUP to set your printer and paper size and orientation.

2. Click on PREVIEW to preview the output. Do not send the report to the printer from this preview window, it will only send the first page to the printer.

3. To change fonts, column sizes etc., click CUSTOMIZE. The report will be displayed in 4D View, Roll Call’s spreadsheet program. Make your modifications here.

4. Click on PRINT to send the report to the printer.
On the columns tab, double click on a field name to move to the selected column.

Report listing all the folks who met your absent/present criteria.

Note actions that can be performed.

5. Click ZOOM IN to make the font in the report larger on your screen.
6. Click ZOOM OUT to make the report font smaller on your screen.
7. To save the report as a tab delimited file or html document, click SAVE. Enter the location and name of the file to be saved.

Visitor Report

The Visitor report will list all your first time, second time, third time visitors, based on the association of visitor and the attendance data you wish to evaluate.

To create the Visitor report, do the following:
1. Expand the Attendance menu.
2. Click on Reports.
4. Enter week of attendance you are interested in looking at.
5. Choose the type of visitor you are looking for from the drop down under the Who tab. Then
choose type of visitor... 1st time, 2nd time etc.
Also indicate your churches association for visitor.

6. Click on the “what” tab and indicate which type of attendance you wish to evaluate.

7. Click GENERATE to run the report.

On the right side of the Report Output Window are actions that can be performed for the report.
1. Click on PAGE SETUP to set your printer and paper size and orientation.
2. Click on PREVIEW to preview the output. Do not send the report to the printer from this preview window, it will only send the first page to the printer.
3. To change fonts, column sizes etc., click CUSTOMIZE. The report will be displayed in 4D View, Roll Call’s spreadsheet program. Make your modifications here.
4. Click on PRINT to send the report to the printer.
5. Click ZOOM IN to make the font in the report larger on your screen.
6. Click ZOOM OUT to make the report font smaller on your screen.
7. To save the report as a tab delimited file or html document, click SAVE. Enter the location and name of the file to be saved.
List of visitors from last weekend.

Note actions that can be performed.
ENTERING CONTRIBUTIONS

Giving Funds

Before you can begin entering contributions in Roll Call, the giving funds must be defined. The giving funds are the designations that people can contribute to. A new Roll Call database will contain one giving fund, “General”. To add giving funds, do the following:

1. Expand the Contributions menu on the left side bar.
2. Click on Giving Funds
3. Click on the plus sign in the lower left of the Giving Fund summary window.

4. Enter the Fund name. This is the name that will be in the drop down box to select designations from the Enter Contributions screen.
5. Enter the associated Account Number. This number is not mandatory.
6. If this giving fund is no longer valid or used, check the “Inactive” box.
7. If this fund is not tax deductible, mark the box for “Not on Receipt”. If this box is checked any monies given to this fund will not be printed on the year-end tax statement.
8. Mark the Connect box, if you will be allowing online giving through Roll Call Connect and would like this fund to be included in the list of available funds.
9. Mark Include in Budget, if you’d like any monies given to this fund to be reported as “budgeted” giving in Roll Call Connect reports.
10. Select the Fund Color. This color will represent the fund in pie charts showing total giving. Click on the “…,” and click on color you’d like to use.
11. The GL Fund is used to map the giving funds to your accounting system. For example if you have a giving fund of “Tithes & Offerings” and you want that to map to the General Income Fund in your accounting system, you would enter General Income as the GL Fund. If you are importing into Quickbooks and your fund is a sub-account, enter the Account, then a colon then the sub account name, for example, Operating Income:General.
12. The GL Account Number is the account number to map to MYOB accounting.
13. GL Key is the number to map to Roll Call’s accounting system.
At a minimum you must enter the fund name.

Envelope Numbers

If your ministry uses envelope numbers to identify donors, you’ll want to assign those numbers before you begin entering contributions.

To manually enter envelope numbers, do the following:
1. Expand the People menu on the left side bar.
2. Expand the Bulk changes menu.
3. Click on Envelopes.
4. Place your cursor in the Current Env No. column to the right of the person you wish to assign a number. Enter the appropriate number.
5. Use the ENTER key on your keyboard to move down the list.
If you would like the system to automatically assign envelope numbers, do the following:
1. Expand the People menu on the left side bar.
2. Expand the Bulk changes menu.
3. Click on Envelopes.
4. Use the SEARCH icon to retrieve the list of people that should be assigned envelope numbers. For example, if you’d like to give all your members and regular attenders envelope numbers, click on the Associations tab, and click on Member and Regular attender to move them to the selected column. Click QUERY in the lower right to return a list of those folks.
5. Click on the ASSIGN button in the lower right.
6. Mark the option to Auto Assign Envelope Numbers. Enter the starting number.
7. Click the SAVE & CLOSE button to assign those numbers and close the window.

![Mark Auto Assign option, enter starting number.]

If you would re-assign envelope numbers each year, you can begin entering next years envelope number now. At the beginning of the new year, you can make the switch. Here’s how:
1. Expand the People menu on the left side bar.
2. Expand the Bulk changes menu.
3. Click on Envelopes.
4. Place your cursor in the Next Env No. column to the right of the person you wish to assign a number. Enter the appropriate number.

![Enter the appropriate number for next year.]
5. Use the ENTER key on your keyboard to move down the list.
6. When you are ready to switch and use the “next” numbers, click on the ASSIGN button in the lower right.
7. Mark the option for New Year.
8. Click SAVE & CLOSE to make the envelope number changes and close the current window.

In the assign window, mark the option for “New Year”, click SAVE & CLOSE.

Batches

All contributions are entered in Roll Call through a batch. A batch is nothing more than a grouping of contributions. Typically, users will enter all the giving for a deposit in a batch.

Because of the integration with Accounting, batches must be either Cash or Non-Cash. Cash contributions include all cash, checks, credit cards and ACH type transactions. Non-Cash batches contain property gifts, things that cannot be deposited into the bank.

To create a batch, do the following:
1. Expand the Contributions menu on the left side bar.
2. Click on Add Batch.

Enter the following information:
1. **Batch Date** – This date will become the default for all contributions entered in this batch.
2. **Description** – Enter a qualifying description of this batch. Especially if you will have multiple batches for the same day. Maybe this group of contributions is for the 9 a.m. service. You could enter “9 a.m. service” as the description.
3. **Anonymous Cash** – Enter the amount of loose cash that was in the offering. This is cash that cannot be associated with any specific donor.
4. **Cash Fund** – Enter the fund that the anonymous cash should be designated to.
5. **Default Fund** – Enter the fund that you’d like all contributions in this batch to default to. This doesn’t mean that you can’t have other funds included in this batch. This is only used as a default. If the majority of the giving is for Tithes & Offerings… make “Tithes & Offerings” the default fund.
6. **Batch Type** – Select Cash for batches that will contain cash, checks, credit card, online, ACH type contributions. Select Non-Cash for property or in-kind gifts.
7. **Asset Fund** – This is the fund to map non-cash gifts to the appropriate asset fund in your accounting system.
8. **Batch Control Count** – This field can be used as a control count for the number of entries expected in this batch. This field is not required, but by using it you may be able to catch
9. **Batch Control Total** – This field can be used as a control total for the amount expected in this batch. This field is not required, but by using it you may be able to catch any data entry errors. If the Batch Total and Batch Control Total do not match, they will be displayed in red.

10. To begin entering individual contributions, click on the plus sign in the lower left corner.

### Enter Contributions from Batch Window

To begin entering cash or cash equivalent contributions, you will need to create a batch. To create a new batch, do the following:

1. Expand the Contributions menu.
2. Click on Add Batch
3. Enter the batch header information as described in the previous section.
4. Click on the plus sign in lower left to begin entering the contributions.

To enter new contributions to an existing batch, find that batch by:

1. Expand the Contributions menu.
2. Click on Search by Batch.
3. Change the Find By Criteria to “Date”.
4. Select the date of the batch you are adding to.
5. Double click on the appropriate record
6. Click on the plus sign in the lower left to begin entering new contributions.

### Basic

To record a donation, enter the following information:

1. **Donor Name or Envelope Number**. When recording contributions, the first thing you need to do is identify the donor. If you use envelope numbers, enter the number and press tab. The donor information will be displayed on the right side. If you use name to identify the donor, enter the last name then press tab. You will be taken to the Select a Person window. You can further reduce the names in the list by typing the first few characters of the first name. You can double click on the name to select it, or if it is already highlighted, press Enter on your keyboard.
2. **Date** – the donation date will default to the same as the batch date. If you’d like to change
this date you can enter it here.
3. **Total Amount** – Enter the amount of the contribution.
4. **Check Number** - If the contribution was a check, you may enter the check number in this field.
5. **Donation Type** – If you entered a check number, this will automatically change to check. Or you can select cash, check, credit card etc. from the drop down list of values.
6. **Designation** – Use the drop down list of values to select the fund that these monies were given to.

![Image of a contributions entry form]

Click SAVE & NEW to enter another contribution.

Click SAVE & NEW to enter a new contribution in this batch. Click SAVE & CLOSE to save the current contribution and return to Batch window.

**Split**

A split donation is a single contribution that needs to be designated to 2 or more funds. To record a split donation, enter the following information:

1. **Donor Name or Envelope Number**. When recording contributions, the first thing you need to do is identify the donor. If you use envelope numbers, enter the number and press tab. The donor information will be displayed on the right side. If you use name to identify the donor, enter the last name then press tab. You will be taken to the Select a Person window. You can further reduce the names in the list by typing the first few characters of the first name. You can double click on the name to select it, or if it is already highlighted, press Enter on your keyboard.
2. **Date** – the donation date will default to the same as the batch date. If you’d like to change this date you can enter it here.
3. **Total Amount** – Enter the amount of the contribution.
4. **Check Number** - If the contribution was a check, you may enter the check number in this field.
5. **Donation Type** – If you entered a check number, this will automatically change to check. Or you can select cash, check, credit card etc. from the drop down list of values.
6. **Amount** – Notice the amount and designation fields underneath the contribution header information. Place your cursor in the lower amount field, and reduce the amount so that it matches the amount to be designated to the first fund. Press TAB. Note a 2nd line is created with the remainder, so you can designated that amount.
7. **Designation** – Use the drop down list of values to select the fund that these monies were given to.
Highlight amount in the middle section.

Reduce the amount and press the TAB key. A new line with remainder will open up.

Click SAVE & NEW to enter a new contribution in this batch. Click SAVE & CLOSE to save the current contribution and return to the Batch window.

**Connect to Pledge**

When you are entering a contribution for an individual that has made a pledge, the pledge will be listed near the bottom of the screen on the pledges tab.

If you enter a contribution and designate it to the fund that the donor pledged to, the contribution and pledge should be automatically connected. Notice the Pledge ID to the right of the designation and description fields. If the pledge ID is listed here, you know the contribution is connected. If you need to change which pledge is connected to this contribution, use the Pledge ID drop down to change the connection.
Quid Pro Quo contributions are contributions where something of value was given. An example of quid pro quo would be your youth group is selling CD’s as a fundraiser. The CD’s are worth $15. If someone gives the youth group $50 for the CD, you’d want to enter that as a Quid Pro Quo contribution.

To enter this transaction, go to the Donation Entry window and enter the following information:

1. **Donor Name or Envelope Number.** When recording contributions, the first thing you need to do is identify the donor. If you use envelope numbers, enter the number and press tab. The donor information will be displayed on the right side. If you use name to identify the donor, enter the last name then press tab. You will be taken to the Select a Person window. You can further reduce the names in the list by typing the first few characters of the first name. You can double click on the name to select it, or if it is already highlighted, press Enter on your keyboard.

2. **Date** – the donation date will default to the same as the batch date. If you’d like to change this date you can enter it here.

3. **Total Amount** – Enter the amount of contribution. In the above example this would be the $50.00.

4. **Check Number** - If the contribution was a check, you may enter the check number in this field.

5. **Donation Type** – If you entered a check number, this will automatically change to check. Or you can select cash, check, credit card etc. from the drop down list of values.

6. **Designation** – Use the drop down list of values to select the fund that these monies were given to.

7. Click on the Quid Pro Quo tab. Select the item that was given. Enter the value of the item given. In this example the item was the CD. The value was $15.

Click SAVE & NEW to enter a new contribution in this batch. Click SAVE & CLOSE to save the current contribution and return to the Batch window.
Enter Contributions using Quick Add

The Quick Add screen is a simplified data entry screen for contributions. It also allows multiple users to enter contributions into a single batch. All Quick Add contributions must be entered for an existing batch. To use the Quick Add, do the following:

1. Expand the Contributions menu.
2. Click on Quick Add.
3. Use the drop down box to select the batch.

4. If the batch does not exist, click the plus sign to the right to create the batch. Enter the following information.
   a. **Batch Date** – This date will become the default for all contributions entered in this batch.
   b. **Description** – Enter a qualifying description of this batch. Especially if you will have multiple batches for the same day. Maybe this group of contributions is for the 9 a.m. service. You could enter “9 a.m. service” as the description.
c. **Anonymous Cash** – Enter the amount of loose cash that was in the offering. This is cash that cannot be associated with any specific donor.
d. **Cash Fund** – Enter the fund that the anonymous cash should be designated to.
e. **Default Fund** – Enter the fund that you’d like all contributions in this batch to default to. This doesn’t mean that you can’t have other funds included in this batch. This is only used as a default. If the majority of the giving is for Tithes & Offerings… make “Tithes & Offerings” the default fund.
f. **Batch Type** – Select Cash for batches that will contain cash, checks, credit card, online, ACH type contributions. Select Non-Cash for property or in-kind gifts.
g. **Asset Fund** – This is the fund to map non-cash gifts to the appropriate asset fund in your accounting system.

If the batch does not exist, click plus sign, then enter batch details here.

### Line at a Time

1. Once you select a batch, your cursor will be placed in the *Donor* field. Identify the donor by entering a last name, envelope number or scanning the check.
2. Press TAB on your keyboard. If you’ve entered a last name to identify the donor, a Select Person window will be returned. Select the appropriate donor.

Enter the last name of the donor, then press TAB. Pick from the list.

3. Enter the *Amount* of the contribution. Press TAB
4. If the contribution was a check, you may enter the *Check* number in this field. Press TAB.
5. If you entered a check number, the *Donation Type* will automatically change to check. Or you can select cash, check, credit card etc. from the drop down list of values. Press TAB.
6. Use the drop down list of values to select the *Fund* that these monies were given to.
7. If the contribution needs to be split between multiple funds, select Split from the drop down list.
   a. A new window will be displayed to allow you to split across multiple funds.
   b. Reduce the highlighted amount to the amount for the first fund.
   c. Press TAB.
   d. A new line will be opened up.
   e. Choose the fund for the second line.
   f. Click SAVE & CLOSE when you have completed entering the split information.

8. The Account number will be populated based on the fund you selected in the previous step. Press TAB.
9. Enter any Comments.
10. Press TAB to enter another

Click SAVE & CLOSE when you are done entering contributions for this batch. Click SAVE & NEW to save these contributions in this batch and begin entering into a new batch. Click CANCEL to discard any changes.

With Names Pre-Populated
1. Once you select a batch, click on the List Adults checkbox. This will populate the screen with the names of all the adults in your database.
2. Place your cursor in the Amount field to the right of the appropriate donor. Enter the amount.
3. Press TAB on your keyboard.
4. Enter the Check Number if the gift was a check.
5. Press TAB to move into the next field.
6. If you entered a check number, the Donation Type will automatically change to check. Or you can select cash, check, credit card etc. from the drop down list of values.
7. Use the drop down list of values to select the Fund that these monies were given to. Press TAB.
8. The Account number will be populated based on the fund you selected in the previous step. Press TAB.
9. Enter any Comments.
10. Press TAB to enter another.

Click SAVE & CLOSE when you are done entering contributions for this batch. Click SAVE & NEW to save these contributions in this batch and begin entering into a new batch. Click CANCEL to discard any changes.

Non-Cash/Property Gift Contributions

There are 3 ways that you can enter an in-kind or property gift in Roll Call.
1. Donation Type – Use the donation type method if you’d like to assign a value to the property gift. You will need to use this method if you want to apply this gift towards a pledge.
2. In-Kind tab – Use this method if you do not want to assign a value to this gift.
3. Non-Cash screen – Use this method if you have a complicated transaction such as stock or real estate where brokerage fees need to be applied

Donation Type

To record a property gift using the Donation Type method, do the following:
1. Create a non-cash type batch.
2. Click on the plus sign in the lower left.
3. Enter Donor Name or Envelope Number. When recording contributions, the first thing you need to do is identify the donor. If you use envelope numbers, enter the number and press tab. The donor information will be displayed on the right side. If you use name to identify
the donor, enter the last name then press tab. You will be taken to the Select a Person window. You can further reduce the names in the list by typing the first few characters of the first name. You can double click on the name to select it, or if it is already highlighted, press Enter on your keyboard.

4. **Date** – the donation date will default to the same as the batch date. If you’d like to change this date you can enter it here.

5. **Total Amount** – Enter approximate value of the gift. This amount will be listed on the year-end tax statement with an asterisk to indicate that this amount needs to be determined by the donor.

6. **Donation Type** – Select a donation type that has been defined as a “non-cash” type.

7. **Designation** – Use the drop down list of values to select the fund that these monies were given to.

8. **Description** – Enter a description of the property donated.

Choose a non-cash donation type. Enter the description of the gift.

Click SAVE & NEW to enter a new contribution in this batch. Click SAVE & CLOSE to save the current contribution and return to Batch window.

**In Kind tab**

To enter a property gift without having to enter an amount, do the following:

To record a property gift using the Donation Type method do the following:

1. Create a non-cash type batch.
2. Click on the plus sign in the lower left.
3. Enter **Donor Name or Envelope Number**. When recording contributions, the first thing you need to do is identify the donor. If you use envelope numbers, enter the number and press tab. The donor information will be displayed on the right side. If you use name to identify the donor, enter the last name then press tab. You will be taken to the Select a Person window. You can further reduce the names in the list by typing the first few characters of the first name. You can double click on the name to select it, or if it is already highlighted, press Enter on your keyboard.
4. **Date** – the donation date will default to the same as the batch date. If you’d like to change this date you can enter it here.
5. **Total Amount** – Leave this amount 0.
6. **Donation Type** – Select a donation type that has been defined as a “non-cash” type.
7. Click on the In Kind tab. You may enter the amount and designation if you wish. This will be for informational purposes only. The amount will not be used on year-end statements or against pledges.

8. Description – enter the description of the property gift. This description will be listed on the donation receipt.

Click SAVE & NEW to enter a new contribution in this batch. Click SAVE & CLOSE to save the current contribution and return to Batch window.

**Non-Cash screen**

If you have large property gifts, where you need to track the sale of stock or real estate, use the Non-Cash gift screen.

To record a property gift using the Non-Cash gift screen:

1. Expand the Contributions menu on the left
2. Expand the Non-Cash Gift menu
3. Click on Add a Non-Cash Gift
4. Enter the Gift Date and select Gift Type. Gift types are the donation types that are marked as non-cash items.
5. Enter a Description of the gift. When you press tab, the first 20 characters of this description will be copied to Receipt Description. The receipt description is listed on the donation receipt detail. You may modify this description if you’d like.
6. The Status will be set to “Pending”. When the gift is posted and a donation record is created, the status will be automatically changed to “Posted”.
7. Enter the donor’s Last Name and press the tab key. A list of people with that last name will be displayed. Click on the appropriate person to select. Notice the full name and address is displayed under Donor/Address.
8. Enter the Designation or the fund that this gift was given to.
9. Enter the Quantity, Unit Selling Price and $ Value at Sale. Enter the amount of Commission & Fees. The Net Sales Cash Proceeds will be calculated.
10. Enter the Sell Date and the Initials of the person responsible, if applicable.
11. Enter the Contribution JE Date and Initials of the person who made the journal entry, if applicable.
12. Indicate if the Contribution Letter was sent, the Date Letter Sent and Initials of the person who processed the letter.
13. You may enter the *Agent, Contact Name* and *Contact Phone* for the agency that processed the sale.
14. Click GIFT COMMENT if you’d like to enter additional comments regarding this gift. Click SAVE & NEW to enter a new non-cash contribution. Click SAVE & CLOSE to save the current contribution and return to Search window.

These non-cash contributions will not be recognized until they are posted. That is, they will not be included in any contribution reports or receipts until they are posted. To post the non-cash contribution, do the following:
1. Click POST from within the non-cash screen.
2. Highlight one or more non-cash contributions from the search window and click POST.

When the non-cash contributions are posted, they will show up in the Search by Batch window.
Check Reader

The check reader, approved to work with Roll Call, is the Mag-Tek keyboard wedge device, check reader. You may order this from us at 800.554.9116 and we’ll configure it for you.

To begin recording donation, get to the Enter Contribution screen. See section on “Enter Contributions through the Batch”.

1. Slide the check through the check reader, with the magnetic numbers on the bottom facing inward.
2. If Roll Call recognizes the account number, the name of the donor and the check number will be displayed. All you need to enter is the Amount and the Designation. Press SAVE & NEW to enter another donation.
3. If Roll Call does not recognize the account number, it will ask you to identify the donor. Enter the Last Name or portion of the last name. A list of all people with that last name will be displayed. Double click to select the appropriate person.
4. Now the account number from the check and the person are linked. The next time you get a check from them, Roll Call will automatically pull up their information.

Import Contributions

If you use a service for online contributions, you can import those contributions into Roll Call. When you enter the form for the first time, there is a single template called Default. You cannot modify the Default template. This template corresponds to the import that was available prior to v.14. You can select the file for import and click Import Contributions to begin the import. Roll Call can also do a custom import. We can import a csv file or tab delimited file with the following information:

1. First Name
2. Last Name
3. Email
4. Cell Phone
5. Primary Phone
6. Address 1
7. City
8. State
9. Postal Code
10. Envelope Number
11. Donation Date
12. Total Amount

Click IMPORT to navigate to the csv file.
The import will create a batch with a contribution for each line in the import file. Each contribution will be assigned a donation type of the default type that you choose (cash, check, credit card, etc.) You can also select from the above on the order the import order should be in. Each bank may want a different and specific order in how they give you the information in the file. To find the appropriate donor, you select what Roll Call should try to find a match on (i.e: email, address, last name, etc... ) Use the drag and drop method, or click on the arrows after highlighting your selection to move your data from the available to the Import Order and Match On columns.

If the fund is not found in Roll Call, a giving fund will be created. If no name columns are selected, then a profile without a name will be generated. *First and Last Name, Donation Date and Total Amount fields must be in the feed in order to import.*

**Add a Template and Import**

To add a template and to import the contributions, do the following:

1. Expand the Contributions menu on the left side bar
2. Click on Import
3. If you are creating your template for the first time, select the +Add button to create your template name. Otherwise just choose your template from the dropdown menu. You can choose the <Skip Field> if there are some data in the field that won’t be imported and should be ignored.
4. You cannot run the import until the following is defined for a template: An import file is selected; donation date and total amount are amoung the import order columns; at least one item is in the Match On box (explained below).
5. Find the file by clicking on the three dots to the right of FILE NAME.
6. Choose the line that the data starts on. If you have column titles, for instance, you actual data will not start until line 2.
7. Choose the default donation type. All donations will have the same donation type per import.
8. Map your values in the import order you need to have them, according to your bank specifications.
9. Choose what Roll Call should be trying to match on should you have previous donors already in Roll Call. This Match On box indicates what columns the import utility will use to find a matching profile in Roll Call to tie the donation to.
10. Press the IMPORT CONTRIBUTIONS.
11. Roll Call will not allow access to the IMPORT CONTRIBUTIONS button until a
DONATION DATE and TOTAL AMOUNT has been selected.
12. You can select VIEW BATCH to view the batch that is created upon completion.
13. While an import is running two things can happen: a match is found and tied to an existing profile, or a match is not found. If a match is found, the only fields pulled from the file are the donation date, total amount and fund. See below on how to find a match should one not be found.

Match On
The Match On box indicates what columns the import utility will use to find a matching profile in Roll Call to tie the donation to.

Running the Import
Requirements & Logging
You cannot run the import until the following is defined for a template:
• An import file is selected
• Donation Date and Total Amount are among the Import Order columns
• At least one column is in the Match On box
There are two log files generated when the import is run. The first log is displayed in the window as the utility runs. It is written in reverse meaning that lines are added to the beginning of the file so that they remain visible to the user as the import runs. This file is temporary. The second log file is available under Administration > Logs > Contributions. It is written in the normal fashion with contents appended to the file. This file is permanent.

Column Count Check
When the import is run, an error is generated if the number of columns specified don’t match the actual number of columns in the file (see below). You can click the Back button and try again.

Successful Run
If the import runs without any problems, the log is generated as the utility runs so the user can see the results. A batch is created with a batch date of the day the import was run and a description - Manual Contributions Import. Each import will generate a new batch,

The user can click on the View Batch button upon completion to view the batch that was created:

Processing Rules
While an import is running, several things can happen:
• A match is found and the donation is tied to an existing profile.
• A match is not found and the user must determine whether to add a new profile or match to an existing one.
When a problem finding a match occurs, notice the right section of the screen (see next page). It contains the contents of the record in the import file that cannot be matched. The contents are displayed in an easy to read format. This is useful when trying to manually find a match.

An existing profile is matched
If this occurs then the only fields pulled from the file are the donation date, total amount and fund.

Adding a new Profile
If the user clicks Add New, a new profile is added and the donation is tied to the profile. The contents of the profile will be based on whatever data is available on the Import Order columns. If no name columns are selected then a profile without a name will be generated. We never use the Person No field if supplied in the file. The system always generates a new one (refer to image).
Manually Finding a Match to Imported Contribution

If there is no match found in Roll Call for an imported contribution, Roll Call will want you to manually find someone. You will have the option to ADD NEW or Search. If Search is selected, the common FIND PERSON window is presented to try to find a match based on Last Name/Env No or First Name. If a record is selected, the donation is tied to that record. If ADD NEW is selected Roll Call will create a new record with the information found on that import with an association of IMPORT. When a profile is selected manually, any of the columns in that profile will be replaced with the contents of whatever columns are selected in the Match On with the exception of the Person No field, which is never replaced.
Delete a Template
You can delete any template except the default template. To delete the template:
1. Select the template you wish to delete.
2. Press the -Delete button.

Post a Batch
Posting a batch in Roll Call sets several things in motion. When you post a batch:
1. The batch can NO LONGER be modified.
2. If you are using Roll Call Accounting the receipt information will be sent to the accounting system.
3. If you are using Quickbooks or MYOB, you can create your export files as part of the posting process.
4. As part of the post process you can choose to print the batch summary and batch detail report.
5. As part of the post process you can choose to print a deposit slip.

To post a batch do the following:
1. Expand the Contributions menu.
2. Click on Search by Batch.
3. Highlight one or more batches that need to be posted.
4. Click on POST BATCH button in the lower right of the window.
5. You will be presented with a list of reports to run, check the options you’d like to print.

Import deposit to QB or MYOB
When you post a batch in Roll Call you will be given the option to export for MYOB or Quickbooks. If you marked either box to create an export file, you will be prompted for a folder to create the file in. The file will automatically be named. Next you will be prompted for the bank account name that you’ll be depositing the money into.

To import the file in Quickbooks, do the following:
1. Open Quickbooks.
2. Select File>Utilities>Import>IIF files.
3. Navigate to the file you just created.
4. You should now have a deposit journal entry representing the batch.

To import the file into MYOB, select File>Import. Navigate to the file you just created. You now have a deposit journal entry that represents this batch.
**Batch Reports**

There are two batch reports available when you post a batch. The first is the batch summary report. This report will outline how much was given to each fund in this specific batch. The second report is the batch detail report. It will outline each donor and how much was given.

To run these reports, mark the box for Batch Summary and or Batch Detail after you choose to Post the batch.
CORRECTING CONTRIBUTIONS

Open Batches
If a batch has not been posted, you can add contributions to that batch and you can make corrections to individual contributions in that batch.

Add Contributions to Existing Batch
To add contributions to an existing batch, find the batch by selecting Search by Batch under the Contributions menu. Double click on the batch you need to modify. From the batch window, click on the plus sign in the lower left to start adding new contributions.

Correct a Contribution
To correct a contribution that has already been recorded in Roll Call, you will need to find that specific contribution. If you know the batch it was in, click on Search by Batch under the Contributions menu. Double click on the batch. Double click on the specific contribution.

If you know the person that made the contribution, select Search by Person under the Contributions menu. Double click on the appropriate person. Find the contributions on the left side, double click on it. Make the necessary changes.

To change the total amount, date, or type, place your cursor in the field and make the correction. To change the fund it was designated to, use the drop down to the right of designation and choose the correct fund.

To change the donor, click on the TRANSFER button and enter the last name for the correct donor. Select the appropriate person from the list.

Click SAVE & CLOSE to save the changes to the contributions record and return to the Search screen.
Make any corrections necessary.

Click TRANSFER to transfer this contribution to a different donor.

Posted Batches

Corrections are not allowed to posted batches. If errors were made in the batch, you will need to reverse the batch, make the correction, then re-post the batch.

Reverse the Batch

When you reverse a batch, make sure to reverse any related journal entries in your accounting system. Then the status of the batch will change to un-posted. At this point you can make corrections to the batch.

To reverse the batch, do the following:
1. Expand the Contributions menu.
2. Click on Search by Batch.
3. Highlight the batch that needs to be reversed.
4. Click the REVERSE button.

Highlight one or more batches, then click REVERSE BATCH.
You may also reverse from the batch window:
1. Expand the Contributions menu.
2. Click on Search by Batch.
3. Double click the batch that needs to be reversed.
4. Click the REVERSE button.

Correct the Contribution

Now that the batch is “un-posted”, you can make corrections to existing contributions or add contributions to the batch. To correct a contribution that has already been recorded in Roll Call, you will need to find that specific contribution. Click on Search by Batch under the Contributions menu. Double click on the batch. Double click on the specific contribution.

To change the total amount, date, or type, place your cursor in the field and make the correction. To change the fund it was designated to, use the drop down to the right of designation and choose the correct fund.
To change the donor, click on the TRANSFER button and enter the last name for the correct donor. Select the appropriate person from the list.

Click SAVE & CLOSE to save the changes to the contributions record and return to the Search screen.

Re-post the Batch
Once you have corrected the batch, you can re-post it.
1. Expand the Contributions menu.
2. Click on Search by Batch.
3. Highlight one or more batches that need to be posted.
4. Click on POST BATCH button in the lower right of the window.
5. You will be presented with a list of reports to run, check the options you’d like to print.

Transfer Contributions
If a contribution was assigned to the wrong donor, you can transfer the contribution to the correct donor at any time. You can do this for posted and un-posted batches.

A single contributions
To transfer a contribution that has already been recorded in Roll Call, you will need to find that specific contribution. If you know the batch it was in, click on Search by Batch under the Contributions menu. Double click on the batch. Double click on the specific contribution.

If you know the person that the contribution is under, select Search by Person under the Contributions menu. Double click on the appropriate person. Find the contribution on the left side and double click on it.

To change the donor, click on the TRANSFER button and enter the last name for the correct donor. Select the appropriate person from the list.
Multiple contributions

A good example of having to transfer multiple contributions from one person to another, would be from a wife to the husband. Another example might be person with the same name. To transfer multiple donations at once, do the following:

1. Expand the People menu on the left.
2. Click on Search Profiles.
3. Find the person who currently has the contributions.
4. Double click on their record.
5. Click on Giving on the left side.
6. Change the view to Detail.
7. Highlight one or more contributions that need to be transferred.
8. Right mouse click and select Transfer.
9. Enter the last name of the correct donor.
10. Select the appropriate person.

Transfer to Dummy Record

If you need to delete a person from the database that has contributions, you will need to transfer their contributions to a “dummy” record first. To create a dummy record, do the following:

1. Expand the People menu.
2. Click Search Profiles.
3. Click the plus sign in the lower left to add a “dummy” person.
4. Make sure the family position is other and the association is Inactive.

Once you have a “dummy” person in your database, transfer the contributions from the person you’d like to delete to this “dummy” record. This will ensure the accuracy of your contribution data.

1. Expand the People menu on the left.
2. Click on Search Profiles.
3. Find the person who you’d like to delete.
4. Double click on their record.
5. Click Giving on the left side.
6. Change the view to Detail.
7. Highlight all the contributions that need to be transferred.
8. Right mouse click and select Transfer.
9. Enter the last name of the correct donor.
10. Select the appropriate person.

Change to Detail. Then highlight all contributions, right-mouse click and select Transfer.
RECURRING CONTRIBUTIONS

Recurring Contribution Process
A recurring contribution exists when a donor arranges for online giving at regular intervals through your website or through “bill pay” at his bank. To record this regular online giving, you may set up recurring contribution entries in Roll Call. This will save you from having to enter these contributions manually; Roll Call will automatically create the contribution record on the appropriate day.

The recurring contribution process in Roll Call is as follows:
1. A recurring contribution entry is added in Roll Call.
2. On the specified date or day (based on interval) a contribution record is automatically created in Roll Call.
3. An email is sent to the “contribution administrator” that this has occurred.
4. The contribution administrator can review the batch and decide whether or not to post the batch.

Recurring Contribution Preferences

Defaults
To speed up the data entry process for recurring contributions, you can set the default designation as well as the default days for the recurring contribution. These defaults will be used when you add a new recurring contribution entry. These defaults can be changed. Also enter the email information for recurring contribution notifications.

Email notification
To notify the contribution administrator by email of a recurring contribution, you must set the email settings in the preferences window.

To enter the recurring contribution preferences, Expand the Contributions menu. Expand the Recurring Contributions menu. Click Search. Click the Preferences icon on the top bar.

Select the Default Designation for recurring contributions as well as the Default Days. Next enter the email address for the folks who need to be notified when recurring contributions have been posted. Also enter your outgoing email host information.
Find Recurring Contribution Profiles

To view all your recurring contribution profiles expand the Recurring Contributions menu. Click Search. All profiles will be displayed.

To view the recurring contribution profiles for a specific donor, designation, frequency, day, creation date or status, expand the Recurring Contributions menu and click on Search. Select the Find By Criteria. Enter the value you wish to view. The results will be displayed. Double click on a specific record to view the profile details.

Create Recurring Contribution Profile

To enter a new recurring contribution profile, expand the Contributions menu. Expand the Recurring Contributions menu. Click on Add Recurring Gift. From the window that is displayed, enter the following:

1. Enter the donor’s Last Name and press the tab key. A list of people with that last name will be displayed. Click on the appropriate person to select. Notice the full name and address is displayed under Donor/Address.
2. Enter the Designation. The designation is the fund that the person is donating to.
3. Select the Status. The options for status are active or inactive. Contribution entries will only
be created for active recurring contributions.

4. Enter the **Amount** of the contribution.

5. Enter the **Frequency** of the recurring contribution. If the donor wishes to make this contribution once per month, select Monthly. If the donor wishes to make this contribution twice a month, select Bi-Monthly. If the donor wishes to contribute every other week, select Bi-Weekly. If the donor wishes to make this contribution each week, select Weekly.

6. Enter the value for **Day 1** and **Day 2** if applicable. If the frequency is monthly, enter the day of the month that the contribution should be posted in Day 1. If the frequency is Bi-Monthly, enter the two days that the contribution should be posted in Day 1 and Day 2. If the frequency is weekly, do not enter any value in Day 1 or Day 2.

7. Enter the **Day of Week** for profiles that are weekly contributions.

8. Enter the **Start Date**. This is the effective date for recurring contribution processing. Contributions will not be created before this date.

9. Click OK to save this profile and return to the Summary window. Click OK & NEXT to save and enter a new profile. Enter CANCEL to ignore the data entered and return to the Summary window.

---

**Posting the Recurring Contributions**

Under normal circumstances, recurring contributions are posted automatically by Roll Call. They can also be posted manually by a user if need be. When recurring contributions are posted, a batch is created and specific contribution records are created in that batch. The contribution administrator will be notified via email that recurring contributions have been posted.

**Automatically**

Each morning, Roll Call evaluates the active recurring contributions profiles to determine if they need to be posted on today’s date. When a recurring contribution is posted, a batch is created with all the contributions that are to be created for that day. As an example, lets say we have 10 monthly recurring contributions that are to post on the 15th. Also we have 2 weekly contributions that are set up to post on Fridays. In our example, the 15th falls on a Friday. At around 2 in the morning on the 15th, the recurring contribution process will create a batch that includes the 10 monthly contributions as well as the 2 Friday contributions.

This is the normal processing for recurring contributions. You need to leave Roll Call running overnight for this processing to occur. If for some reason the system is down, Roll Call will evaluate recurring contributions based on the last time the process was run when it comes back up.

**Manual**

You can also manually post recurring contributions. You may need to do this if you enter the recurring contribution profile, after the processing for that day has taken place. For example, if
you enter a recurring contribution for the 15th of each month on the 15th. The processing for the 15th has already occurred, so that contribution will not post automatically until next month on the 15th.

To post a recurring contribution, expand the Contributions menu. Expand the Recurring Contributions menu, then click Search. Highlight the contributions to be posted, click POST.

Post the Batch

When a batch is created for recurring contributions, the contribution administrator will be notified via email. The batch can be reviewed and then posted when appropriate.
CREATING CONTRIBUTION RECEIPTS (STATEMENTS)

Contribution Receipt Process
The flow for creating contribution statements is as follows:
1. Expand the Contributions menu.
2. Click on the Bulk Receipts menu item. The Contribution Receipts window will be displayed.
3. Choose your receipt type on the criteria tab.
4. Mark the applicable items on the criteria tab.
5. Click on the View People tab to see all the folks that will be receiving a statement.
6. Click on the Receipt Text tab. Customize your text areas.
7. Click PRINT RECEIPTS to print the statements or click EMAIL to email the receipts.

Contribution Statement Formats
To begin the process of creating the contribution receipts, you’ll need to choose the type of contribution statement.

Quarterly
The quarterly statement is for a single quarter. It will list either summary information or detail all the contributions made in that quarter.

Since this receipt is not printed on stationary, the organization return address is included.

Top text.
Summary section.
Detail section.
Bottom text.
Quarterly Tabular

The quarterly tabular receipt shows weekly giving for the quarter. Pledge information is displayed at the bottom of the receipt.

Each month's giving broken down by week.

Any special giving will be listed on right side.
Annual
The annual statement summarizes all giving for the year. The statement can show totals by fund or just a grand total. You can also list all contributions for the year as well. Pledge information can be displayed on this receipt.

Thank you for your faithful giving. Your generosity is much appreciated. This area is completely customizable.

Giving & Pledge Summary
Report Period: 01/01/14 - 12/31/14

<table>
<thead>
<tr>
<th>Designation</th>
<th>Total for Period</th>
<th>Pledge</th>
<th>Pledge</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>517.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Missions</td>
<td>200.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td><strong>717.00</strong></td>
<td><strong>0.00</strong></td>
<td><strong>0.00</strong></td>
</tr>
</tbody>
</table>

Contributions from 1/1/2014 to 12/31/2014

<table>
<thead>
<tr>
<th>Date</th>
<th>Type</th>
<th>Check</th>
<th>Amount</th>
<th>Designation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>07/27/14</td>
<td>Check</td>
<td></td>
<td>75.00</td>
<td>General</td>
<td></td>
</tr>
<tr>
<td>07/27/14</td>
<td>Check</td>
<td></td>
<td>50.00</td>
<td>General</td>
<td></td>
</tr>
<tr>
<td>09/03/14</td>
<td>Check</td>
<td></td>
<td>67.00</td>
<td>General</td>
<td></td>
</tr>
<tr>
<td>09/03/14</td>
<td>Check</td>
<td></td>
<td>50.00</td>
<td>General</td>
<td></td>
</tr>
<tr>
<td>09/03/14</td>
<td>ACH</td>
<td></td>
<td>100.00</td>
<td>General</td>
<td></td>
</tr>
<tr>
<td>09/03/14</td>
<td>ACH</td>
<td></td>
<td>100.00</td>
<td>General</td>
<td></td>
</tr>
<tr>
<td>09/03/14</td>
<td>Check</td>
<td>123</td>
<td>200.00</td>
<td>Missions</td>
<td></td>
</tr>
<tr>
<td>09/03/14</td>
<td>Check</td>
<td>234</td>
<td>75.00</td>
<td>General</td>
<td></td>
</tr>
</tbody>
</table>

Total Giving for period **717.00**

This report includes a good faith estimate of the value of any goods or services you received in exchange for any individual contribution.
Canadian

The Canadian receipts show total giving for the year. The information required by the government in Canada is included on this receipt.

Receipt ID

Duplicate for the donor's record.
Individual Gift

This receipt is for a single contribution.
Quarterly Statements

To create quarterly receipts, do the following:
1. Expand the Contributions menu.
2. Click on the Bulk Receipts menu item. The Contribution Receipts window will be displayed.
3. Choose Quarterly Receipt from the Receipt Type drop down.

Criteria

From the criteria tab, you can choose the type of receipt you want and what information should be displayed on the report.

Enter the following information:
1. Year - Indicate the year that these receipts are for.
2. Quarter – Indicate which quarter you are interested in.
3. Period Starting - This date is defaulted to the beginning of the quarter or year you selected.
   These dates may be changed.
4. Period Ending. This date is defaulted to the end of the quarter or year you selected. This date may be changed.
5. Total Giving for Period Over – If you only want to produce statements for folks who gave over a certain amount, enter that amount here.

Criteria tab and enter date range.

Notice the tabs across the middle of the criteria page. On the Details tab enter the following information:
6. Receipt Details – choose if you’d like the receipt to only have a grand total or if you’d like it to display summary information by fund. You may also choose to display each individual gift.
7. Include Summary by Fund – If you selected Summary & Details under Receipt Details, you can mark this box if you’d like to display the summary information by fund.
8. Include Detailed Gifts – If you selected Summary & Details under Receipt Details, you can mark this box if you want to list each contribution for the period.
9. Include References to Pledges – Under the Pledge Detail section, mark this box if you’d like to see the pledge information for each fund that this donor contributed to. This will add a Pledge Received and Pledge Total column to the report.
10. Include Pledge Remainder – if you would like to include a column Pledge Remainder mark this box.
11. Include all who Pledge – if you want to create a quarterly statement for each person who pledged regardless of their giving for the quarter mark this box.
From the tabs across the middle of the criteria page, click on Print Options to make the following selections:

12. **Single Print Job** – under the print options section, mark this box if you want Roll Call to create 1 large print job for the quarterly receipts. If you will be duplexing the print job (printing on both sides of the paper) you do not want to create a single print job. If you are emailing receipts you do not want to create a single print job. If you are using a large copier printer that requires a project code, you would want to check this box.

13. **Cover Letter** – if you’d like to print a cover letter before each statement, mark this box. Use the text tab to create your cover letter.

14. **Print on Stationary** - mark this box if you will be printing the statements on letterhead. By checking this box, the churches return address will not be printed on the statement. The statement will begin about 2 ½ inches down the page.

15. **Use Org Letterhead** – if you would like to pull in your letterhead graphic to print directly on the receipt, mark this box.

16. **First Page Only** - if you will only be using stationary for the first page of the receipt, mark this box.

17. **Report In Kind giving** – if you entered property or in-kind gifts without an associated amount and you want to display the item descriptions in the lower section of the receipt, mark this box.

18. **Show Envelope Number** – if you would like the envelope number printed on the statement, mark this box.

19. **Sorted By** – choose the sort order of the print job. Do you want the receipts sorted by zip code or by name.

20. **Exclude** – to exclude receipts for folks who have an address marked as “bad” or “do not send” mark this box.

From the tabs across the middle of the criteria page, click on Customize to change the font and alignment.

21. **Top Margin** – the number of centimeters required for the top margin.

22. **Organization Name** – the number of lines down that the organization name starts.

23. **Address starts on line#** - the number of lines down that the donor’s address starts.

24. **Body starts on line#** - the number of lines down that the body of the receipt starts.

25. **Customize Font** – mark this box if you’d like to change the font and size for the receipt. This may take some trial and error to make sure the summary section columns fit on the receipt.
26. **Font** – choose the font you’d like to use for the body of the receipt.
27. **Size** – choose the size of the font you’d like to use for the body of the receipt.

**Text**

There are several different types of “text” that can be used to customize your receipt. They are as follows:

1. **Top Text** – The top text area is used as a thank you note at the beginning of the statement. If you have a verse or a paragraph that you’d like printed at the beginning of the statement, use the top text area. If you have a large thank you note, we recommend you use the cover letter section.
2. **Cover Letter** – The cover letter is a 1 page letter that will be printed before each statement.
3. **Bottom Text** – The bottom text area is used as footer text. It typically indicates no goods or services were received.
4. **NonCashGifts** – if the donor had any non-cash gifts where an amount was assigned to the gift, an asterisk will be placed beside the amount. Then at the bottom of the statement, there
will be an asterisk with the verbage you enter for non-cash gifts. Usually this would state that the donor is responsible for determining the fair market value of the gift.

5. Third Party Gift – if a donor gave a foundation monies to donate to your ministry on their behalf, the foundation is responsible for giving them a receipt. However, you would want to include the gift with a notation that the “third party” is responsible for receipting them.

6. QPQ Gifts – if the donor received something of value for their contribution, maybe a CD or T-shirt, the QPQ value is indicated on the receipt. Use the QPQ Gift text to indicate that the amount of the item is reduced from their total contribution.

7. In Kind Gift – if you have a property contribution where no value was assigned, these gifts are listed underneath the detail section of the statement. This text will be used as the header for the In Kind Gifts.

8. Org Letterhead – if you’d like to pull in your letterhead graphic so that the stationary and receipt are all printed at once, use this section.

To enter the text you’d like displayed on the statement, do the following:
1. Click on the Receipt Text tab.
2. Click on the type of text you’d like to enter.
3. Enter the text and format it as appropriate.

**View People**

The view people tab is used to review the list of people that will be getting a statement. If you’d like to print a receipt for all these people, click PRINT RECEIPT. If you only want to print them for several of the people in the list, highlight the people that you want, then click PRINT RECEIPTS. It will only print statements for those people that were highlighted.

**Printing/emailing your receipt**

Once you have set up your criteria, reviewed the list of people and set up your text areas, click on PRINT RECEIPTS. The statements will be printed for everyone in the view people tab that does not have Email checked. If you want to print a receipt for everyone in the list regardless of the Email status, simply highlight all the people, then click PRINT RECEIPT.

If you’d like to email the statements, click EMAIL RECEIPTS. You will be given the choice to simply create a pdf for each statement, or to create pdf and send email. The receipts will be emailed to everyone in the list that has Email checked. If you want to override the Email status, highlight everyone you’d like to email a statement, then click SEND EMAIL.
Quarterly Tabular Statements

To create quarterly tabular receipts, do the following:
1. Expand the Contributions menu.
2. Click on the Bulk Receipts menu item. The Contribution Receipts window will be displayed.
3. Choose Quarterly (tabular) Receipt from the Receipt Type drop down.

Criteria

When you choose Bulk Receipts, the Contribution Receipt window will be displayed. You will be anchored on the Criteria tab.

Enter the following information:
1. Year – Indicate the year that these receipts are for.
2. Quarter – Indicate which quarter you are interested in.
3. Special Gifts – Indicate which funds should be listed on the right side as “special gifts”. All other funds will be listed in the main section of the report.

In the Custom options section, enter the following custom text:
4. Gift Totals Title - enter the title you’d like the for the gift totals section.
5. Total Budget Title – enter the title for the budget total.
6. Custom Text – enter the receipt text you’d like to include.

In the Print Options section, make the following selections:
7. Exclude Pledge Info – mark this box if you do not want pledge information listed at the bottom of the report.
8. Exclude – mark the appropriate box if you do not want a receipt for folks whose address is marked as “bad address” or “do not send mail”.
9. Sort – indicate how you’d like the receipts ordered… by name or zip code.

View People

The view people tab is used to review the list of people that will be getting a statement. If you’d like to print a receipt for all these people, click PRINT RECEIPT. If you only want to print them for several of the people in the list, highlight the people that you want, then click PRINT RECEIPTS. It will only print statements for those people that were highlighted.
Printing/Emailing the Receipt

Once you have set up your criteria, reviewed the list of people and set up your text areas, click on PRINT RECEIPTS. The statements will be printed for everyone in the view people tab that does not have Email checked. If you want to print a receipt for everyone in the list regardless of the Email status, simply highlight all the people, then click PRINT RECEIPT.

If you’d like to email the statements, click EMAIL RECEIPTS. You will be given the choice to simply create a pdf for each statement, or to create pdf and send email. The receipts will be emailed to everyone in the list that has Email checked. If you want to override the Email status, highlight everyone you’d like to email a statement, then click SEND EMAIL.

Annual Statements

To create quarterly receipts, do the following:
1. Expand the Contributions menu.
2. Click on the Bulk Receipts menu item. The Contribution Receipts window will be displayed.
3. Choose Annual Receipt from the Receipt Type drop down.

Criteria

From the criteria tab, you can choose the type of receipt you want and what information should be displayed on the report.

Enter the following information:
1. Year - Indicate the year that these receipts are for.
2. Period Starting - This date is defaulted to the beginning of the quarter or year you selected. These dates may be changed.
3. Period Ending - This date is defaulted to the end of the quarter or year you selected. This date may be changed.
4. Total Giving for Period Over - If you only want to produce statements for folks who gave over a certain amount, enter that amount here.

Notice the tabs across the middle of the criteria page. On the Details tab enter the following information:
5. Receipt Details – choose if you’d like the receipt to only have a grand total or if you’d like it to display summary information by fund. You may also choose to display each individual gift.
Choose type of receipt and date range.

Choose what should be included in the body of the receipt.

6. Include Summary by Fund – If you selected Summary & Details under Receipt Details, you can mark this box if you’d like to display the summary information by fund.
7. Include Detailed Gifts – If you selected Summary & Details under Receipt Details, you can mark this box if you want to list each contribution for the period.
8. Include References to Pledges – Under the Pledge Detail section, mark this box if you’d like to see the pledge information for each fund that this donor contributed to. This will add a Pledge Received and Pledge Total column to the report.
9. Include Pledge Remainder – if you would like to include a column Pledge Remainder mark this box.
10. Include all who Pledge – if you want to create a quarterly statement for each person who pledged regardless of their giving for the quarter mark this box.

From the tabs across the middle of the criteria page, click on Print Options to make the following selections:
11. Single Print Job – under the print options section, mark this box if you want Roll Call to create 1 large print job for the quarterly receipts. If you will be duplexing the print job
(printing on both sides of the paper) you do not want to create a single print job. If you are emailing receipts you do not want to create a single print job. If you are using a large copier printer that requires a project code, you would want to check this box.

12. **Cover Letter** – if you’d like to print a cover letter before each statement, mark this box. Use the text tab to create your cover letter.

13. **Print on Stationary** - mark this box if you will be printing the statements on letterhead. By checking this box, the churches return address will not be printed on the statement. The statement will begin about 2 ½ inches down the page.

14. **Use Org Letterhead** – if you would like to pull in your letterhead graphic to print directly on the receipt, mark this box.

15. **First Page Only** - if you will only be using stationary for the first page of the receipt, mark this box.

16. **Report In Kind giving** – if you entered property or in-kind gifts without an associated amount and you want to display the item descriptions in the lower section of the receipt, mark this box.

17. **Show Envelope Number** – if you would like the envelope number printed on the statement, mark this box.

18. **Sorted By** – choose the sort order of the print job. Do you want the receipts sorted by zip code or by name.

19. **Exclude** – to exclude receipts for folks who have an address marked as “bad” or “do not send” mark this box.

From the tabs across the middle of the criteria page, click on Customize to change the font and alignment.

20. **Top Margin** – the number of centimeters required for the top margin.

21. **Organization Name** – the number of lines down that the organization name starts.

22. **Address starts on line#** - the number of lines down that the donor’s address starts.

23. **Body starts on line#** - the number of lines down that the body of the receipt starts.

24. **Customize Font** – mark this box if you’d like to change the font and size for the receipt. This may take some trial and error to make sure the summary section columns fit on the receipt.

25. **Font** – choose the font you’d like to use for the body of the receipt.

26. **Size** – choose the size of the font you’d like to use for the body of the receipt.
**Text**
There are several different types of “text” that can be used to customize your receipt. They are as follows:

1. **Top Text** – The top text area is used as a thank you note at the beginning of the statement. If you have a verse or a paragraph that you’d like printed at the beginning of the statement, use the top text area. If you have a large thank you note, we recommend you use the cover letter section.

2. **Cover Letter** – The cover letter is a 1 page letter that will be printed before each statement.

3. **Bottom Text** – The bottom text area is used as footer text. It typically indicates no goods or services were received.

4. **NonCashGifts** – if the donor had any non-cash gifts where an amount was assigned to the gift, an asterisk will be placed beside the amount. Then at the bottom of the statement, there will be an asterisk with the verbage you enter for non-cash gifts. Usually this would state that the donor is responsible for determining the fair market value of the gift.

5. **Third Party Gift** – if a donor gave a foundation monies to donate to your ministry on their behalf, the foundation is responsible for giving them a receipt. However, you would want to include the gift with a notation that the “third party” is responsible for receipting them.

6. **QPQ Gifts** – if the donor received something of value for their contribution, maybe a CD or T-shirt, the QPQ value is indicated on the receipt. Use the QPQ Gift text to indicate that the amount of the item is reduced from their total contribution.

7. **In Kind Gift** – if you have a property contribution where no value was assigned, these gifts are listed underneath the detail section of the statement. This text will be used as the header for the In Kind Gifts.

8. **Org Letterhead** – if you’d like to pull in your letterhead graphic so that the stationary and receipt are all printed at once, use this section.

To enter the text you’d like displayed on the statement, do the following:

1. Click on the Receipt Text tab.
2. Click on the type of text you’d like to enter.
3. Enter the text and format it as appropriate.

**View People**
The view people tab is used to review the list of people that will be getting a statement. If you’d like to print a receipt for all these people, click PRINT RECEIPT. If you only want to print
them for several of the people in the list, highlight the people that you want, then click PRINT RECEIPTS. It will only print statements for those people that were highlighted.

**Printing/emailing your receipt**

Once you have set up your criteria, reviewed the list of people and set up your text areas, click on PRINT RECEIPTS. The statements will be printed for everyone in the view people tab that does not have Email checked. If you want to print a receipt for everyone in the list regardless of the Email status, simply highlight all the people, then click PRINT RECEIPT.

If you’d like to email the statements, click EMAIL RECEIPTS. You will be given the choice to simply create a pdf for each statement, or to create pdf and send email. The receipts will be emailed to everyone in the list that has Email checked. If you want to override the Email status, highlight everyone you’d like to email a statement, then click SEND EMAIL.

**Canadian Receipts**

The Canadian receipts are 1/3 page receipts. They can be printed 1 per page or in triplicate. They summarize the contributions for previous year. There can be only one “original” receipt printed, each subsequent print has the word “copy” on it. There are three types of Canadian receipts:

1. Check or cash gifts
2. Cash gifts with advantage (Quid Pro Quo)
3. Non-cash or property gifts (In Kind gifts)

**Printing Canadian receipts**

To print Canadian receipts:

1. Expand the Contributions menu and click Bulk Receipts.
2. From the criteria tab, select Canadian Receipt as the format.
3. Select the year for which you’ll be printing the receipts. Once you choose the year, the starting and ending dates will be filled in. These dates may be changed.

From the print options section:

4. If you would like to print a sample receipt, mark the **Sample** box. This uses sample data. It is used primarily for lining up paper and viewing the format.
5. Choose the **Classic or Alternate format**. The Classic format was based on an example from the Canadian Tax Authority. The Alternate format lines up organization and donor addresses better.
6. If you would like to use the custom bottom text, mark the Receipt Text box in the Print Options area.

7. Select either a single copy or triplicate within the Print Options box. If you select “single”, only one receipt will be printed for each donor. If you select triplicate, 3 receipts will be printed. One will be the “original”, the other 2 will be labeled “copy”.

8. Indicate the type of labels you’d like to print in the Print Option area. If you do not want to print labels, select none. If you are printing on labels that are 3 across and 10 down, select Avery 5160 labels. If you would like to create a custom size and format, select custom. See “Creating Custom Labels” for more details.

9. Many times receipts must be re-printed for various reasons (they get lost, the printer jams, or they get lost in the mail). If you need a copy of a receipt that has already been printed, select “Reprint”. If you need a second “original”, select “Original”.

10. If you would like to print labels only, select the type of label from the Print Options area, then mark “Labels only”.

From the Sort options area
11. If you would like to have the receipts printed in alphabetical order, select Last Name in the Sort options box. If you would like to print the receipts in postal code order, select Postal Code in the Sort Options box.

From the Organization Logo section
12. If you would like to include your logo in the upper left corner of the receipt, click the ADD IMAGE button. This will allow you to go out to the operating system and pull in your logo.

From the Signature section
13. To pull in an electronic signature for the authorized person, click the ADD IMAGE button. This will allow you to go out to the operating system and pull in the signature.

14. Enter the Name of the person authorized to sign the receipt.

15. Enter the Location at which is issuing the receipt.

View People
The view people tab is used to review the list of people that will be getting a statement. If you’d like to print a receipt for all these people, click PRINT RECEIPT. If you only want to print them for several of the people in the list, highlight the people that you want, then click PRINT.
RECEIPTS. It will only print statements for those people that were highlighted.

**Printing/emailing your receipt**

Once you have set up your criteria, reviewed the list of people and set up your text areas, click on PRINT RECEIPTS. The statements will be printed for everyone in the view people tab that does not have Email checked. If you want to print a receipt for everyone in the list regardless of the Email status, simply highlight all the people, then click PRINT RECEIPT.

If you’d like to email the statements, click EMAIL RECEIPTS. You will be given the choice to simply create a pdf for each statement, or to create pdf and send email. The receipts will be emailed to everyone in the list that has Email checked. If you want to override the Email status, highlight everyone you’d like to email a statement, then click SEND EMAIL.

**Individual Gifts**

Individual gift receipts are receipts for a single contribution. To create these receipts, do the following:

1. Expand the Contributions menu.
2. Click on the Bulk Receipts menu item. The Contribution Receipts window will be displayed.
3. Choose Individual from the Receipt Type drop down.

**Criteria**

From the criteria tab, you can choose the type of receipt you want and what information should be displayed on the report.

Enter the following information:

1. **Year** - Indicate the year that these receipts are for.
2. **Quarter** – Indicate which quarter the receipts are for.
3. **Period Starting** - This date is defaulted to the beginning of the quarter or year you selected. These dates may be changed. For the individual gift format, you may want the period to be a single day.
4. **Period Ending**. This date is defaulted to the end of the quarter or year you selected. This date may be changed. For the individual gift format, you may want the period to reflect a single day.
5. **Total Giving for Period Over** – If you only want to produce statements for folks who gave over a certain amount, enter that amount here.

Notice the tabs across the middle of the criteria page. On the Details tab enter the following information:

6. **Receipt Details** – choose if you’d like the receipt to only have a grand total or if you’d like it to display summary information by fund. You may also choose to display each individual gift.

7. **Include Summary by Fund** – If you selected Summary & Details under Receipt Details, you can mark this box if you’d like to display the summary information by fund.

8. **Include Detailed Gifts** – If you selected Summary & Details under Receipt Details, you can mark this box if you want to list each contribution for the period.

9. **Include References to Pledges** – Under the Pledge Detail section, mark this box if you’d like to see the pledge information for each fund that this donor contributed to. This will add a Pledge Received and Pledge Total column to the report.

10. **Include Pledge Remainder** – if you would like to include a column Pledge Remainder mark this box.

11. **Include all who Pledge** – if you want to create a quarterly statement for each person who pledged regardless of their giving for the quarter mark this box.

From the tabs across the middle of the criteria page, click on Print Options to make the following selections:

12. **Single Print Job** – under the print options section, mark this box if you want Roll Call to create 1 large print job for the quarterly receipts. If you will be duplexing the print job (printing on both sides of the paper) you do not want to create a single print job. If you are emailing receipts you do not want to create a single print job. If you are using a large copier printer that requires a project code, you would want to check this box.

13. **Cover Letter** – if you’d like to print a cover letter before each statement, mark this box. Use the text tab to create your cover letter.

14. **Print on Stationary** - mark this box if you will be printing the statements on letterhead. By checking this box, the churches return address will not be printed on the statement. The statement will begin about 2 ½ inches down the page.

15. **Use Org Letterhead** – if you would like to pull in your letterhead graphic to print directly on the receipt, mark this box.

16. **First Page Only** - if you will only be using stationary for the first page of the receipt, mark
17. *Report In Kind giving* – if you entered property or in-kind gifts without an associated amount and you want to display the item descriptions in the lower section of the receipt, mark this box.

18. *Show Envelope Number* – if you would like the envelope number printed on the statement, mark this box.

19. *Sorted By* – choose the sort order of the print job. Do you want the receipts sorted by zip code or by name.

20. *Exclude* – to exclude receipts for folks who have an address marked as “bad” or “do not send” mark this box.

From the tabs across the middle of the criteria page, click on Customize to change the font and alignment.

21. *Top Margin* – the number of centimeters required for the top margin.

22. *Organization Name* – the number of lines down that the organization name starts.

23. *Address starts on line* - the number of lines down that the donor’s address starts.

24. *Body starts on line* - the number of lines down that the body of the receipt starts.

25. *Customize Font* – mark this box if you’d like to change the font and size for the receipt. This may take some trial and error to make sure the summary section columns fit on the receipt.

26. *Font* – choose the font you’d like to use for the body of the receipt.

27. *Size* – choose the size of the font you’d like to use for the body of the receipt.

**Text**

There are several different types of “text” that can be used to customize your receipt. They are as follows:

1. **Top Text** – The top text area is used as a thank you note at the beginning of the statement. If you have a verse or a paragraph that you’d like printed at the beginning of the statement, use the top text area. If you have a large thank you note, we recommend you use the cover letter section.

2. **Cover Letter** – The cover letter is a 1 page letter that will be printed before each statement.

3. **Bottom Text** – The bottom text area is used as footer text. It typically indicates no goods or services were received.
4. NonCashGifts – if the donor had any non-cash gifts where an amount was assigned to the gift, an asterisk will be placed beside the amount. Then at the bottom of the statement, there will be an asterisk with the verbage you enter for non-cash gifts. Usually this would state that the donor is responsible for determining the fair market value of the gift.

5. Third Party Gift – if a donor gave a foundation monies to donate to your ministry on their behalf, the foundation is responsible for giving them a receipt. However, you would want to include the gift with a notation that the “third party” is responsible for receipting them.

6. QPQ Gifts – if the donor received something of value for their contribution, maybe a CD or T-shirt, the QPQ value is indicated on the receipt. Use the QPQ Gift text to indicate that the amount of the item is reduced from their total contribution.

7. In Kind Gift – if you have a property contribution where no value was assigned, these gifts are listed underneath the detail section of the statement. This text will be used as the header for the In Kind Gifts.

8. Org Letterhead – if you’d like to pull in your letterhead graphic so that the stationary and receipt are all printed at once, use this section.

To enter the text you’d like displayed on the statement, do the following:
1. Click on the Receipt Text tab.
2. Click on the type of text you’d like to enter.
3. Enter the text and format it as appropriate.

View People

The view people tab is used to review the list of people that will be getting a statement. If you’d like to print a receipt for all these people, click PRINT RECEIPT. If you only want to print them for several of the people in the list, highlight the people that you want, then click PRINT RECEIPTS. It will only print statements for those people that were highlighted.

Printing/emailing your receipt

Once you have set up your criteria, reviewed the list of people and set up your text areas, click on PRINT RECEIPTS. The statements will be printed for everyone in the view people tab that does not have Email checked. If you want to print a receipt for everyone in the list regardless of the Email status, simply highlight all the people, then click PRINT RECEIPT.

If you’d like to email the statements, click EMAIL RECEIPTS. You will be given the choice to simply create a pdf for each statement, or to create pdf and send email. The receipts will be emailed to everyone in the list that has Email checked. If you want to override the Email status,
highlight everyone you’d like to email a statement, then click SEND EMAIL.

**Statement for a Specific Person**

To print a receipt for a specific individual, do the following:
1. Expand the Contributions menu.
2. Click on the Personal Receipts menu item. The Select a Person window will be displayed.
3. Enter the last name of the individual, select from the list or further refine by entering the first name.

**Criteria**

From the criteria tab, you can choose the type of receipt you want and what information should be displayed on the report.

Enter the following information:
1. **Year** - Indicate the year that these receipts are for.
2. **Quarter** – Indicate the quarter that these receipts are for.
3. **Period Starting** - This date is defaulted to the beginning of the quarter or year you selected. These dates may be changed.
4. **Period Ending**. This date is defaulted to the end of the quarter or year you selected. This date may be changed.
5. **Total Giving for Period Over** – If you only want to produce statements for folks who gave over a certain amount, enter that amount here.

Notice the tabs across the middle of the criteria page. On the Details tab enter the following information:
6. **Receipt Details** – choose if you’d like the receipt to only have a grand total or if you’d like it to display summary information by fund. You may also choose to display each individual gift.
7. **Include Summary by Fund** – If you selected Summary & Details under Receipt Details, you can mark this box if you’d like to display the summary information by fund.
8. **Include Detailed Gifts** – If you selected Summary & Details under Receipt Details, you can mark this box if you want to list each contribution for the period.
9. **Include References to Pledges** – Under the Pledge Detail section, mark this box if you’d like to see the pledge information for each fund that this donor contributed to. This will add a
Pledge Received and Pledge Total column to the report.
10. Include Pledge Remainder – if you would like to include a column Pledge Remainder mark this box.
11. Include all who Pledge – if you want to create a quarterly statement for each person who pledged regardless of their giving for the quarter mark this box.

From the tabs across the middle of the criteria page, click on Print Options to make the following selections:
12. Single Print Job – under the print options section, mark this box if you want Roll Call to create 1 large print job for the quarterly receipts. If you will be duplexing the print job (printing on both sides of the paper) you do not want to create a single print job. If you are emailing receipts you do not want to create a single print job. If you are using a large copier printer that requires a project code, you would want to check this box.
13. Cover Letter – if you’d like to print a cover letter before each statement, mark this box. Use the text tab to create your cover letter.

14. Print on Stationary - mark this box if you will be printing the statements on letterhead. By checking this box, the churches return address will not be printed on the statement. The statement will begin about 2 ½ inches down the page.
15. Use Org Letterhead – if you would like to pull in your letterhead graphic to print directly on the receipt, mark this box.
16. First Page Only - if you will only be using stationary for the first page of the receipt, mark this box.
17. Report In Kind giving – if you entered property or in-kind gifts without an associated amount and you want to display the item descriptions in the lower section of the receipt, mark this box.
18. Show Envelope Number – if you would like the envelope number printed on the statement, mark this box.
19. Sorted By – choose the sort order of the print job. Do you want the receipts sorted by zip code or by name.
20. Exclude – to exclude receipts for folks who have an address marked as “bad” or “do not send” mark this box.

From the tabs across the middle of the criteria page, click on Customize to change the font and alignment.
21. Top Margin – the number of centimeters required for the top margin.
22. **Organization Name** – the number of lines down that the organization name starts.
23. **Address starts on line#** - the number of lines down that the donor’s address starts.
24. **Body starts on line#** - the number of lines down that the body of the receipt starts.
25. **Customize Font** – mark this box if you’d like to change the font and size for the receipt. This may take some trial and error to make sure the summary section columns fit on the receipt.
26. **Font** – choose the font you’d like to use for the body of the receipt.
27. **Size** – choose the size of the font you’d like to use for the body of the receipt.

**Text**

There are several different types of “text” that can be used to customize your receipt. They are as follows:

1. **Top Text** – The top text area is used as a thank you note at the beginning of the statement. If you have a verse or a paragraph that you’d like printed at the beginning of the statement, use the top text area. If you have a large thank you note, we recommend you use the cover letter section.
2. **Cover Letter** – The cover letter is a 1 page letter that will be printed before each statement.
3. **Bottom Text** – The bottom text area is used as footer text. It typically indicates no goods or services were received.
4. **NonCashGifts** – if the donor had any non-cash gifts where an amount was assigned to the gift, an asterisk will be placed beside the amount. Then at the bottom of the statement, there will be an asterisk with the verbage you enter for non-cash gifts. Usually this would state that the donor is responsible for determining the fair market value of the gift.
5. **Third Party Gift** – if a donor gave a foundation monies to donate to your ministry on their behalf, the foundation is responsible for giving them a receipt. However, you would want to include the gift with a notation that the “third party” is responsible for receipting them.
6. **QPQ Gifts** – if the donor received something of value for their contribution, maybe a CD or T-shirt, the QPQ value is indicated on the receipt. Use the QPQ Gift text to indicate that the amount of the item is reduced from their total contribution.
7. **In Kind Gift** – if you have a property contribution where no value was assigned, these gifts are listed underneath the detail section of the statement. This text will be used as the header for the In Kind Gifts.
8. **Org Letterhead** – if you’d like to pull in your letterhead graphic so that the stationary and receipt are all printed at once, use this section.
To enter the text you’d like displayed on the statement, do the following:
1. Click on the Receipt Text tab.
2. Click on the type of text you’d like to enter.
3. Enter the text and format it as appropriate.

**View People**
The view people tab is used to review the list of people that will be getting a statement. If you’d like to print a receipt for all these people, click PRINT RECEIPT. If you only want to print them for several of the people in the list, highlight the people that you want, then click PRINT RECEIPTS. It will only print statements for those people that were highlighted.

**Printing/emailing your receipt**
Once you have set up your criteria, reviewed the list of people and set up your text areas, click on PRINT RECEIPTS. The statements will be printed for everyone in the view people tab that does not have Email checked. If you want to print a receipt for everyone in the list regardless of the
Email status, simply highlight all the people, then click PRINT RECEIPT.

If you’d like to email the statements, click EMAIL RECEIPTS. You will be given the choice to simply create a pdf for each statement, or to create pdf and send email. The receipts will be emailed to everyone in the list that has Email checked. If you want to override the Email status, highlight everyone you’d like to email a statement, then click SEND EMAIL.
CREATING CONTRIBUTION REPORTS

To run the standard contribution reports,
1. Expand the Contributions menu and click Reports OR
2. Select Reports from the Top menu and select Contribution Reports.

From this Report window, all the reports are listed on the left side. There are also three tabs across the top: Criteria, Columns and View Records. The Criteria tab allows you to enter the date range and select who you want to include in the report as well as which funds to include in the report. The Columns tab allows you to choose what data or fields you want displayed on the report. The View Records shows you which people will be included in the report based on your criteria.

Donor Detail Report

The Donor Detail report outlines all contributions for a given time period, for the funds you are interested in, for the people you are interested in. To run the Donor Detail report:

1. Expand the Contributions menu.
2. Click on Reports.
3. Click Donor Detail on the left sidebar.
4. Click on the Criteria tab. From the criteria tab, select the date range that you wish for this report. Then under the Who tab, select the donors you wish to see on the report. Do you wish to see all donors, or certain associations or certain groups etc. Once you’ve chose who, click on the What tab. From here, select the funds you are interested in including on this report.
5. Click on the Columns tab. Choose the columns you wish to view on the report. There are default fields already set up for this report, but you can drag additional fields from the left side to the Selected column. You can rearrange the ordering in the Selected column by dragging and dropping in the order you wish to see them in the report.
6. If you’d like to change the sort order, move the columns from the Selected column to the “Sort” column.
7. Click GENERATE.

Let’s say we’d like a donor report for all donors (we don’t care what their association is) and we want to list all their contributions for all funds. On this report we want to see donor name, email address, contribution date and amount.
1. Highlight Contribution Detail on the left sidebar.
2. From the Criteria tab, select “This Week” from the date range drop down.
3. Click on the Who tab. Leave “Everyone” selected.
4. Mark the box for “Combine Families” if you want contributions from families lumped together.

5. Click on the What tab. Click the double arrow to move all funds to the Selected column.
6. Mark the box to include non-cash gifts if you want to include property gift amounts in the report as well.

7. Click on the Columns tab. Drag the email, address, city and state fields from the left side column to the Selected column on the report.
8. Click GENERNATE to produce the report.
On the right side of the Report Output Window are actions that can be performed for the report.

1. Click on PAGE SETUP to set your printer and paper size and orientation.
2. Click on PREVIEW to preview the output. Do not send the report to the printer from this preview window, it will only send the first page to the printer.
3. To change fonts, column sizes etc., click CUSTOMIZE. The report will be displayed in 4D View, Roll Call’s spreadsheet program. Make your modifications here.
4. Click on PRINT to send the report to the printer.
5. Click ZOOM IN to make the font in the report larger on your screen.
6. Click ZOOM OUT to make the report font smaller on your screen.
7. To save the report as a tab delimited file or html document, click SAVE. Enter the location and name of the file to be saved.
8. Click SAVE SET to save the list of people for use later within Roll Call.
9. Click CREATE LABELS to create address labels (3 across 10 down size) for this list of people.
10. Click WRITE LETTER, to compose a mail merge letter to this list of people.
11. Click EMAIL to send an email to this list of people or to email the report to another individual. If you choose Email people, it will send the email to everyone listed in the report.

**Donor Summary Report**

The Donor Summary report calculates the amount given by the donor for all the funds selected for the given time period. To run the Contribution Summary report:

1. Expand the Contributions menu.
2. Click on Reports.
3. Click Donor Summary on the left sidebar.
4. Click on the Criteria tab. From the criteria tab, select the date range that you wish for this report. Then under the Who tab, select the donors you wish to see on the report. Do you wish to see all donors, or certain associations or certain groups etc. Once you’ve chosen who, click on the What tab. From here, select the funds you are interested in including on this report.
5. Click on the Columns tab. Choose the columns you wish to view on the report. There are default fields already set up for this report, but you can drag additional fields from the left side to the *Selected* column. You can rearrange the ordering in the Selected column by dragging and dropping in the order you wish to see them in the report.
6. If you’d like to change the sort order, move the columns from the *Selected* column to the “Sort” column.
7. Click GENERATE.

As an example, lets say we’d like a donor summary report for all members who have given to the building fund. On this report we want to see donor name, address, total, number of gifts and average gift.

1. Highlight Donor Summary on the left sidebar.
2. From the Criteria tab, select “This Month” from the date range drop down.
3. Click on the Who tab. Select Association from the “Run for” drop down box. Click on Member to move that value to the *Selected* column.
4. Mark the box for “Combine Families” if you want contributions from families lumped together.

![Select the date range and run for criteria for this report.](image)
5. Click on the What tab. Click on Building to move that fund to the Selected column. 

6. Mark the box to include non-cash gifts if you want to include property gift amounts in the report as well. 

7. Click on the Columns tab. Drag address, city and state fields from the left side column to the Selected column on the report. 

8. Click GENERATE to produce the report. 

On the right side of the Report Output Window are actions that can be performed for the report. 
1. Click on PAGE SETUP to set your printer and paper size and orientation. 
2. Click on PREVIEW to preview the output. Do not send the report to the printer from this preview window, it will only send the first page to the printer. 
3. To change fonts, column sizes etc., click CUSTOMIZE. The report will be displayed in 4D View, Roll Call’s spreadsheet program. Make your modifications here. 
4. Click on PRINT to send the report to the printer. 
5. Click ZOOM IN to make the font in the report larger on your screen. 
6. Click ZOOM OUT to make the report font smaller on your screen.
To save the report as a tab delimited file or html document, click SAVE. Enter the location and name of the file to be saved.

Click SAVE SET to save the list of people for use later within Roll Call.

Click CREATE LABELS to create address labels (3 across 10 down size) for this list of people.

Click WRITE LETTER, to compose a mail merge letter to this list of people.

Click EMAIL to send an email to this list of people or to email the report to another individual. If you choose Email people, it will send the email to everyone listed in the report.

**Donor Summary by Fund**

The Donor Summary by Fund report calculates the amount given to each fund by the donor for the given time period. To run the Contribution Summary by Fund report:

1. Expand the Contributions menu.
2. Click on Reports.
3. Click Donor Summary by Fund on the left sidebar.
4. Click on the Criteria tab. From the criteria tab, select the date range that you wish for this report. Then under the Who tab, select the donors you wish to see on the report. Do you wish to see all donors, or certain associations or certain groups etc. Once you’ve chosen who, click on the What tab. From here, select the funds you are interested in including on this report.
5. Click on the Columns tab. Choose the columns you wish to view on the report. There are default fields already set up for this report, but you can drag additional fields from the left side to the Selected column. You can rearrange the ordering in the Selected column by dragging and dropping in the order you wish to see them in the report.
6. If you’d like to change the sort order, move the columns from the Selected column to the “Sort” column.
7. Click GENERATE.

As an example, lets say we’d like a donor summary by fund report for all donors and we want a total of all of their contributions for the given time period. On this report we want to see donor name, email, amount, and number of gifts.

1. Highlight Contribution Summary by Fund on the left sidebar.
2. From the Criteria tab, select “This Month” from the date range drop down.
3. Click on the Who tab. Leave “Everyone” selected.
4. Mark the box for “Combine Families” if you want contributions from families lumped together.

On criteria tab, choose date range and who should be included in report.

5. Click on the What tab. Click the double arrow to move all funds to the Selected column.
6. Mark the box to include non cash gifts if you want to include property gift amounts in the report as well.

Choose the funds that should be included in the giving calculation.

7. Click on the Columns tab. Drag the email field from the left side column to the Selected column on the report.
8. Click GENERATE to produce the report.

On the right side of the Report Output Window are actions that can be performed for the report.
1. Click on PAGE SETUP to set your printer and paper size and orientation.
2. Click on PREVIEW to preview the output. Do not send the report to the printer from this preview window, it will only send the first page to the printer.
3. To change fonts, column sizes etc., click CUSTOMIZE. The report will be displayed in 4D View, Roll Call’s spreadsheet program. Make your modifications here.
Lists each donor and how much they gave to each fund.

Note the actions on the right side.

4. Click on PRINT to send the report to the printer.
5. Click ZOOM IN to make the font in the report larger on your screen.
6. Click ZOOM OUT to make the report font smaller on your screen.
7. To save the report as a tab delimited file or html document, click SAVE. Enter the location and name of the file to be saved.
8. Click SAVE SET to save the list of people for use later within Roll Call.
9. Click CREATE LABELS to create address labels (3 across 10 down size) for this list of people.
10. Click WRITE LETTER, to compose a mail merge letter to this list of people.
11. Click EMAIL to send an email to this list of people or to email the report to another individual. If you choose Email people, it will send the email to everyone listed in the report.

**Donor Giving by Week, Month or Year**

The Donor Giving summarizes how much a donor gave by week, month or year in a spreadsheet format. The weeks, months or years are listed across the top of the spreadsheet for the timeframe you selected.

To run this report:
1. Expand the Contributions menu.
2. Click on Reports.
3. Click Donor Giving on the left sidebar.
4. Click on the Criteria tab. From the criteria tab, select the date range that you wish for this report. Next, select the Report Type: by Week, by Month or by Year. Then under the Who tab, select the donors you wish to see on the report. Do you wish to see all donors, or certain associations or certain groups etc. Once you’ve chosen who, click on the What tab. From here, select the funds you are interested in including on this report.
5. Click on the Columns tab. Choose the columns you wish to view on the report. There are default fields already set up for this report, but you can drag additional fields from the left side to the Selected column. You can rearrange the ordering in the Selected column by dragging and dropping in the order you wish to see them in the report.
6. If you’d like to change the sort order, move the columns from the Selected column to the “Sort” column.
7. Click GENERATE.
As an example, let’s say we’d like a Donor Giving by Month report for all donors and we want a total of all of their contributions for the given time period. On this report we want to see donor name, birthday and amount for each month.

1. Highlight Donor Giving on the left sidebar.
2. From the Criteria tab, select “This Month” from the date range drop down.
3. Click on the Who tab. Leave “Everyone” selected.
4. Mark the box for Combine Families if you want contributions from families lumped together.
5. If you want all people listed, whether or not they gave, uncheck Only those Who Gave.

6. Click on the What tab. Click the double arrow to move all funds to the Selected column.
7. Mark the box to include non cash gifts if you want to include property gift amounts in the report as well.

8. Click on the Columns tab. Drag the birth date field from the left side column to the Selected column on the report.
9. Click GENERNATE to produce the report.
Choose the information that should be included in the report.

Lists each donor and how much they gave each month.

On the right side of the Report Output Window are actions that can be performed for the report.

1. Click on PAGE SETUP to set your printer and paper size and orientation.
2. Click on PREVIEW to preview the output. Do not send the report to the printer from this preview window, it will only send the first page to the printer.
3. To change fonts, column sizes etc., click CUSTOMIZE. The report will be displayed in 4D View, Roll Call’s spreadsheet program. Make your modifications here.
4. Click on PRINT to send the report to the printer.
5. Click ZOOM IN to make the font in the report larger on your screen.
6. Click ZOOM OUT to make the report font smaller on your screen.
7. To save the report as a tab delimited file or html document, click SAVE. Enter the location and name of the file to be saved.
8. Click SAVE SET to save the list of people for use later within Roll Call.
9. Click EMAIL to send an email of the report to another individual.
Top Donors

The Top X Givers report lists the top givers based on the date range, funds and the people you select. To run this report:

1. Expand the Contributions menu.
2. Click on Reports.
3. Click Top X Donors on the left sidebar.
4. Click on the Criteria tab. From the criteria tab, select the date range that you wish for this report. Then under the Who tab, select the donors you wish to see on the report. Do you wish to see all donors, or certain associations or certain groups etc. Once you’ve chosen who, click on the What tab. From here, select the funds you are interested in including on this report.
5. Click on the Columns tab. Choose the columns you wish to view on the report. There are default fields already set up for this report, but you can drag additional fields from the left side to the Selected column. You can rearrange the ordering in the Selected column by dragging and dropping in the order you wish to see them in the report.
6. If you’d like to change the sort order, move the columns from the Selected column to the “Sort” column.
7. Click GENERATE.

As an example, lets say we’d like to view the Top 10 donors that are also members. On this report we want to see donor name, birthday and amount.

1. Highlight Top X Donors on the left sidebar.
2. From the Criteria tab, select “This Year” from the date range drop down.
3. Enter 10 as the number of givers.
4. Click on the Who tab. In the Run for drop down, select “Association”. Click on Member to move that value to the Selected column.
5. Mark the box for Combine Families if you want contributions from families lumped together.
6. Click on the What tab. Click the double arrow to move all funds to the Selected column.

7. Mark the box to include non cash gifts if you want to include property gift amounts in the report as well.
8. Click on the Columns tab. Drag the birth date field from the left side column to the Selected column on the report.
Choose which funds should be used in giving calculation.

9. Click GENERATE to produce the report.

Choose the information that should be included on the report.

On the right side of the Report Output Window are actions that can be performed for the report.
1. Click on PAGE SETUP to set your printer and paper size and orientation.
2. Click on PREVIEW to preview the output. Do not send the report to the printer from this preview window, it will only send the first page to the printer.
3. To change fonts, column sizes etc., click CUSTOMIZE. The report will be displayed in 4D View, Roll Call’s spreadsheet program. Make your modifications here.
4. Click on PRINT to send the report to the printer.
5. Click ZOOM IN to make the font in the report larger on your screen.
6. Click ZOOM OUT to make the report font smaller on your screen.
7. To save the report as a tab delimited file or html document, click SAVE. Enter the location and name of the file to be saved.
8. Click SAVE SET to save the list of people for use later within Roll Call.
9. Click CREATE LABELS to create address labels (3 across 10 down size) for this list of people.
Lists the top 10 donors.

Donors over X Amount

The Donors over X Amount report lists the donors that meet the specified amount criteria for the date range, funds and people selected.

To run this report:
1. Expand the Contributions menu.
2. Click on Reports.
3. Click Donors over X Amount on the left sidebar.
4. From the criteria tab, select the date range that you wish for this report.
5. Next enter the amount that you are searching for. The report will search for those folks who gave exactly that amount or greater over the date range.
6. Next under the Who tab, select the donors you wish to see on the report. Do you wish to see all donors, or certain associations or certain groups, etc.? Once you’ve chosen who, click on the What tab. From here, select the funds you are interested in including on this report.
7. Click on the Columns tab. Choose the columns you wish to view on the report. There are default fields already set up for this report, but you can drag additional fields from the left side to the Selected column. You can rearrange the ordering in the Selected column by dragging and dropping in the order you wish to see them in the report.
8. If you’d like to change the sort order, move the columns from the Selected column to the “Sort” column.
9. Click GENERATE.

As an example, lets say we’d like to view people who have given over $250 this year. We want to evaluate everyone in the database and we want to consider giving to all funds.

1. Highlight Donors over X amount on the left sidebar.
2. From the Criteria tab, select “This Year” from the date range drop down.
3. Enter 250 as the Amount.
5. Mark the box for Combine Families if you want contributions from families lumped together.
6. Click on the What tab. Click the double arrow to move all funds to the Selected column.
7. Mark the box to include non-cash gifts if you want to include property gift amounts in the report as well.
8. Click on the Columns tab. Drag the address, city, and state fields from the left side column to the Selected column on the report.
9. Click GENERNATE to produce the report.

On the right side of the Report Output Window are actions that can be performed for the report.
1. Click on PAGE SETUP to set your printer and paper size and orientation.
2. Click on PREVIEW to preview the output. Do not send the report to the printer from this preview window, it will only send the first page to the printer.
3. To change fonts, column sizes etc., click CUSTOMIZE. The report will be displayed in 4D View, Roll Call’s spreadsheet program. Make your modifications here.
Choose the information that should be included in the report.

Listing of donors who gave over the specified amount.

Note actions that can be performed.

4. Click on PRINT to send the report to the printer.
5. Click ZOOM IN to make the font in the report larger on your screen.
6. Click ZOOM OUT to make the report font smaller on your screen.
7. To save the report as a tab delimited file or html document, click SAVE. Enter the location and name of the file to be saved.
8. Click SAVE SET to save the list of people for use later within Roll Call.
9. Click CREATE LABELS to create address labels (3 across 10 down size) for this list of people.
10. Click WRITE LETTER, to compose a mail merge letter to this list of people.
11. Click EMAIL to send an email to this list of people or to email the report to another individual. If you choose Email people, it will send the email to everyone listed in the report.

**Given X Times**

The Given X Times lists the donors who have given over a certain number of gifts based on the date range, funds and people you select.
To run this report:
1. Expand the Contributions menu.
2. Click on Reports.
3. Click Given X Times on the left sidebar.
4. From the criteria tab, select the date range that you wish for this report.
5. Next enter the number of times you are searching for. The report will search for those folks who have given at least that many times over the date range.
6. Next under the Who tab, select the donors you wish to see on the report. Do you wish to see all donors, or certain associations or certain groups, etc.? Once you’ve chosen who, click on the What tab. From here, select the funds you wish to consider for this report.
7. Click on the Columns tab. Choose the columns you wish to view on the report. There are default fields already set up for this report, but you can drag additional fields from the left side to the Selected column. You can rearrange the ordering in the Selected column by dragging and dropping in the order you wish to see them in the report.
8. If you’d like to change the sort order, move the columns from the Selected column to the Sort column.
9. Click GENERATE.

As an example, lets say we’d like to view people who have given at least 6 times this year. We want to evaluate everyone in the database and we want to consider giving to all funds.
1. Highlight Given X times on the left sidebar.
2. From the Criteria tab, select “This Year” from the date range drop down.
3. Enter 6 as the Times.
5. Mark the box for Combine Families if you want contributions from families lumped together.
6. Click on the What tab. Click the double arrow to move all funds to the Selected column.
7. Mark the box to include non-cash gifts if you want to include property gift amounts in the report as well.
8. Click on the Columns tab. Drag the address, city, and state fields from the left side column to the Selected column on the report.
9. Click GENERATE to produce the report.

On the right side of the Report Output Window are actions that can be performed for the report.
1. Click on PAGE SETUP to set your printer and paper size and orientation.
2. Click on PREVIEW to preview the output. Do not send the report to the printer from this preview window, it will only send the first page to the printer.
3. To change fonts, column sizes etc., click CUSTOMIZE. The report will be displayed in 4D View, Roll Call’s spreadsheet program. Make your modifications here.
4. Click on PRINT to send the report to the printer.
5. Click ZOOM IN to make the font in the report larger on your screen.
6. Click ZOOM OUT to make the report font smaller on your screen.
7. To save the report as a tab delimited file or html document, click SAVE. Enter the location and name of the file to be saved.
8. Click SAVE SET to save the list of people for use later within Roll Call.
9. Click CREATE LABELS to create address labels (3 across 10 down size) for this list of people.
10. Click WRITE LETTER, to compose a mail merge letter to this list of people.
11. Click EMAIL to send an email to this list people or to email the report to another individual. If you choose Email people, it will send the email to everyone listed in the report.

**Given 0 Times**

The Given 0 Times report lists the people in your database who have not contributed within the specified time period.

To run this report:
1. Expand the Contributions menu.
2. Click on Reports.
3. Click Given 0 Times on the left sidebar.
4. From the criteria tab, select the date range that you wish for this report.
5. Next under the Who tab, select the donors you wish to see on the report. Do you wish to see all donors, or certain associations or certain groups, etc.?
6. Click on the What tab. From here, select the funds you wish to consider for this report.
7. Click on the Columns tab. Choose the columns you wish to view on the report. There are default fields already set up for this report, but you can drag additional fields from the left side to the Selected column. You can rearrange the ordering in the Selected column by dragging and dropping in the order you wish to see them in the report.
8. If you’d like to change the sort order, move the columns from the Selected column to the Sort column.
9. Click GENERATE.

As an example, let’s say we’d like to view members who have not given at all.
1. Highlight Given 0 times on the left sidebar.
2. From the Criteria tab, select “This Year” from the date range drop down.
3. Click on the Who tab. Select “Associations” as the Run for. Select Member.
4. Mark the box for Combine Families if you want contributions from families lumped together.
5. Click on the What tab. Click General fund to the Selected column.
6. Mark the box to include non-cash gifts if you want to include property gift amounts in the report as well.
Choose the date range and the "run for" criteria. In this example, members and regular attenders.

Choose which fund to consider. In this example, we want to find those that haven't given to the general fund.

Choose the information to include in the report.
7. Click on the Columns tab. Drag the address, city, and state fields from the left side column to the Selected column on the report.
8. Click GENERNATE to produce the report.

On the right side of the Report Output Window are actions that can be performed for the report.
1. Click on PAGE SETUP to set your printer and paper size and orientation.
2. Click on PREVIEW to preview the output. Do not send the report to the printer from this preview window, it will only send the first page to the printer.
3. To change fonts, column sizes etc., click CUSTOMIZE. The report will be displayed in 4D View, Roll Call’s spreadsheet program. Make your modifications here.
4. Click on PRINT to send the report to the printer.
5. Click ZOOM IN to make the font in the report larger on your screen.
6. Click ZOOM OUT to make the report font smaller on your screen.
7. To save the report as a tab delimited file or html document, click SAVE. Enter the location and name of the file to be saved.
8. Click SAVE SET to save the list of people for use later within Roll Call.
9. Click CREATE LABELS to create address labels (3 across 10 down size) for this list of people.
10. Click WRITE LETTER, to compose a mail merge letter to this list of people.
11. Click EMAIL to send an email to this list people or to email the report to another individual. If you choose Email people, it will send the email to everyone listed in the report.

First Time Givers

The First Time Givers report allows you to view those folks who gave for the first time, during a specified time period.

To run this report:
1. Expand the Contributions menu.
2. Click on Reports.
3. Click First Time Givers on the left sidebar.
4. From the criteria tab, select the date range that you wish for this report. Also select First, Second, or Third time Givers.
5. Next under the Who tab, select the donors you wish to see on the report. Do you wish to see all donors, or certain associations or certain groups, etc.? Once you’ve chosen who, click on the What tab. From here, select the funds you wish to consider for this report.
6. Click on the Columns tab. Choose the columns you wish to view on the report. There are default fields already set up for this report, but you can drag additional fields from the left side to the Selected column. You can rearrange the ordering in the Selected column by dragging and dropping in the order you wish to see them in the report.

7. If you’d like to change the sort order, move the columns from the Selected column to the Sort column.

8. Click GENERATE.

As an example, let’s say we’d like to view people who have given at least 6 times his year. We want to evaluate everyone in the database and we want to consider giving to all funds.

1. Highlight First Time Givers on the left sidebar.
2. From the Criteria tab, select “This Year” from the date range drop down.
3. Select “First Time Giver” as the report type.
5. Mark the box for Combine Families if you want contributions from families lumped together.
6. Click on the What tab. Click the double arrow to move all funds to the *Selected* column.

7. Mark the box to include non-cash gifts if you want to include property gift amounts in the report as well.

8. Click on the Columns tab. Drag the address, city, and state fields from the left side column to the *Selected* column on the report.

Choose the information you’d like included on the report.

9. Click GENERATE to produce the report.

On the right side of the Report Output Window are actions that can be performed for the report.
1. Click on PAGE SETUP to set your printer and paper size and orientation.
2. Click on PREVIEW to preview the output. Do not send the report to the printer from this preview window, it will only send the first page to the printer.
3. To change fonts, column sizes etc., click CUSTOMIZE. The report will be displayed in 4D View, Roll Call’s spreadsheet program. Make your modifications here.
4. Click on PRINT to send the report to the printer.
5. Click ZOOM IN to make the font in the report larger on your screen.

Listing of first time givers.
6. Click ZOOM OUT to make the report font smaller on your screen.
7. To save the report as a tab delimited file or html document, click SAVE. Enter the location and name of the file to be saved.
8. Click SAVE SET to save the list of people for use later within Roll Call.
9. Click CREATE LABELS to create address labels (3 across 10 down size) for this list of people.
10. Click WRITE LETTER, to compose a mail merge letter to this list of people.
11. Click EMAIL to send an email to this list people or to email the report to another individual. If you choose Email people, it will send the email to everyone listed in the report.

**Fund Summary**

The Fund Summary report calculates the amount given to the fund during the selected timeframe by the selected donors. To run the Fund Summary report:
1. Expand the Contributions menu.
2. Click on Reports.
3. Click Fund Summary on the left sidebar.
4. From the criteria tab, select the date range that you wish for this report.
5. Next under the Who tab, select the donors you wish to see on the report. Do you wish to see all donors, or certain associations or certain groups, etc.?
6. Click on the What tab. From here, select the funds you wish to consider for this report.
7. Click on the Columns tab. Choose the columns you wish to view on the report. There are default fields already set up for this report, but you can drag additional fields from the left side to the Selected column. You can rearrange the ordering in the Selected column by dragging and dropping in the order you wish to see them in the report.
8. If you’d like to change the sort order, move the columns from the Selected column to the Sort column.
9. Click GENERATE.

As an example, lets say we’d like to view how much has been given to General and Building by the small groups.
1. Highlight Fund Summary on the left sidebar.
2. From the Criteria tab, select “This Year” from the date range drop down.
3. Click on the Who tab. Select “Groups” as the Run for. Click over all the small groups.

Choose the folks whose contributions you’d like included in the report.
4. Mark the box for *Combine Families* if you want contributions from families lumped together.
5. Click on the What tab. Click General and Building funds to the *Selected* column.
6. Mark the box to include non-cash gifts if you want to include property gift amounts in the report as well.

7. Click **GENERATE** to produce the report.

On the right side of the Report Output Window are actions that can be performed for the report.
1. Click on **PAGE SETUP** to set your printer and paper size and orientation.
2. Click on **PREVIEW** to preview the output. Do not send the report to the printer from this preview window, it will only send the first page to the printer.
3. To change fonts, column sizes etc., click **CUSTOMIZE**. The report will be displayed in 4D View, Roll Call’s spreadsheet program. Make your modifications here.
4. Click on **PRINT** to send the report to the printer.
5. Click **ZOOM IN** to make the font in the report larger on your screen.
6. Click **ZOOM OUT** to make the report font smaller on your screen.
7. To save the report as a tab delimited file or html document, click SAVE. Enter the location and name of the file to be saved.
8. Click SAVE SET to save the list of people for use later within Roll Call.

**Giving by Fund by Week, Month or Year**

The Giving by Fund by Week report summarizes all giving for the fund by week, month or year for a given time period in a spreadsheet format. The weeks, months or years are listed across the top.

To run this report:
1. Expand the Contributions menu.
2. Click on Reports.
3. Click Fund Giving on the left sidebar.
4. Click on the Criteria tab. From the criteria tab, select the date range that you wish for this report.
5. Next, select the Report Type: by Week, by Month or by Year.
6. Then under the Who tab, select the donors you wish to see on the report. Do you wish to see all donors, or certain associations or certain groups, etc.? Once you’ve chosen who, click on the What tab. From here, select the funds you are interested in including on this report.
7. Click on the Columns tab. Choose the columns you wish to view on the report. There are default fields already set up for this report, but you can drag additional fields from the left side to the Selected column. You can rearrange the ordering in the Selected column by dragging and dropping in the order you wish to see them in the report.
8. If you’d like to change the sort order, move the columns from the Selected column to the “Sort” column.
9. Click GENERATE.

As an example, lets say we’d like a Fund Giving by Month report for all donors and we want to include giving from Members and Regular Attenders.

1. Highlight Fund Giving on the left sidebar.
2. From the Criteria tab, select “This Year” from the date range drop down.
3. Select “by Month” as the Report Type.
4. Click on the Who tab and choose “Associations” as the Run for criteria. Click over Members
and Regular Attenders to the Selected column.
5. Mark the box for Combine Families if you want contributions from families lumped together.
6. Click on the What tab. Click the double arrow to move all funds to the Selected column.
7. Mark the box to include non-cash gifts if you want to include property gift amounts in the report as well.

8. Click GENERNATE to produce the report.

On the right side of the Report Output Window are actions that can be performed for the report.
1. Click on PAGE SETUP to set your printer and paper size and orientation.
2. Click on PREVIEW to preview the output. Do not send the report to the printer from this preview window, it will only send the first page to the printer.
3. To change fonts, column sizes etc., click CUSTOMIZE. The report will be displayed in 4D View, Roll Call’s spreadsheet program. Make your modifications here.
4. Click on PRINT to send the report to the printer.
5. Click ZOOM IN to make the font in the report larger on your screen.
6. Click ZOOM OUT to make the report font smaller on your screen.
7. To save the report as a tab delimited file or html document, click SAVE. Enter the location and name of the file to be saved.
8. Click SAVE SET to save the list of people for use later within Roll Call.
9. Click EMAIL to email this report to someone.

**Contribution Detail**

The Contribution Detail report outlines all contributions for a given time period, for the funds you are interested in, for the donors you select. To run the Contribution Detail report:
1. Expand the Contributions menu.
2. Click on Reports.
3. Click Contribution Detail on the left sidebar.
4. Click on the Criteria tab. From the criteria tab, select the date range that you wish for this report.
5. Then under the Who tab, select the donors you wish to include in the report. Once you’ve chose who, click on the What tab. From here, select the funds you are interested in including on this report.
6. Click on the Columns tab. Choose the columns you wish to view on the report. There are default fields already set up for this report, but you can drag additional fields from the left side to the Selected column. You can rearrange the ordering in the Selected column by dragging and dropping in the order you wish to see them in the report.
7. If you’d like to change the sort order, move the columns from the Selected column to the “Sort” column.
8. Click GENERATE.

In this example, lets say we’d like a donor report for all donors (we don’t care what their association is) and we want to know all of their contributions for all funds. On this report we want to see donor name, email address, contribution date and amount.

1. Highlight Contribution Detail on the left sidebar.
2. From the Criteria tab, select “This Week” from the date range drop down.
3. Click on the Who tab. Leave “Everyone” selected.
4. Click on the What tab. Click the double arrow to move all funds to the Selected column.
5. Mark the box to include non-cash gifts if you want to include property gift amounts in the report as well.

6. Click on the Columns tab. Drag the fields from the left side column to the Selected column on the report.
7. Click GENERNATE to produce the report.

On the right side of the Report Output Window are actions that can be performed for the report.
1. Click on PAGE SETUP to set your printer and paper size and orientation.
2. Click on PREVIEW to preview the output. Do not send the report to the printer from this preview window, it will only send the first page to the printer.
3. To change fonts, column sizes etc., click CUSTOMIZE. The report will be displayed in 4D View, Roll Call’s spreadsheet program. Make your modifications here.
4. Click on PRINT to send the report to the printer.
5. Click ZOOM IN to make the font in the report larger on your screen.
6. Click ZOOM OUT to make the report font smaller on your screen.
7. To save the report as a tab delimited file or html document, click SAVE. Enter the location and name of the file to be saved.
8. Click SAVE SET to save the list of people for use later within Roll Call.

**Contribution Statistics**

The Contribution Statistics report breaks down contributions by age range, association and zip code, marital status and giving range. This file also outlines the number of givers by range of giving. To run the Contribution Statistics report:

1. Expand the Contributions menu.
2. Click on Reports.
3. Click Contribution Statistics on the left sidebar.
4. Click on the Criteria tab. From the criteria tab, select the date range that you wish for this report.
5. Then under the Who tab, select the donors you wish to include in the report. Once you’ve chose who, click on the What tab. From here, select the funds you are interested in including on this report.
6. Click GENERATE.

In this example, let’s run the statistics for all donors for this year and let’s consider all funds.

1. Highlight Contribution Statistics on the left sidebar.
2. From the Criteria tab, select “This Year” from the date range drop down.
3. Click on the Who tab. Leave “Everyone” selected.

4. Click on the What tab. Click the double arrow to move all funds to the Selected column.
5. Click GENERATE to produce the report.

On the right side of the Report Output Window are actions that can be performed for the report.

1. Click on PAGE SETUP to set your printer and paper size and orientation.
2. Click on PREVIEW to preview the output. Do not send the report to the printer from this preview window, it will only send the first page to the printer.
3. To change fonts, column sizes etc., click CUSTOMIZE. The report will be displayed in 4D View, Roll Call’s spreadsheet program. Make your modifications here.
4. Click on PRINT to send the report to the printer.
5. Click ZOOM IN to make the font in the report larger on your screen.
6. Click ZOOM OUT to make the report font smaller on your screen.
Choose the funds that should be considered in the calculations.

Breakdown of contributions by different demographics.

7. To save the report as a tab delimited file or html document, click SAVE. Enter the location and name of the file to be saved.

8. Click SAVE SET to save the list of people for use later within Roll Call.
MAINTAIN PLEDGES

To track pledges in Roll Call, you must first setup the pledge fund. The pledge fund can be a multi-year campaign, such as a building fund. Or, it can be a yearly tithe pledge. Once the pledge fund has been established, you can record the individual pledges.

**Pledge Fund**

A pledge fund must be for an account that is established in the chart of accounts. If the chart of accounts does not contain this fund designation, you’ll need to set that up first. See “Getting Started” for more details.

1. Expand the Pledge menu.
2. Click on Add a Campaign.

First, use the drop down box to select either the **Fund Name** OR **Account Number**.
If you selected a fund name, the associated account number will be returned. If you selected the account number, the fund name will be returned.

Next, enter the **Start Date** and **End Date**. Please note, that once a pledge fund has been created, the start date may not be changed.

If you have a target goal for this pledge drive, you may enter the **Fund Goal** in this field. The pledge progress summaries will use this amount to calculate the percentage of goal reached. The **Fund Type** is a free format field you can use to describe the pledge fund.

Click SAVE & CLOSE to save the information. Click SAVE & NEW to enter another pledge fund.

**Individual Pledges**

To begin adding individual promises or pledges, click on the plus sign in the lower left of the pledge fund window.

First, enter the **Last Name** or a portion of the last name and tab out of the field. A list of people with that last name will be displayed. Double click on the individual who is making the pledge. If a married couple is making a pledge together, enter the pledge...
under the head of families record. If the husband and wife are making separate pledges, enter the husband’s pledge. Then enter a pledge for the wife.

Note the Start and End Dates from the pledge fund will be entered as the defaults for this pledge. These dates may be changed. For example, if you have an existing building fund that runs three years, you may have people that pledge to that fund in the middle of the campaign. Simply change the individual start date on their pledge record.

Next, use the drop down box to select the applicable Payment Period. Will they be paying on a weekly, monthly, or annual basis?

Next you can enter the Total Amount of their pledge (the amount they will pay over the course of the entire pledge period) in the Pledge Amount field. Once you’ve entered this amount, the Each Payment amount (on the right side of the screen) will be calculated. Or, you can enter the Each Payment amount and the Pledge Amount will be calculated.

If you wish progress against this pledge to be printed on the donation receipt, click “Yes” for Report on Rcpt. The Date Completed, Pledge Id and Pledge Fund Id fields are determined by Roll Call and may not be modified.

To save the information you’ve entered and enter another pledge, press SAVE & NEW. To save the information and return to the pledge summary window click SAVE & CLOSE. To leave the screen without saving the information click on CANCEL. To save the information you’ve entered, press OK.

**Finding Pledges**

You can search for pledges based on fund name or by donor name. To find a pledge based on the fund, do the following:

1. Expand the Pledge menu.
2. Click on Search by Fund.
3. Enter the fund name.
4. Double click on the specific fund.
5. Scroll through the list of pledgers and double click on the specific pledge you are interested in.

To find a pledge based on person information, do the following:
1. Expand the Pledge menu
2. Click on Search by Person.
3. Use the Find By drop down box to select your criteria.
4. Enter the value you are looking for.
5. Scroll through the list of pledgers and double click on the specific pledge you are interested in.

Modify Pledge Information

Changing the pledge information

The only changes that are allowed to the pledge fund are to the *Start Date*, *End Date*, *Fund Goal* and *Fund Type*. If you would like to modify this information, select Search by Fund under the Pledge menu. Double click on the fund you are interested in changing.

To change individual pledge information, use the Search by Fund or Search by Person to find the specific pledge. Double click on the pledge. Make the necessary changes.
Deleting a pledge fund
If you would like to delete a pledge fund, click the Search by Fund menu item. Highlight the fund you’d like to delete, then click the minus sign in the lower left of the window. All pledge funds highlighted will be deleted.

Double click on the specific pledge you need to update.

Make necessary changes to this pledge.

Highlight pledge campaign you’d like to delete, then press the minus sign.
Deleting pledges
If you would like to delete a pledge, click the Search by Fund menu item. Double click on the specific pledge fund. From the lower section, highlight the pledge or pledges that need to be deleted. Click the minus sign in the lower left of the window.

![Image of pledge deletion process]

Highlight the specific pledge you’d like to delete. Then click the minus sign.

Pledge Progress Letter
The pledge progress letter can be used to let folks know how they are doing against their pledges. The letter can be printed or emailed to pledgers who gave during the period or all pledgers regardless of their giving.

To create Progress Letter, do the following:
1. Expand the Pledges menu.
2. Click on the Pledge Progress Letter menu item. The Progress Letter window will be displayed.

Criteria
From the criteria tab, you can choose the type of pledge campaign that you’d like to print the letters for.

Enter the following information:
1. Pledge Fund - Choose the pledge campaign you’ll be running the letters for.
2. Show on Letter – Choose the information you’d like on the letter.
   a. Choose Summary and all details to display a summary of giving plus a listing of all contributions.
   b. Choose Summary and period details to list only those contributions within the reporting period.
   c. Choose Summary Only to exclude the details.
3. Starting Period – Enter the starting date of the report period you’d like the letter for.
4. Ending Period – Enter the ending date for the report period for the letter.
Select fund and reporting period.

Choose who should receive a letter and what information should be included.

Notice the tabs across the middle of the criteria page. On the Details tab enter the following information:

5. **People to Include** - choose the folks who should get a letter.
   a. *All pledgers for campaign* – each person who made a pledge will receive a letter regardless of contributions during the period.
   b. *Gave in Period* – only create a letter for those pledgers who gave during the reporting period.
   c. *Didn’t give in period but have given* – creates a letter for anyone who has pledged and given.
   d. *Haven’t given* – creates a letter for the folks who have pledged but have not given at all.

6. **Summary Details** – Choose the information to display in the summary section.
   a. *Pledge Total* – this is the total amount of their pledge or promise.
   b. *Recvd to Date* – the total amount that has been contributed thus far.
   c. *Recvd this Period* – the amount that was contributed during the report period.
   d. *Pledge Start* – the starting date of the pledge.
   e. *Pledge End* – if you’d like the receipt to only have a grand total or if you’d like it to display summary information by fund. You may also choose to display each individual gift.
   f. *Frequency* – indicates if the pledge was weekly, monthly, one-time.

From the tabs across the middle of the criteria page, click on Print Options to make the following selections:

1. **Single Print Job** – under the print options section, mark this box if you want Roll Call to create 1 large print job for the quarterly receipts. If you will be duplexing the print job (printing on both sides of the paper) you do not want to create a single print job. If you are emailing receipts you do not want to create a single print job. If you are using a large copier printer that requires a project code, you would want to check this box.

2. **Cover Letter** – if you’d like to print a cover letter before each statement, mark this box. Use the text tab to create your cover letter.

3. **Print on Stationary** - mark this box if you will be printing the statements on letterhead. By checking this box, the churches return address will not be printed on the statement. The statement will begin about 2 1/2 inches down the page.

4. **Use Org Letterhead** – if you would like to pull in your letterhead graphic to print
directly on the receipt, mark this box.
5. First Page Only - if you will only be using stationary for the first page of the receipt, mark this box.
6. Show Envelope Number – if you would like the envelope number printed on the statement, mark this box.
7. Sorted By – choose the sort order of the print job. Do you want the receipts sorted by zip code or by name.
8. Exclude – to exclude receipts for folks who have an address marked as “bad” or “do not send” mark this box.

From Print Options tab, choose how you’d like to print the letter.

From the tabs across the middle of the criteria page, click on Customize to change the font and alignment.
1. Top Margin – the number of centimeters required for the top margin.
2. Organization Name – the number of lines down that the organization name starts.
3. Address starts on line# - the number of lines down that the donor’s address starts.
4. Body starts on line# - the number of lines down that the body of the receipt starts.

To modify what line the sections are printed on, change settings on Customize tab.
5. **Customize Font** – mark this box if you’d like to change the font and size for the receipt. This may take some trial and error to make sure the summary section columns fit on the receipt.

6. **Font** – choose the font you’d like to use for the body of the receipt.

7. **Size** – choose the size of the font you’d like to use for the body of the receipt.

**Text**

There are several different types of “text” that can be used to customize your receipt. They are as follows:

1. **Top Text** – The top text area is used as a thank you note at the beginning of the statement. If you have a verse or a paragraph that you’d like printed at the beginning of the statement, use the top text area. If you have large thank you note, we recommend you use the cover letter section.

2. **Cover Letter** – The cover letter is a 1 page letter that will be printed before each statement.

3. **Bottom Text** – The bottom text area is used as footer text. It typically indicates no goods or services were received.

4. **Org Letterhead** – if you’d like to pull in your letterhead graphic so that the stationary and receipt are all printed at once, use this section.

To enter the text you’d like displayed on the statement, do the following:

1. Click on the Receipt Text tab.
2. Click on the type of text you’d like to enter.
3. Enter the text and format it as appropriate.

**View People**

The view people tab is used to review the list of people that will be getting a letter. If you’d like to print a letter for all these people, click PRINT LETTER. If you only want to print them for several of the people in the list, highlight the people that you want, then click PRINT LETTER. It will only print statements for those people that were highlighted.

**Printing/emailing your letter**

Once you have set up your criteria, reviewed the list of people and set up your text areas, click on PRINT LETTER. The statements will be printed for everyone in the view people
tab that does not have Email checked. If you want to print a receipt for everyone in the list regardless of the Email status, simply highlight all the people, then click PRINT LETTER.

If you’d like to email the statements, click EMAIL LETTER. You will be given the choice to simply create a pdf for each statement, or to create pdf and send email. The receipts will be emailed to everyone in the list that has Email checked. If you want to override the Email status, highlight everyone you’d like to email a statement, then click EMAIL LETTER.

Pledge Reports
There are various reports that can be run for pledges. They are all run in the same manner. The process is as follows:
1. Expand the Pledge menu.
2. Click on Pledge Reports.
3. The Pledge report window is displayed. The reports are listed on the left side.
4. Click on the report you wish to run.
5. Complete the criteria section on the right.
6. Click GENERATE.

Criteria section
Once you select your report, the criteria section of the report window will change. For the majority of the reports, you’ll need to select a date range and which funds you wish to report on. When you click GENERATE you’ll be taken to the Pledge Report Output Window.

Output window
The report will be displayed on the left side of the window. If all the results don’t fit in this window you can use the scroll bars to move up & down or left to right. There are a standard set of buttons on the right side of the window. These are as follows:
1. PAGE SETUP – this button allows you to choose the paper size and orientation of the page for your printed report.
2. PREVIEW – This button will allow you to preview your printed report.
3. PRINT – click this button to send your report to the printer.
4. CUSTOMIZE – the customize button puts the report in the Roll Call spreadsheet program. From here, you can save the report to a text file, change fonts, change columns widths, change column headers, etc.
5. ZOOM IN – to view the report in a larger font, click Zoom In.
6. ZOOM OUT – to view the report in a smaller font, click Zoom Out.
7. SAVE REPORT – this allows you to save the report spreadsheet.
8. SAVE SET – allows you to save this set of people to use in a different part of the program.
9. CREATE LABELS – this allows you to print address labels for the folks listed in your report.
10. WRITE LETTER – this allows you to create a mail merge letter for the folks listed in your report.
11. EMAIL – the email option allows you to email all the people in your report OR to email the report to someone else.

Pledge Status report
The pledge status report lists the folks who have pledged to a specific fund and calculates how much they’ve pledged for a date range. The report lists the name, how much they pledged for a period and how much they gave for the same period.
To run the report:
1. Expand the Pledge menu.
2. Click on Reports.
3. Click on Pledge Status on the left side.
4. Select your date range.
5. Select the fund you wish to run this for.
6. Click GENERATE.

Pledge Comparison report
The pledge comparison, compares multiple pledge funds. For example if you wanted to compare how much folks pledged to the 2013, 2014 and 2015 campaigns, you could do that through this report.

To run the report:
1. Expand the Pledge menu.
2. Click on Reports.
3. Click on Pledge Comparison on the left side.
4. Select the funds you wish to list across the top.
5. Click GENERATE.

**Pledge Fund Comparison report**

The pledge fund comparison, lists the funds you select, the amounts pledged and the amounts received for each selected fund.

To run the report:
1. Expand the Pledge menu.
2. Click on Reports.
3. Click on Pledge Fund Comparison on the left side.
4. Select the funds you wish to list.
5. Click GENERATE.
Choose the pledge campaigns you’d like to compare.

Outlines amount pledged and received to the selected funds.

**Pledge Giving report**

The pledge giving report can list all folks who have given to a pledge fund regardless if they pledged or not.

To run the report:
1. Expand the Pledge menu.
2. Click on Reports.
3. Click on Pledge Giving on the left side.
4. Select the funds you wish to list across the top.
5. Choose the people you wish to include.
   a. Those that pledged and gave.
   b. Those that did not pledge but gave.
   c. All people who gave whether they pledged or not.
6. Click GENERATE.
Choose your pledge campaign, report period and who you'd like to include in the report.

This example lists all donors to a fund.
MANAGING GROUPS

Group Hierarchy

Groups are defined by the following classifications:

1. Campus. If your church has multiple campuses or locations with different groups and classes at each site, you may want to define your groups at the campus level. The campus indicates which site or location the group stems from.

2. Group Type. The next level in the hierarchy is group type. This tells us the general classification of the group. Is the group a committee, a small group, a Sunday school class or a youth group? Your church defines these group types or classifications. Roll Call’s default group types are Group and Class.

3. Department. The next level in the hierarchy is the department. The department is the ministry area within your church that is responsible for overseeing the group. Children’s Ministry, Congregational Care, Youth and Music are some common departments.

4. Status. The status indicates whether the group is active or inactive.

Every group that is defined in Roll Call must be assigned a Group Type, Department, Name and Status. Status always defaults to active.

Group Custom Fields

Group custom fields

You may want to define custom fields for groups. These fields allow you to customize the information you capture for your groups. You can set up default custom field titles per group type. For example, let’s say we have a “small group”, group type. For each small group we need to know an emergency contact, what they are studying, where they meet, and if they are accepting new members.

To create these group custom field titles:

1. Select RollCall>Preferences from the top menu if you are on a Mac OR select Edit>Preferences if you are on a Windows machine.

2. Click on the Group Custom on the left sidebar.

3. Select the Group Type, “small group” in the upper left drop down box.

Select Group Custom, then choose type. Enter field names.
Enter “Emergency Contact as Cstm 1.
5. Enter “Studying” as Cstm 2.
6. Enter “Meeting Location” as Cstm 3.
7. Enter “Accepting New Members” as Chk1.

Now each time you create a small group, there will be fields available to enter Emergency Contact, Studying, Meeting Location, and Accepting New Members. You can customize each group further by modifying the custom field titles for a specific group.

**Group membership custom fields**

Like group custom fields, you may want to define custom fields to track specific information for each member in a group.

You can set up default custom field titles per group type. For this example, let’s say we need to know certain information about the worship team members. We’d create a group type of “worship team”. For each of our worship team members we need to know what instrument they play, can they read music, what is their voice type and how many times per month are they available.

To create these group member custom field titles:
1. On a Mac Select RollCall>Preferences from the top menu. On a Windows machine, select Edit>Preferences from the top menu.
2. Click on the Member Custom on the left sidebar.
3. Select the Group Type, “worship team” in the upper left drop down box.
4. Enter “Instrument” as Cstm 1.
5. Enter “Voice Type” as Cstm 2.
7. Enter “Read Music” as Chk1.

Now each time you create a worship team group, there will be membership fields available to enter Instrument, Voice Type, Days Available, and Read Music. You can further customize each group by modifying the custom field titles for group members.
Add a Group

Enter general information
There are several options for getting to the Add a Group window:
1. Expand the Groups menu and click Add a Group OR
2. Expand the Groups menu and click Search. Click on the plus sign in the lower left to add a new group.

Once you are in the screen to add the group:
1. Enter the values for Campus (if applicable), Group Type, Department and Status.
2. Enter the Group Name.

3. If the group has a leader, enter the last name in the Leader field. Press tab to view a list of the folks with that last name. Select from the list.
4. If the group has a co-leader, enter the last name in the Co-Leader field. Press tab to view a list of the folks with that last name. Select from the list.

5. Select the Frequency to indicate if the group meets weekly or randomly.
6. The field “When does this meet?” is the information that is displayed in Roll Call Connect for when the group meets. PLEASE NOTE: This information is not used by the check in system. You need to enter sessions for child check in to work properly.
Enter general information about class.

7. Enter the **Location** of the group if applicable.
8. Enter the **Address** that will be displayed in Roll Call Connect for the meeting location.
9. The **Start Date** will default to today’s date. You may change it if you’d like.
10. Enter the **End Date** if you know the last day this group will meet. Keep in mind that on this date the system will change that group to inactive.

Click SAVE & CLOSE to save the information and return to the Search screen. Click SAVE & NEW to save the information and enter a new group.

**Add Members**

To enroll people into the group, press the Members tab. From within the members tab:

1. Click the plus sign in the lower left of the window. A new window will be displayed for you to enter the Last Name and First Name (or portion of the last name) of the person you want to enroll.
2. Select the appropriate person to enroll in the group.
3. Tab across to enter any of the custom field data for this person. If you need to define the membership custom field names, click CHANGE TITLES and enter the name of the data you’d like to capture.
Create sessions

Next, you’ll want to indicate which days and at what times the group meets. The meeting days and times are called sessions in Roll Call. A group that meets weekly can have an unlimited number of sessions. A group that meets randomly does not have any sessions defined.

To create a session:
1. Click on the session tab, if sessions are not currently displayed.
2. Click on the plus sign in the lower left. A row will be displayed, with a default of Sunday and time of 12 a.m.
3. Use the Day of Week drop down box to select the appropriate day.
4. Enter the Start Time.
5. Enter the End Time.
6. Place your cursor under Room and double click to enter the room number of this group meeting.

Enter values for group custom information

If you set up custom fields (under Preferences) for this group type, you can enter the data in the Custom (1) and Custom (2) tab. Let’s look at our previous example of a small group. We had set up custom fields to record emergency contact, studying, meeting location and accepting new members.

To enter the custom data for this group:
1. Press the Custom(1) tab. The fields on this tab are the text fields.
2. Enter values for each of the custom fields Emergency Contact, Studying and Meeting Location.
3. Press the Custom (2) tab. The fields on this tab are the check boxes and dates.
4. Check the box for Accepting New Members, if the answer is Yes.

If no custom fields are defined for this group type, you can define them for this specific group if you’d like. Click on the CHANGE TITLES button to enter the name of the data you’d like to capture. When you are done entering the titles, click CHANGE DATA to enter the actual data for that field.
Enter any custom information on this tab.

Preferences
Use the preferences tab in the group screen to set your attendance roster preferences, check in label preferences and grade/age range preferences.

Mark the following options for your Attendance Roster:
1. **Birth Date or Special Needs** - Choose which field you’d like displayed on the roster. You may only choose one.
2. **Show Year of Birth** – Mark this box if you choose to include birthday and you want to display the full birthdate.
3. **Show Age** – Mark this box if you’d like to display the child’s age.
4. **Show Family No.** – Mark this box if you’d like to show the group member’s family number.
5. **List Parents** – If you would like to display the parent’s names for the group member.

Make your selections for the attendance roster.
Enter the grade range or age range that is applicable for this group. This information will be used to recommend classes in the child check in system. It will also be used in the Graduation utility.

1. **From Age (Years & Months)** - Enter the beginning age that a child is allowed in this class/group.
2. **To Age (Years & Months)** – Enter the oldest age that a child is allowed in this class/group.
3. **From Grade** – Enter the beginning grade that a child is allowed in this class/group.
4. **To Grade** – Enter the last grade that a child is allowed in this class/group.

Enter label preferences for the check in system.

Enter grade OR age ranges for this class/group.

Enter the following check in system preferences for this specific class or group. **From Age (Years & Months)** - Enter the beginning age that a child is allowed in this class/group.

1. **Number of Labels** – Enter the number of nametags you’d like to print when a person checks into this group.
2. **Print Tag on Check Out** – Mark this box if you’d like to print a name tag when the child checks out of this class.

**Copy a Group**

There are two methods that can be used to copy groups.

1. Duplicate the Group. This makes an exact copy of the group. The system names the group “Group Name copy”. The copy will contain the same members, sessions and preferences.
2. Clone the Group. Cloning a group allows you to make multiple copies of a group at once and give them specific names. You can choose whether or not to copy members and sessions.

To duplicate a group, do the following:

1. Expand the Groups menu.
2. Highlight the group you wish to copy.
3. Right mouse click on the group.
4. Choose Duplicate.
Right mouse click on the group, then choose Duplicate.

To clone a group, do the following:

1. Expand the Groups menu.
2. Click on Search and find the group you wish to copy.
3. Double click on that group.
4. Select Clone from the Admin menu at the top.
5. Choose the information you wish to copy. Click NEXT.
6. Enter the new group names. Click FINISH.
Choose what information you’d like included in the cloned group.

Give each new group a name.

Click FINISH.

**Mass Enrollment**

To enroll multiple people into a group at once, expand the Groups menu, double click on the group you’d like to enroll folks into. Choose Mass Enrollment from the Utilities menu at the top.

**Select Association**

To limit the people in the list based on an association, click over each association you’d like in the list.
**Select Male or Female**
To limit the list of possible enrollees to a certain *Gender*, check the box for Male or Female. This can also be used in combination with *Age* range and association. For example, if you wanted only male members, you could check the box for male and click over the association Member.

**Enter an age range or grade range**
To limit the selection of possible enrollees based on age, enter an *Age* range. You can also use this option in combination with *Male/Female* and *Association*. So if you wanted to limit the list to boys ages 6 – 8, as example you could check male, and enter an age range of 6 – 8.

Press CONTINUE to get your list of potential enrollees. Mark the box to Select All if you want everyone in the list to be enrolled in the group. Or, highlight each person you want enrolled. To highlight multiple people, hold down the apple key on the Mac, or the shift key on Windows.

**Select using query editor**
If there is different criteria you’d like to use to determine potential enrollees, you can use the query editor to get that list. For this example let’s say we want a list of those people that live in a certain city. From this window, click the QUERY EDITOR button. The query editor will be displayed.

1. Change the *Query In* field to Address.
2. Select City from the *Field Name* drop down box.
3. Highlight “is equal to” in the *Comparison* box.
4. Enter the name of the city in the *Value* field.
5. Click on the QUERY button.

A list of people that live in that city will be displayed. Mark the box to Select All if you want everyone in the list to be enrolled in the group. Or, highlight each person you want enrolled. To highlight multiple people, hold down the apple key on the Mac, or the shift key on Windows.
From the list that is returned, highlight the folks you want to enroll in the group. Click ENROLL SELECTED.

Transfer members to a new group

To transfer members from one group to another, do the following:
1. Expand the Groups menu.
2. Click on Search.
3. Double click on the group you wish to transfer from.
4. Select the Administration menu at the top and then select Transfer.
5. On the right side, choose the group you wish to transfer to.
6. Click over each person from the left side to the right side to transfer them.

Mark your transfer option. Transfer to the new group moves from one group to the other. Enroll in new group/class keeps them in the original group and also enrolls them in the new group. Copy to new group with data will move them into the new group and also move the membership custom data.

Click OK to complete the transfer process.
Choose the class you want to transfer to. Click on each child you’d like to transfer.

Graduation

There are 3 different methods for graduating children from one class to the next:
1. Graduation Profile – This method works great for classes that are grade specific and only cover one grade. You can create a map of how the classes graduate, then click GRADUATE NOW.
2. Birthday Graduation – Use this method if the children should move up on their birthday.
3. Graduation Utility – This method works great if you have the grade included in the child’s profile. It also handles the situation where a class covers multiple grades, for example a class that includes 3rd through 5th graders.

Graduation Profile

If you have a series of classes that you need to graduate at the beginning or end of the school year, do the following:
To create this “pre-school” graduation profile, do the following:
1. Click on Graduation under the Groups menu.
2. Click on the plus sign to add a profile.
3. Select the Department and Group Type for your “School Age” classes.
4. Give this graduation profile a name. In this example, I’ll call it Grade School.
5. Click the plus sign in the lower left to set up the first graduation from Kdg to 1st grade. Select Kdg from the “from” box and 1st grade from the “to” box. Click SAVE & NEW or SAVE & CLOSE.
6. Continue this process until all your school age classes have been identified.

Select From Group or To Group.
When you are ready to actually do the graduation, do the following:
1. Expand the Groups menu.
2. Click on Graduation.
3. Double click on the profile you wish to graduate.
4. Click GRADUATE NOW.
5. A log will be displayed showing the graduation process.

On Birthday
There may be cases where you want a child to automatically move to the next class on their birthday. In this example let’s say we have a Nursery class for kids 0 – 2 years and a 3 year old class, and a 4 – 5 year old class. For these classes we want the child to graduate on their birthday.

To create this “pre-school” graduation profile, do the following:
1. Make sure you have the age ranges set in the Preferences tab of each group.
2. Next, click on Graduate under the Groups menu.
3. Click on the plus sign to add a profile.
4. Select the Department and Group Type for your “pre-school” classes.
5. Give this graduation profile a name. In this example, I’ll call it Pre-School.
6. Click the plus sign in the lower left to set up the first graduation from 0 - 2 to 3 year olds. Use the drop down to select the from class. Use the drop box to the right to pick the to class. Click SAVE & NEW or SAVE & CLOSE.
7. Continue this process until all your pre-school classes have been identified.
8. When you are back at the graduation profile window, click on the box to graduate on Birthday.

Graduation Utility
If you have the child’s grade in their profile information and you’ve set the grade range in the group’s preferences, you can use the graduation utility to move children when it is time to graduate. This utility will do two things:
1. It will change the grade in the child’s profile record. For example if the grade was set to 1, it will be changed to 2.
2. If the child is enrolled in a class that has the grade preferences set, it will move the child to the appropriate class. If the child was in the 1st grade class, they will be moved to the 2nd grade class.
To use the graduation utility, do the following:
1. Expand the Groups menu.
2. Click on the Utilities icon on the top bar.
3. Select Graduate by Grade.
4. The utility wizard will be presented.
5. Enter the date by which a child must turn 5 to be enrolled in Kindergarten.
6. Click NEXT through the steps.
7. A log will be displayed outlining the results of this process.

**Modify Group Information**

To modify any of the information about a group, change sessions, add or delete people from a group, do the following:
1. Expand the Groups menu.
2. Click on Search.
3. Double click on the appropriate group.
4. Make the necessary changes. To add or remove members, click on Members tab, use the plus or minus sign in lower part of window. To add or remove sessions, click on the Sessions tab, use the plus or minus sign in the lower part of the window.

**Delete Groups**

To delete a group, do the following:
1. Expand the Groups menu.
2. Click on Search menu item.
3. Highlight the group or groups you’d like to delete.
4. Click the minus sign. You’ll be asked if you want to make the groups inactive or completely delete them from the database.
REPORTING ON GROUPS

Attendance Summary

The attendance summary report gives head count information for group attendance information. This report can be run by day and it will list each group, the day they met, how many attended and how many visitors attended. The Attendance Summary can also be run by week, month or year. When running for this time frame, it will display the appropriate headcount.

To run the attendance summary report:
1. Expand the Groups menu.
2. Click on Reports.
3. Highlight Attendance Summary.
4. On the Groups tab, move all groups you are interested in to the Selected column.
5. On the Criteria tab, enter the date range for the attendance data you are interested in.

Click on a group name to move it to the Selected column to include it in the report.

On criteria tab, choose date range and report type.
6. Select “By Day”, “By Week”, “By Month” or “By Year” as the report type.
7. Click on the Columns tab to choose additional fields for the report.
8. Click GENERATE to run the report.
On the right side of the Report Output Window are actions that can be performed for the report.

1. Click on PAGE SETUP to set your printer and paper size and orientation.
2. Click on PREVIEW to preview the output. Do not send the report to the printer from this preview window, it will only send the first page to the printer.
3. To change fonts, column sizes etc., click CUSTOMIZE. The report will be displayed in 4D View, Roll Call’s spreadsheet program. Make your modifications here.
4. Click on PRINT to send the report to the printer.
5. Click ZOOM IN to make the font in the report larger on your screen.
6. Click ZOOM OUT to make the report font smaller on your screen.
7. Click EMAIL to email the report.
8. If you ran the report by week, month, or year you will see a GRAPH button. Click to view a bar chart of the attendance.
9. To save the report as a tab delimited file or html document, click SAVE. Enter the location and name of the file to be saved.

**Absent Present Report**

The absent/present report allows you to find folks who have been absent so many weeks or who have attended so many times in a certain time frame.

To run the Absent/Present report:
1. Expand the Groups menu.
2. Click on Reports.
3. Highlight Absent Present.
4. On the Groups tab, choose the groups you are interested in considering.
5. On the criteria tab, enter your absent present criteria. Enter how many weeks you wish to look back. Choose to find people who were absent or find people who were present. Enter how many times.
6. Next click on the Columns tab to choose the information you wish to include on the report. Double click on a column name from the left column to move it to the middle column.
7. Click GENERATE to run the report.
On the right side of the Report Output Window are actions that can be performed for the report.

1. Click on PAGE SETUP to set your printer and paper size and orientation.
2. Click on PREVIEW to preview the output. Do not send the report to the printer from this preview window, it will only send the first page to the printer.
3. To change fonts, column sizes etc., click CUSTOMIZE. The report will be displayed in 4D View, Roll Call’s spreadsheet program. Make your modifications here.
4. Click on PRINT to send the report to the printer.
5. Click ZOOM IN to make the font in the report larger on your screen.
6. Click ZOOM OUT to make the report font smaller on your screen.
7. To save the report as a tab delimited file or html document, click SAVE. Enter the location and name of the file to be saved.
8. Click SAVE SET to save the list of people for use later within Roll Call.
9. Click CREATE LABELS to create address labels (3 across 10 down size) for this list of people.
10. Click WRITE LETTER, to compose a mail merge letter to this list of people.
11. Click EMAIL to send an email to this list of people or to email the report to another individual. If you choose Email people, it will send the email to everyone listed in the report.

**Attendance by Group**

The attendance by group report displays weekly attendance data for the members in the selected groups. If you choose to do this across groups, it will list all the people in the groups selected and order by name. If you choose to run this within each group, it will order it by group, then list each member of that group.

To create the attendance by group report, do the following:
1. Expand the Groups menu.
2. Click on Reports.
3. Highlight Attendance by Group.
4. Click over the groups you wish to include in the report to the Selected column.
5. Click on the Criteria tab. Select the starting and ending date for the report.

6. Click on the Columns tab to add additional fields to the report.
7. Click GENERATE.

On the right side of the Report Output Window are actions that can be performed for the report.
1. Click on PAGE SETUP to set your printer and paper size and orientation.
2. Click on PREVIEW to preview the output. Do not send the report to the printer from this preview window, it will only send the first page to the printer.
3. To change fonts, column sizes etc., click CUSTOMIZE. The report will be displayed in 4D View, Roll Call’s spreadsheet program. Make your modifications here.
4. Click on PRINT to send the report to the printer.
5. Click ZOOM IN to make the font in the report larger on your screen.
6. Click ZOOM OUT to make the report font smaller on your screen.
7. To save the report as a tab delimited file or html document, click SAVE. Enter the location and name of the file to be saved.
Attendance by Group results.

8. Click SAVE SET to save the list of people for use later within Roll Call.
9. Click CREATE LABELS to create address labels (3 across 10 down size) for this list of people.
10. Click WRITE LETTER, to compose a mail merge letter to this list of people.
11. Click EMAIL to send an email to this list people or to email the report to another individual.
   If you choose Email people, it will send the email to everyone listed in the report.

**Attendance by Session**

This report lists the attendance information for each group by session for each week within the data range criteria. For each session the number of enrolled, the number of visitors, and the number present are listed.

To create the attendance by session report, do the following:
1. Expand the Groups menu.
2. Click on Reports.
3. Highlight Attendance by Session.
4. Click over to the Selected column the groups you wish to include in the report.

Click on a group name to move it to the Selected column to include it in the report.
5. Click on the Criteria tab. Select the starting and ending date for the report.
6. Click on the Columns tab to add additional fields to the report.
7. Click GENERATE

Enter the date range for attendance that should be displayed.

Double click a field name to move it to Selected column so it is included in report.

On the right side of the Report Output Window are actions that can be performed for the report.
1. Click on PAGE SETUP to set your printer and paper size and orientation.
2. Click on PREVIEW to preview the output. Do not send the report to the printer from this preview window, it will only send the first page to the printer.
3. To change fonts, column sizes etc., click CUSTOMIZE. The report will be displayed in 4D View, Roll Call’s spreadsheet program. Make your modifications here.
4. Click on PRINT to send the report to the printer.
5. Click ZOOM IN to make the font in the report larger on your screen.
6. Click ZOOM OUT to make the report font smaller on your screen.
7. To save the report as a tab delimited file or html document, click SAVE. Enter the location and name of the file to be saved.
This report outlines who attended each specific session.

8. Click EMAIL to email the report to someone else.

**Check in Roster**

The check in roster lists the students that have checked into a class, their parent’s names, allergy information and their birthdate. This report is typically run from the check in stations to give to the teachers once check in is complete. It can also be run from the Group Reports screen.

To create the check in roster, do the following:
1. Expand the Groups menu.
2. Click on Reports.
3. Highlight Check In Roster.
4. Click over to the Selected column the groups you wish to print a check in roster for.
5. Click on the Criteria tab. Select the date for the roster. Highlight the applicable sessions.
6. Click GENERATE to send the report to the printer.
Attendance Roster

The Attendance Roster displays the group members, an area to record attendance for up to 13 weeks or display 13 weeks of attendance history.

To create the attendance roster, do the following:
1. Expand the Groups menu.
2. Click on Reports.
3. Highlight Attendance Roster.
4. Click over to the Selected column the groups you wish to print a roster for.
5. Click on the Criteria tab. Select the starting date for the roster. Choose 13 weeks prior if you want to display attendance history. Choose 13 weeks after if you want blank columns to record attendance.
6. Click GENERATE to send the report to the printer.
Choose date and 13 wks prior or after for the roster.

Example of Attendance Roster showing 13 wks after a specified date.

**Sign-In Roster**

The sign in roster can be used for parents or teachers to check students into a class. It contains the times that the class meets, the name of the students, parents name, allergy information and a custom field.

To create the sign in roster, do the following:
1. Expand the Groups menu.
2. Click on Reports.
3. Highlight Sign in Roster.
4. Click over to the Selected column the groups you wish to print a roster for.
5. Click on the Criteria tab. Select the Date of the group meeting and whether or not to Include Leaders. You may also indicate if you’d like to print a roster for all groups that are scheduled to meet on that day.

6. Next choose which fields will be displayed on the roster. Check the box next to Bar Codes, Family Number, Custom field and Special Needs if you’d like that column included in the report. The Custom field will be a blank column with a title that you define. The Special Needs column will print the special needs data from Roll Call. You may enter a different title for that column.

7. Finally select the Group Notes or enter a Custom Title for the roster. You may also enter a Custom Footer for the report. Use the Blank Lines option to print user defined number of blank lines for visitors.

8. Click GENERATE to send the roster to the printer.
Check In Log

This report shows check in activity for specified groups. It will list the people who checked in, the time they checked in and the time they checked out. If they checked in and out multiple times, this will be displayed as well.

To create the check in log, do the following:
1. Expand the Groups menu.
2. Click on Reports.
3. Highlight Check In Log.
4. Click over to the Selected column the groups you wish to include in the report.
5. Click on the Criteria tab. Select the starting and ending date for the report.
6. Click on the Columns tab to add additional fields to the report.
7. Click GENERATE.
On the criteria tab, choose the date range for the report.

Double click on a field name to include it in the report.

On the right side of the Report Output Window are actions that can be performed for the report.

1. Click on PAGE SETUP to set your printer and paper size and orientation.
2. Click on PREVIEW to preview the output. Do not send the report to the printer from this preview window, it will only send the first page to the printer.
3. To change fonts, column sizes etc., click CUSTOMIZE. The report will be displayed in 4D View, Roll Call’s spreadsheet program. Make your modifications here.
4. Click on PRINT to send the report to the printer.
5. Click ZOOM IN to make the font in the report larger on your screen.
6. Click ZOOM OUT to make the report font smaller on your screen.
7. To save the report as a tab delimited file or html document, click SAVE. Enter the location and name of the file to be saved.
8. Click SAVE SET to save the list of people for use later within Roll Call.
9. Click CREATE LABELS to create address labels (3 across 10 down size) for this list of people.
10. Click WRITE LETTER, to compose a mail merge letter to this list of people.
11. Click EMAIL to send an email to this list of people or to email the report to another individual. If you choose Email people, it will send the email to everyone listed in the report.

**Group Members**

This report lists the members for each of the groups selected. It contains the members name, and address information.

To create the attendance roster, do the following:
1. Expand the Groups menu.
2. Click on Reports.
3. Highlight Attendance by Session.
4. Click over the groups you wish to include in the report.
5. Click on the Criteria tab. Select which members to include “active” or “all”. If you choose to print across groups, you’ll get a list of individuals in those classes. If you choose to print within each group, the list will be sorted and separated by group.

6. Click on the Columns tab to add additional fields to the report.

On the criteria tab, choose the type of members to include.

Double click on a field name to move it to the selected column.

7. Click GENERATE.

On the right side of the Report Output Window are actions that can be performed for the report.

1. Click on PAGE SETUP to set your printer and paper size and orientation.

2. Click on PREVIEW to preview the output. Do not send the report to the printer from this preview window, it will only send the first page to the printer.

3. To change fonts, column sizes etc., click CUSTOMIZE. The report will be displayed in 4D View, Roll Call’s spreadsheet program. Make your modifications here.

4. Click on PRINT to send the report to the printer.

5. Click ZOOM IN to make the font in the report larger on your screen.
6. Click ZOOM OUT to make the report font smaller on your screen.
7. To save the report as a tab delimited file or html document, click SAVE. Enter the location and name of the file to be saved.
8. Click SAVE SET to save the list of people for use later within Roll Call.
9. Click CREATE LABELS to create address labels (3 across 10 down size) for this list of people.
10. Click WRITE LETTER, to compose a mail merge letter to this list of people.
11. Click EMAIL to send an email to this list of people or to email the report to another individual. If you choose Email people, it will send the email to everyone listed in the report.

Background Checks

You may be wondering if it’s worth the time to enter your background check reports into Roll Call. It is if you’d like to quickly determine who has a current check, who is missing a check or who has an outdated or obsolete background check. These questions are easily answered with some of the queries or standard reports available in Roll Call.

Find Missing

To find those volunteers who are missing a background check, you will need to have those volunteers in one or more groups. To find the “missing” checks, do the following:

1. Expand the Groups menu.
2. Click on Reports.
3. Click on Background Checks for Groups.
4. On the Groups tab, click on each group that represents your volunteers that should have a background check.
5. On the Criteria tab, in the missing section, click on the types of reports you are interested in.
6. Click GENERATE to run the report.
7. The report will list all the volunteers in those groups and indicate if the report is missing.
Select the volunteer groups that you'd like to check for missing background checks.

Choose the type of missing reports.

List of folks that have a missing background check.
Find Obsolete
To find those volunteers that have an obsolete background check, you will need to have those volunteers in one or more groups. To find the “obsolete” checks, do the following:

1. Expand the Groups menu.
2. Click on Reports.
3. Click on Background Checks for Groups.
4. On the Groups tab, click on each group that represents your volunteers that should have a background check.
5. On the Criteria tab, in the obsolete section, click on the types of reports you are interested in.
6. Enter the “older than” date. This will tell the system what is considered obsolete.
7. Click GENERATE to run the report.
8. The report will list all the volunteers in those groups and indicate if the report is obsolete.
Duplicate Class Enrollment

The duplicate class report will outline any folks who are enrolled or members of more than one class. The only groups that are considered when running this report are of the type class. This report can be very helpful to find children who were inadvertently enrolled in more than one Sunday school class.

1. Expand the Groups menu.
2. Click on Reports.
3. Click on Duplicate Class Enrollment
4. On the Groups tab, click on each group you would like to analyze. However, only groups that are of the type “class” will be considered.

5. On the Columns tab, choose any additional information you’d like to include in the report. Double click on a field name to move it to the Selected column for inclusion in the report.
6. Click GENERATE to run the report.
Lists all members that are in multiple classes.

On the right side of the Report Output Window are actions that can be performed for the report.
1. Click on PAGE SETUP to set your printer and paper size and orientation.
2. Click on PREVIEW to preview the output. Do not send the report to the printer from this preview window, it will only send the first page to the printer.
3. To change fonts, column sizes etc., click CUSTOMIZE. The report will be displayed in 4D View, Roll Call’s spreadsheet program. Make your modifications here.
4. Click on PRINT to send the report to the printer.
5. Click ZOOM IN to make the font in the report larger on your screen.
6. Click ZOOM OUT to make the report font smaller on your screen.
7. To save the report as a tab delimited file or html document, click SAVE. Enter the location and name of the file to be saved.
8. Click SAVE SET to save the list of people for use later within Roll Call.
9. Click CREATE LABELS to create address labels (3 across 10 down size) for this list of people.
10. Click WRITE LETTER, to compose a mail merge letter to this list of people.
11. Click EMAIL to send an email to this list people or to email the report to another individual. If you choose Email people, it will send the email to everyone listed in the report.

**Group Involvement**

The Group Involvement report will show in a tabular format who is a member of the selected groups. The group names will be column headings. To run the report:
1. Expand the Groups menu.
2. Click on Reports.
3. Highlight Group Involvement.
4. Click over to the Selected column the groups you wish to include in the report.
5. Click on the Columns tab to add additional fields to the report.
6. Click GENERATE.
On the right side of the Report Output Window are actions that can be performed for the report.

1. Click on PAGE SETUP to set your printer and paper size and orientation.
2. Click on PREVIEW to preview the output. Do not send the report to the printer from this preview window, it will only send the first page to the printer.
3. To change fonts, column sizes etc., click CUSTOMIZE. The report will be displayed in 4D View, Roll Call’s spreadsheet program. Make your modifications here.
4. Click on PRINT to send the report to the printer.
5. Click ZOOM IN to make the font in the report larger on your screen.
6. Click ZOOM OUT to make the report font smaller on your screen.
7. To save the report as a tab delimited file or html document, click SAVE. Enter the location and name of the file to be saved.
8. Click SAVE SET to save the list of people for use later within Roll Call.
9. Click CREATE LABELS to create address labels (3 across 10 down size) for this list of people.
10. Click WRITE LETTER, to compose a mail merge letter to this list of people.
11. Click EMAIL to send an email to this list of people or to email the report to another individual. If you choose Email people, it will send the email to everyone listed in the report.
USING THE QUERY EDITOR

Query Editor uses
The query editor is used to produce lists of records that have common characteristics.
Some examples are:
• A list of all the members.
• A list of the people who visited last Sunday.
• A list of the groups that meet on Wednesday night.
• A list of donations given between two dates.

Table Layouts
Before using the query editor it is helpful to understand how information is stored in
Roll Call. Roll Call is based on the relational database 4D. The information is stored in
tables. Each table contains information about a “thing”. For example: people, addresses,
donations, groups and group members. Each table then is related to each other. For
example, each donation must be for a person.

Address
The address table contains the family specific information. Some of the fields in the
address table are: Family number, Family email address, Address 1, Address 2, City, State,
Zip, Area Code 1, Phone 1, Area Code 2, Phone 2, Alternate Address, Shepherd Area and
Wedding Date.

People
The people table contains the individual’s information. Some of the fields in the people
table are: Family ID, Title, First Name, Nick Name, Middle Name, Last Name, Gender,
Birthday, Age, Association, email address and envelope number. The individual’s
“standard” (work, fax, pager and cell) phone numbers are stored in this table. The values
for the custom fields that were defined by your church are stored in the people table.
Summary donation information is stored in the people table.

Contributions
The contributions table contains the high level information about a donations. Some of
the fields in the contributions table are: Person who gave the donation, the donation date,
the donation amount, the type of donation, the check number, property gift information
and quid pro quo donation amount.

Designation
The designation table indicates which fund the donation was assigned to. If the donation
was split into multiple funds, there will be multiple designation records for that donation.
The designation fields are: the ID of the related donation record, the fund designation, the
amount given to that fund, and the pledge ID if the designation was for a pledge fund.

Non-Cast Gift
The non-cash gift table indicates what was given, the donor, and the amount it was sold
for.

Recurring Donation
Recurring donations contain information about regularly scheduled donations. It contains
the donor, amount to be donated, and the frequency.
Pledge
The pledge table contains the information about an individual’s pledges. The fields are the ID of the person who made the pledge, the fund that the pledge was made to, the amount of the pledge, and the start and end date of the pledge.

Groups
The group table contains the high level information about a group. The fields are the group type, the department, group name, the campus (if multi-campus is turned on), and the leader of the group. There are also custom group titles and values stored in this table.

Group Members
The group members table indicates which people are enrolled in a group. The fields include group name, the person’s ID and the custom fields defined by your church.

Sessions
The sessions table contains the day of the week and the times that a group meets.

Attendance Summary
The meetings table contains an attendance summary for a group or service for a date.

Attendance
The attendance table contains the specific attendance information for a group or service. Who attended, on what day, and what time.

Sets
A set is a grouping of records. Each time you execute a query a set of records displayed. Once you have the list or “set” you may save it.

To save a set, press the SAVE SET button. A file dialog box will be displayed allowing you to choose the location and to name the file. After you’ve entered this information press SAVE.

Now this set can be used for multiple tasks. For example, let’s say you are creating a merge letter to people that have donated to a certain fund. You need to give the pastor a list of those people, you need to create the merge letter and you need to create labels for that group of people. Those are 3 different tasks, but all with the same “set” of people.
You could do the query once, save the set, then re-use the set for each of the tasks.
PLEASE NOTE: the set is only a snapshot of who has given to a fund at that particular time. The set does not change as more people give to that fund.

To call up the “set”, you may use the GET SET button any time you are at a query editor window with the same Find Records In table name. You may also click on the GET SET icon from the Summary screen. If your set was for people records then the Find Records In must also be for people. If the set you saved was Donation records, the Find Records In must be for Donations.

Current selection
Roll Call stores the results of the last query performed in memory. You can always recall those results by clicking the CURRENT SELECTION button from the query editor.

For this example, let’s say you did a query then accidentally clicked on the CANCEL button from the results screen. You could go back to the query editor and press the CURRENT SELECTION button to retrieve your results.

Basic Query
To query you’ll need to fill in the following information:
1. The table you’ll be querying from. For example, if the criteria is the City, you’ll be querying from the Address table. Enter this in the Query In portion of the query editor.
2. The field name. In that same example, if the criteria is City, you’ll need to select City from the Field Name drop down box.
3. The comparison. In this example the comparison would be “is equal to”. Highlight that in the Comparison box.
4. The value. Enter the name of the city you are interested in, in the Value field.
5. Press the QUERY button. A list of all the people who live in that city will be returned.
Multiple criteria query

Let’s say you want to know all the people that are over 30 years old that are members. We’ll have two lines in this query.

1. Under the People menu, click on Search Profiles. Click SEARCH icon.
2. Enter Address as the Query In table.
3. Select “City” from the Field Name drop down box.
4. Highlight “is equal to” in the Comparison box.
5. Select Chicago” as the Value.
6. Press the ADD LINE button.
7. Select People from the Query In table.
8. Select “Gender” from the Field Name drop down box.
9. Highlight “is equal to” from the Comparison box.
10. Enter Female as the Value.
11. Press QUERY. A list of women from Chicago will be displayed.
Associations query
Let’s say you want to know all the people that are Members or Regular Attenders. In this example, we’ll need to use the Associations tab of the query editor.

1. Under the People menu, click on Search Profiles. Click SEARCH icon.
2. Click on the Associations tab.
3. Click on each Association you want to include in the query.
4. Press QUERY to execute the query.

Groups query
Let’s say you want to know all the people that are in the Children’s Department classes. In this example, we’ll need to use the Associations tab of the query editor.

1. Under the People menu, click on Search Profiles. Click SEARCH icon.
2. Click on the Groups tab.
3. Click on each Group/Class you want to include in the query.
4. Press QUERY to execute the query.
An either/or criteria
In this example, let’s say we need a list of all the people who live in a certain city OR they are assigned to a specific shepherd area.

1. Under the People menu, click on Search Profiles. Click SEARCH icon.
2. Enter “Address” as the Query In table. (both city and shepherd area are stored in the address table)
3. Select “City” from the Field Name drop down box.
4. Highlight “is equal to” in the Comparison box.
5. Enter “Evergreen” as the Value.
6. Press the ADD LINE button.
7. Press the OR button. Notice the AND is changed to OR on the second line.
8. Select “Shepherd Area” from the Field Name drop down box.
9. Highlight “is equal to” from the Comparison box.
10. Select “Aram’s” as the Value.
11. Press QUERY. A list of people who live in Evergreen OR are in Aram’s shepherd area is displayed.

Date range criteria
For this example, let’s create a query that gives us a list of people who have given a donation between January 1, 2014 and July 31, 2014.

1. Under the People menu, click on Search Profiles. Click SEARCH icon.
2. Enter “Contribtuion” as the Query In table. (donation date is stored in the Contributions table)
3. Select “Donation Date” from the Field Name drop down box.
4. Highlight “is greater than or equal to” in the Comparison box.
5. Enter 1/1/14 as the Value.
6. Press the ADD LINE button.
7. Select “Donation Date” again from the Field Name drop down box.
8. Highlight “is less than or equal to” from the Comparison box.
9. Enter 7/31/14 as the Value.
10. Press QUERY. A list of people who gave between 1/1/14 and 7/31/14 is displayed.
A partial name criteria
In this example we’ll use a wildcard character. The wildcard in Roll Call is the @ symbol. Let’s say we want to find all the people whose first name begins with KIM.

1. Under the People menu, click on Search Profiles. Click SEARCH icon.
2. Enter “People” as the Query In table. (first name is stored in the People table)
3. Select “First Name” from the Field Name drop down box.
4. Highlight “is equal to” in the Comparison box.
5. Enter “KIM@” as the Value.
6. Press QUERY. A list of people with the first name of Kim or Kimmy or Kimberly etc. will be returned.
Complex Queries

Association plus other criteria
In this example, let’s find all the people that are members, regular attenders and their city is Chicago.
1. Under the People menu, click Search Profiles. Click on the SEARCH icon.
2. Click on the Associations tab and click over Member and Regular Attender.
3. Click on the Editor tab.
4. Select Address as the table.
5. Select City in the Field drop down
6. Highlight “is equal to” in the Comparison box.
7. Enter Chicago as the Value.
8. Press QUERY. A list of all the people that meet that criteria are listed.
Multi-Table query
You may need a list, in which the criteria spans several tables. For example, give me all the people who have donated since 2014 who live in Chicago.

1. Under the People menu, click on Search Profiles. Click SEARCH icon.
2. Enter “Contribution” as the Query In table.
3. Select “Donation Date” from the Field Name drop down box.
4. Highlight “is greater than or equal to” in the Comparison box.
5. Enter 1/1/14 as the Value.
6. Press the ADD LINE button.
7. Change the Query In table from “Contributions” to “Addresses”.
8. Select “City” from the Field Name drop down box.
9. Highlight “is equal to” in the Comparison box.
10. Enter “Chicago” in the Value field.
11. Press QUERY. A list of people gave after 1/1/25 a who live in Chicago is returned.

Query in Current Selection
Querying within a current selection allows you to limit your query to only those records that are in the current selection. Let’s say you’ve just done a query of all the people who are Members. Then you want to know who has given in the last 6 months.

From the results list, press the SEARCH icon. The query editor is displayed again.
1. Select Contributions as the “Query In” table.
2. Select “Donation Date” from the Field Name drop down box.
3. Highlight “is greater than” from the Comparison box.
4. Enter 1/1/14 in the Value field.
5. Press QUERY CURRENT SELECTION. This will reduce your first list of Members that have given since 1/1/14.
Query with a combination of AND and OR

Some queries require the use of the connector AND as well as the connector OR. When using both And and OR remember to place the OR statements first. An example of this type of query would be, give me a list of all the children or youth who have been baptized. I have Baptized as a custom check box field.

1. Under the People menu, click on Search Profiles. Click the SEARCH icon.
2. Leave People as the Query In table.
3. Select “Family Position” from the Field Name drop down box.
4. Highlight “is equal to” in the Comparison box.
5. Select “Child” as the Value.
6. Press the ADD LINE button.
7. Press the OR button. Notice the AND is changed to OR on the second line.
8. Select “Family Position” from the Field Name drop down box.
9. Highlight “is equal to” from the Comparison box.
10. Select “Youth” as the Value.
11. Press the ADD LINE button.
12. Select “Baptized” from the Field Name drop down box.
13. Enter True Value.
14. Press QUERY. A list of all children and youth who have been Baptized is displayed.
Query using Except

For this example let’s say we want to find all people who live in Byron, but not on Staff. In this example Staff is an Association.

1. Under the People menu, click on Search Profiles. Click the SEARCH icon.
2. Leave “People” as the Query In table.
3. Select “City” from the Field Name drop down box.
4. Highlight “is equal to” from the Comparison box.
5. Enter Byron.
6. Click the ADD LINE BUTTON.
7. Click the EXCEPT button. The AND changes to EXCEPT.
8. Select “Association” from the Field Name drop down box.
9. Highlight “is equal to” from the Comparison box.
10. Select “Staff” as the Value.
11. Press QUERY. A list of people that aren’t on staff, who live in Byron is displayed.

Comparing two result sets

There are several ways that you can compare two sets:

An intersection compares the results of two queries and returns the records that were common to both sets. For example, I want a list of all the people who have donated and are enrolled in a group.

A union combines the results of two queries. An example of the union is – give me a list of people who either donated or joined a group.

A difference would subtract out the records that were common to both sets. An example of the difference is – give me all the people who donated but are not in a group.

For these examples, let’s look at all the people in our database that have donated in the last year. Then let’s compare that to the list of people that belong to a small group.

For the first query:
1. Under the People menu, click on Search Profiles. Click the SEARCH icon.
2. Change the Query In table to “Contributions”.
3. Select “Donation Date” from the Field Name drop down box.
4. Highlight “is greater than” from the *Comparison* box.
5. Enter the earliest date of donations to consider, for example 1/1/14.
6. Press QUERY. A list of people who gave to the church on or after 1/1/14 is displayed.

From the results list, press the SETS button. This brings up the screen that allows you to perform the intersections, unions and differences. In the left box labeled Set A, mark the button for Current Selection then press the button GET SET A. Now SET A contains all the people who have donated since 1/1/14.

Next, let’s move over to the box labeled Set B. Click on the button for Query Editor, and press the button GET SET B. The query editor is displayed.

1. Change the *Query In* table to Group Members.
2. Select “Inactive” from the *Field Name* drop down box.
3. Highlight “is equal to” in the *Comparison* box.
4. Choose False as the *Value*.
5. Press QUERY. The active people who are in a group are in SET B.
Click the button to Combine Sets, if you’d like to see the “union” of the two sets. That is, the combination of the people who gave and the people who are in a group. Press the OK button to see the results of the intersection.

Click Subtract B from A, if you’d like to see the “difference” between the two sets. This would show you all the people that gave but are not enrolled in a group. Press OK to see the results of this difference.

Click Subtract A from B, if you’d like to see the “difference” between the two sets. This difference would give you the people that are in a group, but have not donated. Press OK to see the results of this difference.

Click the button to Common to A and B, if you’d like to see the “intersection” of the two sets. That is, the people that have both donated and belong to a group. Press the OK button to see the results of the intersection.

**AND, OR and EXCEPT**

“Or” increases the possible results by allowing more ways for records to be selected. “And” restricts the possible results by compounding the requirements. “Except” restricts results by introducing exceptions or exemptions. If you need to use more than one of these conjunctions, place the OR statements first, then the AND statements, then the EXCEPT.

**Save a Query**

Let’s say you do a query of Members, Regular Attenders and Occasional Attenders on a regular basis. To save the query text, press the SAVE QUERY button. A file dialog box asks for the location to save and the name of the file. Enter this information, then press SAVE.

To use the query later, press the LOAD QUERY button from the query editor. A file dialog box is displayed. Navigate to the file you saved previously. The query text is displayed in the query editor. Press the query button to execute the query.

**Special Query**

There are some searches that require more complex algorithms. These searches have been “pre-set” for you to use. From the results list of a query, click on the SPECIAL icon.
Change Selection to Head
This search can only be done from within a results list. It will reduce the list to include only the Heads of Family for each family that was represented in the list. For this example let’s say we had a list of the children from our first grade class. If we choose to change to the heads of family, the children will not be in the list anymore, only the head of their family will be listed.

Change Selection to Mothers
This search can only be done from within a results list. It will change the list to include the Mothers for each family that was represented in the list. For this example let’s say we had a list of the children from our first grade class. If we choose to change to the Mothers, the children will not be in the list anymore, only the Moms will be listed.

Change Selection to Fathers
This search can only be done from within a results list. It will change the list to include the fathers for each family that was represented in the list. For this example let’s say we had a list of the children from our first grade class. If we choose to change to the fathers, the children will not be in the list anymore, only the dads will be listed.

Change Selection to Adult and all Children
This search can only be done from within a results list. It will change the list to include an adult and all the children of each family that was represented in the list. For this example let’s say we had a list of the children from our first grade class. If we choose to change to the adult and all children, the husband, wife or adult from the family plus all the children in the family will be displayed in the list.

Find Single Parents
This search finds the single parents.

Find possible blended families
This search looks for families with more than two members, where at least one person has a different last name.

Find people with picture
This search looks for individuals who have a picture in Roll Call.

Find families with a picture
This search looks for families that have a picture in Roll Call.

Find possible uninvolved families
This search allows you to specify the type of “uninvolvment”. When you select this search, the uninvolved window is displayed.

You may check one or all of these boxes. If you select multiples, an AND conjunction is used.

If you check the box for “hasn’t given”, you may also specify a since date. For example, I want to know what families have not given since the beginning of the year. I would check “hasn’t given”, then enter 1/1/14 as the date.

If you check the box for “hasn’t attended” – this will tell you what families haven’t attended any event (worship service or group/class) in the last year.
If you check the box for “hasn’t joined group” – this will tell you what families haven’t recently (based on the since date) joined a group.

If you check the box for “haven’t had their record modified” – this will tell you which families have not had any of their demographic information changed since the date you specify.

Choose how you define “uninvolved”.

![Screenshot of an interface showing how to identify families who haven't joined a group or modified their records.](image-url)
CREATING CUSTOM REPORTS

If the standard reports in Roll Call do not meet your needs, use the Quick Report writer to create custom reports. The Quick Report editor is a tool provided with the 4D database that Roll Call is written on. This chapter outlines the basic usage of the Quick Report editor within the context of Roll Call.

To create a Quick Report you’ll need to determine several things:
1. What table should the report be based on. That is, what is the report about, people, donations, groups etc.?
2. What “set” of information should be included in the report?
3. What columns or fields do I want in the report?
4. How do I want the information sorted?
5. Are there any calculations required in the report?

Create a custom report

To create a Quick Report follow these main steps.
1. Under the Report & Labels menu, select Quick Reports.
2. Click on the reports tab.
3. Click the NEW icon.
4. Perform the query to determine what data should be included in the report.
5. Format the report.
6. Generate the report.
Base Table

Each Quick Report must be based on a table. The report can contain values from multiple tables, however, the table which contains the lowest level of information must be the “base” table. For example, if we want a report with People’s name, Address, Donation and Designation information, Designation would be the “base” table. If we wanted a report with Group information as well as the members in the group, Group Membership would be the base table.

To begin creating the report, expand the Reports&Labels menu on the left side. Select Quick Reports. Select the base table from the left sidebar. Click on the green plus sign or ADD icon. Next you’ll be prompted with the query editor to determine what records should be included in the report.

Data for the Report

Once you’ve clicked the NEW icon the query editor is produced so that you may select the data you’d like included in the report. For a detailed description of using the query editor, see “Using the Query Editor”.

For this example, let’s create a report of all the people who are over 30 years old. From the Query Editor, change the Query In table to People. In the Field drop down, select Age. In the Comparison box, choose “is greater than”. In the Value field, enter 30. Press the QUERY button.

Select columns for the report

Now that you have the data (the people that will be included), you must determine what information you want to see about each of those people. From the Quick Report editor, you may select a column by double clicking on it. In this example, notice the list of people fields under Master Table.

To create a report with First Name, Last Name, Address, City, State, and Zip Code, double click on the First Name field, then the Last Name field. Once you double click on the field name, a column will be created in the upper part of the quick report editor for that field.
Next, use the drop down box to change Master Table to Related Tables. You should see a box to the left of Family Info on Windows or an arrow to the left of Family Info on the Mac. Click on that box/arrow. The list of Address fields will be displayed below. Double click on Address, City, State, Zip etc. to include them in the report.

Calculated columns

To create a column that uses a formula, select Column>Add from the Quick Report menu. The formula editor is displayed. The formula editor allows you to combine the values of multiple fields, return certain values such as YES/NO instead of TRUE/FALSE, perform mathematical equations and use pre-written functions.
**Concatenation**
To combine the values of multiple fields into one column, you can use the plus sign in the formula editor. Common examples of combining field values would be to have the last name, a comma, then the first name, or combining the area code and phone number.

For this example, let’s create a name column. Double click on the *Last Name* field found under the box *Related Tables*. The name *People.LastName* is placed in the formula editor box. Next click on the plus sign. Next enter a quote mark, a comma, a space then another quote mark. Next click on the plus sign again. Now double click on the *First Name* in the section below *Related Tables*. The formula should read:

```plaintext
[People.LastName]+", "+[People.FirstName]
```

Click the OK button to accept the formula.

**Equations**
You can perform mathematical equations within the formula editor. You can add, subtract, multiply, divide and create percentages. For this example, let’s say we wanted to add a one to a child’s grade.

Double click on the *Grade* field found under the box *Related Tables*. The name *People.Grade* is placed in the formula editor box. Next click on the plus sign. Now type in the number 1. The formula should read:

```plaintext
[People.Grade]+1
```

Click the OK button to accept the formula.

**NUM function**
The num function allows you to return a constant, based on a field value. This comes in very handy for Boolean or check box type fields where the value is either True or False. By using the NUM function you could choose to return an X if the value was True or you could return Yes if it was True and No if it was False.

For this example, let’s assume we have a custom check box called Newsletter. In our report, we want to return an X if the person wants to receive the newsletter. The formula is:

```plaintext
(Num([People].Newsletter)***"X"**
```

310
If you wanted to return a Yes or No, the formula would be:

\[((\text{Num[People]Newsletter=True})*"Yes")+(\text{Num[People]Newsletter=True})*"No")\]

**Roll Call functions**

The following functions can be typed into the formula editor, or selected from the commands by theme box to the right. Scroll down to reach the functions in italics. Double click to select the function you need.

**DoBuild_Label** – this function returns an address block for an individual. It contains the name and current address.

**Jim_Sue_Label** – returns an address block using the first name of the head of family plus the spouse name and the last name, then the address.

**Family_Label** – returns “Mr. & Mrs.” Plus the first and last name of the head of family, then the address.

**Different_Last_Name** – returns an address block with the first and last name of the head of family plus the first and last name of the spouse (if the last name is different).

**Get Many -> People -> Group Membership** – returns a list of all groups that the person is involved in.

**Get Many -> People -> Pledge funds** – returns a list of all the pledge funds this person has pledged to.

**Get Many -> People -> Pledges** – returns a list of all the amounts a person has pledged.

**List_Phones (“All”)** - Produces a list of the “non-standard” individual phone numbers that are stored in the telephone table.

**List_Family(“ ”)** Returns a list of all the family members.

**Get Children(0)** – Returns a list of the children for a family.

**Build_Salutation** – Returns the head of the family’s nickname plus the spouse’s first name.

**Get DES Function(TRUE)** – Returns a list of donations to the current pledge record.

**Get DES Function (FALSE)** – Returns the total of donations to the current pledge record.

**Designation SUM** – Returns the total for the designations.

**Summary Information**

You can use the sum, average, minimum, maximum and count functions for a column. For this example, let’s say we have a report that lists donation information for a date range and we want the grand total donated as well as the number of donations given.

1. In the cell where donation amount and grand total intersect, click on the SUM icon (backwards E) or select Cells>Sum from the quick report menu.
2. In the cell where name and grand total intersect, click on the COUNT icon (N) or...
select Cells>Count from the quick report menu.

Sort the Report
To sort the report by a specific column, highlight the field name. Next, press the green arrow to the right, to move the field to the sort order box. For example, let’s say we have a report that lists people information and we want it sorted by name. First highlight Last Name and press the green arrow. Last Name is now listed in the sort order box. Then if you’d like to sort by First Name within the same Last name, highlight First Name, and press the green arrow.

Format the Report
There are several formatting options in the report writer. These allow you to EDIT the titles, page breaks, whether to display detail lines, and the presentation of the report.

Titles
To set up the title of your report, select File>Headers and Footers from the quick report menu. Enter the text you’d like for your title in the appropriate text box.
Page breaks

To create a page break, you must have sorted your report on a certain field. Then you can create a page break, each time the value of that field changes. For example, let’s say we created a report that lists all donations for a given year. We wanted to sort those donations by the fund that they were designated to. Then we want a new page for the different funds.

When you sorted the report by designation, a new line or row is created in the spreadsheet called Designation changed. Right mouse click on that title and select Totals Spacing. The subtotals properties window is displayed. Click on the button for Generate Page Break.
Hide details
To create a summary report you will need to hide detail lines. For example, let’s say you want a donation report by fund designation. You only want totals for the designation, not every individual donation.

Output presentations
There are several things that can be done to change the appearance of the report.
1. Page Setup
2. Fonts
3. Presentation

To change the orientation of the report from portrait to landscape, select File>Page Setup from the quick report menu. Choose the appropriate orientation.

You may change the font or the font size for a row, column or specific cell. Highlight the area you wish to change, then select the font style in size from the drop down boxes in the middle top of the window.

To modify the presentation of the report you can:
1. Select Style>Borders to modify the types of border included in the report.
2. Select Style> Presentation to pick a certain presentation.
3. Select Style>Right/Left Justify to change the justification of a column.

Print the Report
To send the report to the printer, select File>Generate. The print dialog box will be displayed, so you may choose your printer. If you’d like to save the report to a file, select File>Destination. Change the destination to a Disk File. Then select File>Generate from the menu. A file dialog box will be displayed so that you can save this report as a tab delimited text file. These types of files can easily be imported into 3rd party such as a spreadsheet.
Re-use the Report

Once you’ve created the report, you’ll want to save the template so it can be used again.

The template is the columns and the formatting options that were selected. Select File>Save from the quick report menu. You’ll be asked for a file name and location. Give the report a name that is meaningful to you. Once you close the quick report editor window, you’ll see the report listed in the Tables and Templates window.

To run the report again, select Reports>Quick Reports from the top menu. From the Tables and Template window, highlight the report you’d like to run. Then press the GENERATE icon. The query editor will be displayed, so you can select the data you want in the report. A print dialog box will be displayed, so you can send the report to the printer.

Edit a Saved Template

To edit the report, select Reports>Quick Reports and Labels from the main menu. From the Tables and Template window, double click on the template you’d like to modify. The query editor will be displayed, so you can select the data you want to see in the report. After you review the raw data, press the EDIT icon.

A message will be displayed, telling you the name and location of the template file. **Remember this information.** Once you are in the quick report window, select File>Open from the report writer window. Then navigate the template file from the message, highlight it and press SAVE. The columns and formatting will be displayed in the quick report window.

Make any changes you’d like to the columns or formatting on the report template. To run the report select File>Generate. If you’d like to save the changes, press File>Save.
CLEANING UP THE DATA – DATA ADMINISTRATION

List of Valid Values

Most lists can be changed. The “lists” are the valid values that you can enter for a field such as Association, Key Words, Custom Field Lists, City, Telephone Types, etc.

To modify this information, expand the Administration menu and click on Lists. A screen with all the lists will be displayed.

From this window, click on the type of list you’d like to modify. The current list of values will be displayed on the right. To add a new value, press the plus sign. A line will open up for you to add the value. To delete a value, highlight it, then press the minus sign. To modify a value, double click on the value, then make necessary changes.

Duplicate Check

To identify potential duplicate records, expand the people menu. Click on Find Duplicate Records. The area to the right will allow you to select your duplicate criteria.

To see all the people that have the same first and last name, click the First and Last Name button. To see all the people that have the same address but are in different families, click on the Same Address option. To see all the folks with the same home number, click on the option for Home Phone.

From the display of potential duplicates, click on a person that appears to be a duplicate record, then click on the next record that appears to be a duplicate with the first. These records will be placed side by side so you can view the information.

From the buttons underneath each record, you may perform several actions:
1. Click the DISPLAY button to view the person’s entire record.
2. Click the TRANSFERS button to transfer the donations from one record to the other.
3. Click the TRANSFER button to transfer other details such as visitations, group membership and comments.
4. Once you’ve viewed and transferred information as required, you may delete the unwanted duplicate record.
Bulk Changes

Many of the people and group fields can be changed “en masse”. For example if you wanted to change a city name from from St. Thomas to Saint Thomas, you can use the bulk changes area.

Global change to people or address information

As an example, let’s say that you want to change all people that have an Association of Member to a new Association of “Partner”. To do this:

1. Expand the People menu.
2. Click on Bulk Changes.
3. Use the “Run For” area to select what you want to make this change to. In this example, select Associations, then click over Member.
4. Next select the column you will be changing. In this example it is Association.
5. Enter the new value for the Association.
6. Click PROCESS CHANGE to complete the change.
Global change to group information

As an example, let’s say that you want to change all the groups that have a Department of Children’s to “Kids Place”. To do this:
1. Expand the Group menu.
2. Click on Bulk Changes.
3. Use the “Change” area to select the groups to make this change to. In this example, select Groups with a Department of Childrens’
4. Next select the column you will be changing. In this example it is Department.
5. Enter the new value Kids Place.
6. Click PROCESS CHANGE to complete the change.
MAINTAINING THE DATABASE

Data File Location

The data file contains all the information that you have entered in Roll Call. Since this file contains all your work, make sure you know the name and location of it and that you back it up regularly.

The data file is comprised of two files: the 4D data file and the rollcall.journal file. The 4D data file name will end with the extension 4DD. The name and location of your data file is found by selecting Help> About Roll Call.

User Security

Activate Security

To activate the security system in Roll Call you will need to give Director a password. Once Director has a password, you will be required to log into Roll Call with a valid user name and password.

To give Director a password, expand the Administration menu. Click on User Security. Click on Director from the list on the left. Click on the CHANGE PASSWORD button. Enter a password.
Preferences
There are password preferences you can set for your system. The preferences allow you to select how often a person needs to change their password, if a password is required, how many characters the password needs to be, etc.

To set the preferences:
1. Expand the Administration menu.
2. Click on User Security
3. Click on the Prefs icon (right side)
4. Enter the Maximum Password Age. If you do not want passwords to expire, mark the option for “Passwords Never Expire”. If you want the passwords to expire after a certain length of time, mark the option for “Expires In” and indicate how long.
5. Enter the Minimum Password Age. If you don’t care how often the user changes their password, you can mark the option for “Allow Changes Immediately”. If you only want them to be able to change so often, mark the option for “Expires In” then enter the number of days.
6. Enter the Minimum Password Length. If you wish to allow blank passwords, mark the option to “Allow Blank”. Otherwise, enter the “At Least” number of characters.

Create New User
To create a new user:
1. Expand the Administration menu.
2. Click on User Security.
3. Click on the plus sign in the lower left under the user names.
4. Enter the user name for this user.
5. Enter a default password.
6. Indicate if this will be a standard user or a check in user. Standard users will see the Navigator window when the sign in. Check In users will see the check in screen when they log in.
7. Click OK to save that user.
8. Next mark the security levels that are appropriate for this user.

Security Levels
The following are the security levels for a standard users.

<table>
<thead>
<tr>
<th>Security Level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read Only</td>
<td>If this box is checked, a user will have read only privileges for the areas marked.</td>
</tr>
<tr>
<td>People</td>
<td>If this box is marked, the user can view, enter and delete people information</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Groups</td>
<td>This allows the user to view, enter and delete groups.</td>
</tr>
<tr>
<td>Services</td>
<td>This allows the user to view, enter and delete worship services.</td>
</tr>
<tr>
<td>Contributions</td>
<td>This allows the user to view, enter and delete contributions.</td>
</tr>
<tr>
<td>Contributions Plus</td>
<td>This allows the user to post and reverse batches. They can also transfer contributions.</td>
</tr>
<tr>
<td>Pledges</td>
<td>This allows the user to view, enter and delete pledges.</td>
</tr>
<tr>
<td>Letters</td>
<td>Allows this user to access the word processor portion of roll call.</td>
</tr>
<tr>
<td>Visitation</td>
<td>Allows this user to view, enter and delete visitation information.</td>
</tr>
<tr>
<td>Background Checks</td>
<td>Allows the user to view, enter and delete background check information.</td>
</tr>
<tr>
<td>Attendance</td>
<td>Allows the user to view, record, modify and delete attendance information.</td>
</tr>
<tr>
<td>Graduation</td>
<td>Allows the user to set up graduation profiles and to do the graduation.</td>
</tr>
<tr>
<td>Expert</td>
<td>Allows the user to do the duplicate check check, access preferences, child check in set up preferences and bulk changes.</td>
</tr>
<tr>
<td>Confidential Comments</td>
<td>Allows the user to view, enter and delete confidential comments.</td>
</tr>
<tr>
<td>Custody Comments</td>
<td>Allows the user to view, enter and delete custody comments.</td>
</tr>
<tr>
<td>Email</td>
<td>Allows the user to email from Roll Call.</td>
</tr>
<tr>
<td>Edit Lists</td>
<td>Allows the user to create, modify and delete list of values. For example, Associations, Cities, and Keywords.</td>
</tr>
<tr>
<td>Assign ID’s</td>
<td>Allows the user to enter family numbers and badge number.</td>
</tr>
<tr>
<td>People Import</td>
<td>Allows the user to import people into the system.</td>
</tr>
<tr>
<td>People Export</td>
<td>Allows the user to export people information to a tab delimited file.</td>
</tr>
</tbody>
</table>

The security levels for check in allow the user to get to the check in screens. The information entered for the check in user will determine what the check in screen will look like. The check in user manual goes into each level in-depth.
Backup on single user system

To create a Roll Call backup, select File>Backup Configuration. You’ll be taken to the Maintenance window. Click the Database Properties button to select the location that you’d like to store your backup. Click Ok to save this location. If you’d like to have your database automatically backed up, click on the Scheduler tab. Indicate how often and when you’d like to back up.

Once your configuration is set, select File>Backup to perform the backup.

Recover the database

You can recover from a backup from within the Roll Call menus, or from your operation system.

From within Roll Call

To recover from a backup, select File>Backup from the main menu. Click on the RESTORE icon on the left. Highlight the backup file, then click RESTORE.

Click here to browse your system to select backup location.

Highlight the file you’d like to restore, click RESTORE.
From the operating system
If you cannot get into Roll Call, you can open a backup file, by double clicking on the Roll Call icon, then immediately holding down the ALT key. The window displayed will allow you to restore a backup.
1. Select the option to “Restore a Backup”
2. Navigate to and highlight your backup file. Click OPEN.
3. From the next window Click RESTORE.

Backup a networked system
On the network, the backup can be done on the server or from the client. To backup from the Server, click on Maintenance from the Server dashboard. Next click START BACKUP. To perform a backup from one of the clients, select Help>Administration window. This will display the Server dashboard and you can do the backup as if you were at the Server.
To set backup preferences, location, and frequency, click on Maintenance and click the PREFERENCES button. When you are anchored on the Configuration link on the left, you may set up the backup location. Make sure you backup both the data file and structure file. Also, if your church imports family or individual pictures make sure to also backup the Images folder under Roll Call Server.

To implement transaction log, click here and select location.

Choose location of backups.

Check to backup data and resource files.

Click to include images folder in backup.

Click to START BACKUP or click on PREFERENCES to set location, scheduling etc.

To set up the backup location, make sure you backup both the data file and structure file. If your church imports family or individual pictures, make sure to also backup the Images folder under Roll Call Server.

When you are anchored on the Scheduler link on the left, you may set up the backup frequency.

Select your backup frequency and starting time.
Indicate how many backups to retain.

Indicate how to handle backups if there are active transactions.

How do you want to handle backup failures?

Recover database from a backup on a network system

To recover from a backup, open Roll Call Server and immediately hold down the ALT/OPTION key to get the open file dialog box. Choose the option for Restore from Backup. Click OK. Navigate to your latest backup file. Highlight it and click OPEN. Your compiled database and data file will be recovered. Next you can restart Roll Call Server.
Open a Different Datafile

To open a different data file, double click on the Roll Call or Roll Call Server icon, then immediately hold down the ALT key. Choose the option for opening a different data file.

Choose the option for selecting a different data file.

Click Continue.

Highlight the data file you want to open and click OPEN.

Compact the data file

Compacting your data removes any fragmentation within your data file. The process of compacting is slightly different depending on whether or not you use a stand-alone or server system.

**Single user system**
1. Select File>Backup from the main menu.
2. Click on the icon for COMPACT on the left.
3. Click on the top icon for Compact data and indexes.

**Roll Call Server**
1. Make sure all clients are disconnected from Roll Call.
2. From the Server dashboard, click on Maintenance.
3. Click COMPACT DATA.
Repair my data file

To repair your data file, follow these steps.
1. Double click on the Roll Call or Roll Call Server icon, then immediately hold down the ALT key.
2. Choose the option for Maintenance window.
3. Click on the REPAIR icon on the left.
4. Click the REPAIR button.
Choose the option for Maintenance.

Click on the REPAIR icon.

Click here to repair the data file.